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Preface

Welcome to Release 11 of the Oracle Applications User’s Guide.

This user’s guide includes the information you need to work with
Oracle Applications effectively. It contains detailed information about
the following:

¢ Overview and reference information
« How to navigate through Oracle Applications windows

« How to submit Oracle Applications programs, reports, and
listings

This preface explains how this user’s guide is organized and introduces
other sources of information that can help you.
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About This User’s Guide

This guide is the primary source of information about Oracle
Applications User Interface. It contains overviews as well as task and
reference information. This guide includes the following chapters:

» Chapter 1, “Getting Started,” introduces you to Oracle
Applications and to some basic features common to all Oracle
Applications products. It tells you how to log in, choose a
responsibility, use the menu, get Help, use keyboard shortcuts,
and exit.

» Chapter 2, “Oracle Applications User Interface Basics,”
introduces you to the Oracle Applications user interface and
teaches you a few simple concepts and functions you need to
start working. Specifically, this chapter describes the anatomy of
the Oracle Applications user interface, how to navigate around
Oracle Applications, how to view message explanations, and
how to access linked forms.

» Chapter 3, “Entering and Querying Data,” discusses advanced
features that help you enter and query data from Oracle
Applications. Specifically, this chapter describes how to simplify
data entry using a list of values, how to enter a date using the
Calendar, and how to search for information.

» Chapter 4, ”Customizing the Presentation of Data,” discusses
how you can customize the layout of your data in a folder.

« Chapter 5, “Using Flexfields,” contains an explanation of
flexfields and tells you how to use them. You learn about the
features of flexfields, the differences between a key and a
descriptive flexfield, how to enter data into flexfields, and how
to query data using flexfields.

» Chapter 6, “Running Oracle Applications Reports and
Programs,” gives you an overview of how to run reports and
programs in Oracle Applications. Specifically, you learn about
the concurrent processing feature that allows you to run reports
and programs non-interactively, how to run reports and
programs using Standard Report Submission, and how to define
request sets.

« Chapter 7, “Monitoring Oracle Applications Reports and
Programs,” tells you how to view and monitor your requests.
Specifically, this chapter tells you how to use the Concurrent
Requests, Requests, and Completed Request windows, how to
view the progress of a concurrent request, how to cancel a
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request or change its processing options, and how concurrent
processing recovers from unforeseen system events.

« Chapter 8, “Working with Attachments,” describes attaching a
document to a data record, as well as how to view, delete, or
copy an attachment.

e Chapter 9, “Using User Profiles,” teaches you about Oracle
Applications user profiles. User profiles give you control over
the behavior of certain Oracle Applications features. Specifically,
this chapter tells you how to set user profile options and which
user profiles are common to all Oracle Applications products.

« Appendix A, “Oracle Applications Menus,” describes the Oracle
Applications main menu bar.

« Appendix B, “Oracle Applications from Character to GUI,”
describes how features from previous Oracle Applications map
to Oracle Applications 10SC.

This user’s guide is available online

All Oracle Applications user’s guides are available online, in both
HTML and Adobe Acrobat format. (Most other Oracle Applications
documentation is available in Adobe Acrobat format.)

The paper and online versions of this manual have identical content;
use whichever format is most convenient.

The HTML version of this book is optimized for on-screen reading,
and lets you follow hypertext links for easy access to books across our
entire library; you can also search for words and phrases if your
national language is supported by Oracle’s Information Navigator.
The HTML documentation is available from the Oracle Applications
toolbar, or from a URL provided by your system administrator. Note
that the HTML documentation is translated into over twenty
languages.

You can order an Oracle Applications Documentation Library CD
containing Adobe Acrobat versions of each manual in the Oracle
Applications documentation set. Using this CD, you can search for
information, read it on-screen, and print individual pages, sections, or
entire books. When you print from Adobe Acrobat, the resulting
printouts look just like pages from an Oracle Applications hardcopy
manual.

Note: There may be additional material that was not available
when this user’s guide was printed. To learn if there is a

Preface iii



Assumptions

documentation update for this product, look at the main menu
on this product’s HTML help.

This guide assumes you have a working knowledge of the principles
and customary practices of your business area. It also assumes you are
familiar with Oracle Applications. If you have never used Oracle
Applications, we suggest you attend one or more of the Oracle
Applications training classes available through Oracle Education. (See
Other Information Sources for more information about Oracle
Applications and Oracle training.)

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle provides powerful tools you can use to create, store, change,
retrieve and maintain information in an Oracle database. But if you use
Oracle tools like SQL*Plus to modify Oracle Applications data, you risk
destroying the integrity of your data and you lose the ability to audit
changes to your data.

Because Oracle Applications tables are interrelated, any change you
make using an Oracle Applications form can update many tables at
once. But when you modify Oracle Applications data using anything
other than Oracle Applications forms, you may change a row in one
table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving
erroneous information and you risk unpredictable results throughout
Oracle Applications.

When you use Oracle Applications forms to modify your data, Oracle
Applications automatically checks that your changes are valid. Oracle
Applications also keeps track of who changes information. But, if you
enter information into database tables using database tools, you may
store invalid information. You also lose the ability to track who has
changed your information because SQL*Plus and other database tools
do not keep a record of changes.

Consequently, we STRONGLY RECOMMEND that you never use
SQL*Plus, Oracle Data Browser, database triggers, or any other tool to
modify Oracle Applications tables, unless we tell you to do so in our
manuals.
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Other Information Sources

You can choose from many sources of information, including
documentation, training, and support services, to increase your
knowledge and understanding of Oracle Applications.

Most Oracle Applications documentation is available in Adobe Acrobat
format on the Oracle Applications Documentation Library CD. We supply
this CD with every software shipment.

If this manual refers you to other Oracle Applications documentation,
use only the Release 11 versions of those manuals unless we specify
otherwise.

Oracle Applications Character Mode to GUI Menu Path Changes

This is a quick reference guide for experienced Oracle Applications end
users migrating from character mode to a graphical user interface
(GUI). This guide lists each character mode form and describes which
GUI windows or functions replace it.

Training

Oracle Education offers a complete set of training courses to help you
and your staff master Oracle Applications. We can help you develop a
training plan that provides thorough training for both your project
team and your end users. We will work with you to organize courses
appropriate to your job or area of responsibility.

Training professionals can show you how to plan your training
throughout the implementation process so that the right amount of
information is delivered to key people when they need it the most. You
can attend courses at any one of our many Educational Centers, or you
can arrange for our trainers to teach at your facility. In addition, we
can tailor standard courses or develop custom courses to meet your
needs.

Support

From on-site support to central support, our team of experienced
professionals provides the help and information you need to keep
Oracle Applications working for you. This team includes your
Technical Representative, Account Manager, and Oracle’s large staff of
consultants and support specialists with expertise in your business
area, managing an Oracle server, and your hardware and software
environment.
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About Oracle

Oracle develops and markets an integrated line of software products
for database management, applications development, decision support,
and office automation, as well as a complete family of financial,
manufacturing, and human resource applications.

Oracle products are available for mainframes, minicomputers, personal
computers, network computers, and personal digital assistants,
allowing organizations to integrate different computers, different
operating systems, different networks, and even different database
management systems, into a single, unified computing and information
resource.

Oracle offers its products, along with related consulting, education, and
support services, in over 140 countries around the world. Oracle
Corporation is the world’s leading supplier of software for information
management, and is the world’s second largest software company.

Thank You

Thank you for using Oracle Applications and this user’s guide.

We value your comments and feedback. At the end of this manual is a
Reader’s Comment Form you can use to explain what you like or
dislike about Oracle Applications or this user’s guide. Mail your
comments to the following address or call us directly at (650) 506—7000.

Oracle Applications Documentation Manager
Oracle Corporation

500 Oracle Parkway

Redwood Shores, CA 94065

U.S.A.

Or, send electronic mail to appsdoc@us.oracle.com.
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I
Getting Started

CHAPTER

T his chapter introduces you to Oracle Applications. Specifically,
this chapter teaches you how to:

« Start Oracle Applications
« Use Oracle Applications menus
» Use keyboard shortcuts

* Get help in Oracle Applications

Exit from Oracle Applications

In addition, this chapter also lists some basic graphical user interface
terms used throughout the guide.
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Overview of Oracle

Basic Business Needs

Applications

Oracle Applications is a tightly—integrated family of application
products that share a common look and feel. Using the menus and
windows of Oracle Applications, you have access to all the functions
you need to manage your business information.

Oracle Applications is highly responsive to users, supporting a
multi-window graphical user interface (GUI) that provides you with
full point-and—click capability. You can use your mouse or keyboard to
operate graphical controls such as pull-down menus, buttons, poplists,
and check boxes.

In addition, Oracle Applications offers many other features such as
field-to—field validation and list of values to help you simplify data
entry and maintain the integrity of the data you enter.

The best way to familiarize yourself with the common look and feel of
Oracle Applications products is to log in and use the products. This
chapter describes how to get started with Oracle Applications and
provides you with the basic information you need to explore Oracle
Applications in greater depth.

Applications GUI and other common Oracle Applications
features. If you need specific information about a particular
Oracle Applications product, you should consult the help or
reference guide for that product. For example, if you wish to
learn how to enter a journal, you should consult the Oracle
General Ledger User’s Guide or the Oracle Public Sector General
Ledger User’s Guide.

@ Suggestion: This guide teaches you how to use the Oracle

Oracle Applications provides you with features you need for your
business. With Oracle Applications you can:

» Learn how to use the system quickly. Oracle Applications uses
familiar and easy-to—use menus so you, your staff, and your new
employees can be productive after a few minutes of coaching
from a colleague.

» Be productive even if you are a novice user. A simple, intuitive
graphical user interface (GUI) lets you use all of the power of
Oracle Applications.
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» Increase your productivity as a power user. When you become
familiar with Oracle Applications, you can use shortcuts in the
graphical user interface to quickly navigate and work with
multiple windows at once.

« Get help when you need it. Context-sensitive online help is
always available whenever you need assistance.

« Secure your application data from unauthorized access. You
can control access to your application data and customize the
windows available for each user based on that user’s level of
authority.

Basic GUI Terminology

The examples and screenshots shown in this guide represent the
various platforms on which Oracle Applications is available including
the Microsoft Windows environment, and Web Browsers.

Before using Oracle Applications, you should familiarize yourself with
the specifics of your GUI environment and how to perform basic tasks,
such as using a menu or selecting an item. In doing so, you should
come across and become familiar with the following generic terms:

desktop The part of your computer monitor that displays
information and where your work takes place.
This is also referred to as your screen.

window A box around a set of related information on your
desktop.
menu A list that appears in a bar across the top of a

window that consists of commands or actions you
can perform.

click Quickly press and release a mouse button while the
mouse pointer is on a particular item.

double—click Rapidly click a mouse button twice while the
mouse pointer is on a particular item.

drag Move the mouse while holding down a mouse
button.

select Mark an item. Examples include highlighting text,

or clicking on a value from a list.
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choose Select an item and initiate the action associated
with the item. Examples include choosing a menu
item or choosing a button.

scroll bar A vertical or horizontal bar that appears on a
window whose contents are not entirely visible.
Click on the arrows, or drag on the box of a scroll
bar to scroll through the hidden contents, or click
in the bar itself to move to either the previous or
next page.

Note: The mouse button that we refer to in the terms above is
the mouse button that you program for selecting text and
choosing items. (Usually the left mouse button)

Once you get started in Oracle Applications, you can refer to the Oracle
Applications User Interface section of this guide for a more
comprehensive list of user interface terms. See: Oracle Applications
User Interface: page 2 — 2.
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Starting Oracle Applications

To start Oracle Applications, you need to:

Starting and Logging On

Apphiotas

Start up your computer system

Start your Web Browser

Start the Oracle Applications program
Log on to Oracle Applications

Choose a responsibility (if necessary)

Navigate to an application window

Web Environment

To start Oracle Applications in a Web environment enter the
appropriate URL for your site in an Oracle Applications certified
browser.

Windows Environment

To start Oracle Applications in the Windows environment double—click
on an Oracle Applications icon.
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After starting Oracle Applications, the first window you see is the
sign—-on window:

Figure1-1 E;g Oracle Applications M=l E

Oracle

Applications

User Mame Cancel ‘ Connect ‘

Password
Copyright () Oracle Corporation, 1994, 1996, All Rights Reserved.

Note: The appearance of your sign—on window may vary
depending on how it is customized at your site.

You need an Oracle Applications username and password, also known
as an Oracle Applications sigh—on, to log on to Oracle Applications. It
is different from the username and password you use to log on to your
computer. If you are not sure of your Oracle Applications sign-on,
consult your system administrator.

Oracle Applications security is based on your Oracle Applications
sign-on. Your sign—-on connects you to your responsibilities, which
control your access to applications, functions, reports, and data.

p Tologon to Oracle Applications:

1. Enter your username in the User Name field.

|:| Attention: Do not press [Enter] after entering each item, as [Enter]
is normally used to accept the default button. Instead, use [Tab] or
the mouse to navigate between fields.

2. Enter your password in the Password field.
3. Choose Connect.

Notice your password does not appear as you type it, to prevent
others from seeing it. Keep your password confidential to prevent
access to Oracle Applications by unauthorized users.
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Choosing a Responsibility

If you are an authorized user of Oracle Applications, one of two things
occurs after you sign on to Oracle Applications:

e The Navigate window appears, as in Figure 1 — 2, listing your
current responsibility in the windowv title.

or

» A window containing a list of responsibilities appears, as in
Figure 1 -3.

Figure 1-2 E;a Mavigator - System Administrator

Security:

Security menu

Security . Users

Concurrent . Responsibilities

Profile . Administer Concurrent Managers

Apnplication . Requests: Submit

Install . Concurrent Requests: View

Requests . Menus

Workflow . View All Concurrent Requests (System 4
. Descriptive Flexfield Segments
. Profile System Values

M Close Other Forms
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Figure1-3

E‘,ﬁ Heszponsibilities

Find| %

Fesponsibility

AP Manager GLI LIS

AR Manager GUI LK

AR Manager GLI LIS

AR Manager GLILIS2

Alert Manager

Application Developer

Apps for the Web Manager
Australian Asset Manager
Australian Payahles Manager
Altomotive

BoOmM Cost Accountant GUILIST (Mo Lipdate)
BOM Supervisor GUI LIS
Bank Reconciliation

Belgian Localizations

Bills of Material

Brazilian General Information

Brazilian General Ledger ’ﬂ
1] | »

—

Find | 0] |Cance||

A responsibility is a level of authority in Oracle Applications that lets
you access only those Oracle Applications functions and data
appropriate to fulfill your role in an organization. Each responsibility
allows access to:
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» A specific application or applications, such as Oracle General
Ledger or Oracle Planning.

* A set of books, such as U.S. Operations or German Sales or an
organization, such as New York Manufacturing or New York
Distribution.

e Avrrestricted list of windows that you can navigate to; for
example, a responsibility may allow certain Oracle Planning
users to enter forecast items, but not enter master demand
schedule items.

» Avrrestricted list of functions you can perform. For example, two
responsibilities may have access to the same window, but one
responsibility’s window may have additional function buttons
that the other responsibility’s window does not have.

* Reports in a specific application; your system administrator can
assign groups of reports to one or more responsibilities, so the
responsibility you choose determines the reports you can submit.

Each user has at least one or more responsibilities and several users can
share the same responsibility.

If your system administrator assigns you just one responsibility, upon
signing on, you go directly to the Navigate window for that
responsibility. The Responsibilities window appears only if your
system administrator assigns more than one responsibility to you.

p To choose a responsibility:

m  |f your sign-on displays a Responsibilities window, use one of the
following methods to choose a responsibility:

« Use the [Up arrow] and [Down arrow] keys to select a value and
press [Return].

« Use your mouse to select a value and choose OK.
« Double—click your mouse directly on a value to choose it.

A Navigate window appears displaying the name of the
responsibility you choose. You are now ready to start working.

See Also

Using a List of Values: page 3-9
Changing Your Security Access: page 1 — 15
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Opening a Form from the Navigate Window

Figurel1-4

Use the Navigator window to navigate to a form that lets you perform
a specific business flow. The Navigator window is always present
during your session of Oracle Applications and displays the name of
your current responsibility in its window title.

The Navigator consists of two regions, Functions and Documents. The
Functions region provides a list of forms displayed like the files in a file
system, while the Documents region is a customizable region that
allows you to create links to specific documents that you use
frequently.

Egg Navigator - System Admimstrator

s —— ]

Security:

Security menu

Security . Users

Concurrent . Responsibilities

Profile . Administer Concurrent Managers
Application . Requests: Submit

Install . Concurrent Requests: View

Requests . Menus

Workflow . View All Concurrent Requests (System J

. Descriptive Flexfield Segments
. Profile System Values

Remove

M Close Other Forms

Using the Navigator’s Functions Region

The forms that you can navigate to are displayed in a navigation list on
the left-hand side of the Navigate window. The navigation list is
organized much like the hierarchy of a file system, where you can
expand items that begin with a plus sign (+) to further sub-levels until
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Figure1-5

you find your form of interest. Sub-levels appear indented below the
items from which they are expanded. Items that are expanded are
preceded by a minus sign (-). You can expand no further when an item
displays neither a plus or minus sign. Figure 1 -5 is an example of
how navigation list expansion works. The sequence shows that Item 1
is expanded twice to get to the forms called Item 1Aa and Item 1Ab.
Note that Item 2 in the example also represents a form, since it cannot
be expanded.

Expand Item 1 Expand Item 1A
+ Item 1 — | —-ltem1 —Item1
Item 2 + Item 1A - Item 1A
+ Item 3 + Item 1B — Item 1Aa
Item 2 — Item 1Ab
+ Item 3 + Item 1B
Item 2
+ Item 3

Above the navigation list, you should see two fields that span the
width of the window. These two fields help you identify your
selection. The top field displays the name of the item currently
selected, while the bottom field displays a description of that item.

Finally, at the bottom of the Navigate window, you should see a check
box labelled Close Other Forms. This check box lets you choose
between being able to open several forms at the same time or just one
form at a time.

For example, suppose you have a form open that displays two
windows and you want to open yet another form. If the Close Other
Forms check box is unchecked, then when you open a new form,
Oracle Applications displays that form in a new window, so that the
two windows for your original form also remain open. If the check box
is checked, then when you open a new form, Oracle Applications closes
the two windows associated with the first form before it opens the
window for the new form.

3~ Suggestion: Each window that you have open requires a

@ certain amount of computing resources. If you know that your
computer is low on resources, you may want to check the Close

Other Forms check box to avoid opening too many windows

simultaneously and wasting resources.

Note: Whenever Oracle Applications closes a form, if you
have made any changes in the form but not yet saved the
changes, you will be asked to do so.
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p Toexpand or collapse the navigation list:

1. Choose one of the following methods to expand an expandable
item to its next sub-level:

* Double—click on the item.

« Select the item and choose Open.

L  Select the item and choose the Expand button.

2. Choose one of the following methods to collapse an expanded item:

* Double—click on the item.

—  Select the item and choose the Collapse button.

3. To expand or collapse several items at once, choose one of the
following buttons:

*, « Expand All Children—expand all the sub-levels of the currently
selected item

s » Expand All—expand all the sub-levels of all expandable items in
the navigation list

= » Collapse All—collapses all currently expanded items in the
navigation list

p Toopen a form from the navigation list:
1. Check or uncheck Close Other Forms.
2. Select your form of interest.

3. Choose Open.

the form of interest to open it. However, do not double—click
on the Open button. All buttons require only a single click to
activate; using a double click will activate the action twice.

@ Suggestion: Alternatively, you can double—click directly on

» Toopenaform using an LOV window:
1. Check or uncheck Close Other Forms.

2. Use the keyboard shortcut to open the LOV (List of Values)
window.

3. Select the form from the list and choose OK or first reduce the list
by entering a partial form title.
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See Also

Using the Top Ten List

Figure1-6

Using Keyboard Shortcuts: page 1 - 20

If there are forms that you use frequently, you can copy them over to a
navigation top ten list located on the right-hand side of the Navigate
window. The top ten list displays your forms numerically so you can
choose them instantly without having to search for them in the
navigation list. You can add a maximum of ten forms to the top ten list
and you can create a different top ten list for each responsibility you
have access to.

Note: A top ten list is unique for the responsibility and user
sign—-on combination you use.

Egjg Mavigator - System Administrator

s |-

Security:

Security menu

Security . Users

Concurrent . Responsibilities

Profile . Administer Concurrent Managers
Application . Requests: Submit

Install . Concurrent Requests: View

Requests . Menus

Workflow . View All Concurrent Requests (System 4

. Descriptive Flexfield Segments
. Profile System Values

Hemove

M Close Other Forms
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p Tocreate a navigation top ten list:
1. Select a frequently used form from the navigation list.
2. Choose Add.

The form now appears in the navigation top ten list preceded by a
top ten list number.

3. If you wish to remove a form from the top ten list, select that form
in the top ten list and choose Remove.

» Toopen aform from the navigation top ten list:
1. Uncheck or check Close Other Forms.

2. Type the top ten list number that precedes the form you want to
open. You can also select the form you want and choose Open, or
double—click on the form.

Notice that the name and description of that form also appear in
the current selection fields above the navigation list.

See Also

Using a List of Values: page 3-9

Using the Navigator’s Documents Region

If you have a document, such as a particular purchase order, invoice, or
sales order that you want to access later, you can create a link to the
document using the Navigator’s Document feature. The Navigator’s
Document feature allows you to create as many links as you want and
save them in the Documents region of the Navigator window. The
links can be represented as icons in the window or may be viewed as a
list. Documents are defined as ”real-world” documents such as those
listed above, but may also include such documents as employees or
plans. When you use a link to open a document, Oracle Applications
opens the document in the appropriate form window. You can access
the Document region using the alternative region poplist.
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» Adding new Documents to the Navigator

1. Forms that support adding documents to the navigator, enable the
Place on Navigator menu item in the Action menu. Use this menu
item to add your document to the Navigator.

p Opening the Navigator’s Document Region

1. Choose Documents from the alternative region poplist in the
Navigation window.

Once you create a link to a document, the Document region will
open by default when you log on.

p To open aform from the Document Region

1. Select the document link you want to open.

2. Choose Open or double—click it.

» Renaming Documents in the Navigator
1. Select the document link you want to rename.
2. Choose the Rename... button, or double—click the label.
3. Enter the new name, then press OK.

Note: There is a limit of 80 characters for document names.

» Removing Documents from the Navigator
1. Select the document link to be discarded.
2. Choose Remove.

Removing the document link from the navigator has no effect on
the actual document. However, if a record such as a purchase
order is deleted in the 'Enter Purchase Orders’ form, the link in
your navigator displays a message letting you know that your link
is now invalid.

Changing Your Security Access

If you have several responsibilities and you want to work in Oracle
Applications under a different responsibility, you can do so without
exiting Oracle Applications. Similarly, if you have several different
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sign-ons for different responsibility sets, and you want to log on with a
different user sign—on, you can do so without exiting Oracle
Applications.

You can also change the password to your user sign—-on at any time.
Your system administrator may require all users to periodically change
their passwords to maintain better security to Oracle Applications.

» To switch your responsibility:

1.

Click in the Navigate window or choose Navigator from the
Window menu to make the Navigate window active.

Choose Switch Responsibility from the Special menu.

If there are windows still open in your current responsibility,
Oracle Applications asks you to save your changes, if there are any;,
before it closes those windows. You may cancel switching
responsibilities by choosing Cancel in the save changes window.

Note: The save changes window only appears if there are any
changes to save. If there are no changes to save, all open windows
other than the Navigate window close, and Oracle Applications
displays the responsibility list.

Note: If you have only one responsibility, the Switch Responsibility
menu item is disabled.

Select a new responsibility from the Responsibilities window and
choose OK.

The Navigate window title and contents then update to reflect the
new responsibility you choose.

» Tochange your password:

1

Applications User’s Guide

Click in the Navigate window or choose Navigator from the
Window menu to make the Navigate window active.

Choose Change Password from the Special menu, to display the
Password Update window.



Figure1-7

E‘% Paszsword Update

Old Password | |

New Password | |

Re-enter Hew Password | |

Cancel 0K |

3. Enter your old password in the Old Password field.
4. Enter your new password in the New Password field.

5. Enter your new password again in the Re-enter New Password
field.

6. Choose OK.

If the second entry of your new password does not match your
first, Oracle Applications asks you to re-enter your new password
again, until both entries match. Your new password takes effect
immediately.

Note: If you change your mind and do not want to alter your
password, choose Cancel to close the Password Update window.

p Tosignon as a different user:

1. Click in the Navigate window or choose Navigator from the
Window menu to make the Navigate window active.

2. Choose Sign On Again from the Special menu, to display the
Oracle Applications sign—on window.

3. Enter the username and password for your other sign—-on and
choose Connect.

Attention: When you sign on to Oracle Applications as a different

|:| user, any windows that are currently opened will be automatically
closed. If you have not saved your changes, you will be prompted
to do so before you are allowed to continue.

See Also

Toolbar: page 2 -10

Getting Started 1-17




Using Menus

Figure1-8

Oracle Web-Deployed Applications use a SDI presentation (Single
Document Interface). With SDI each window is separate and every
form window contains its own menu. In addition, Oracle
Web-Deployed Applications maintains a host window which contains
the toolbar, message line, and status line.

Eg’iTuulbal |_ O] x|
Action  Edit Query Go Help
1] =) = T
Zlelv] 2iRE] s F sl =lelo] =42
Enter a guery, press Gtrl+F11 to execute, F4 to cancel,
Record: 171 Enter-Guery

The main menu bar includes the following pull-down menus:

+ Action

+ Edit

¢ Query

+ Go

+ Folder

» Special

* Window

* Help

You use these menus to navigate around a form, to edit or retrieve
data, or to perform various other actions.

Note that when the Navigate window is active, as shown in
Figure 1 -9, only the following menus on the menu bar are enabled:

e Action
e Special

e Help
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Figure1-9

See Also

Toolbar
n Edit Guery G0 Folder Special Help
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Requests:Set
Set

Administer request sets
Set Code

Application B Security . Users

Concurrent

Description . Responsibilities
— Profile . Administer Concurrent Managers
Owiner + Application . Requests: Submit
Active Dates + Install . Concurrent Requests: View

Menus
. View All Concurrent Requests {System 4
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Oracle Applications Main Menu Bar: page A -2
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Using Keyboard Shortcuts

Figure1-10

E‘E,il(eys
| Function Ke=

Block Menu Cirl+B

Clear Block F¥

Clear Field Fa

Clear Form Fa

Clear Record FE

Cormmit Ctrl+5

Count Guery F1z

Delete Record Ctrl+Lp

Dizplay Error Shift+Ctrl+E

Diowen Dowen -

J 5

Jor]

Experienced Oracle Applications users can bypass the menu by using a
keyboard shortcut, a specific combination of keystrokes that performs the
same function as a corresponding menu item. Oracle Applications
assigns many commonly used functions, such as Run Query, Save, or
Clear Record to keyboard shortcuts.

You can display a list of the keyboard shortcuts that map to your
computer terminal’s keyboard at any time.

Note: Rather than list the actual keys for a keyboard shortcut,
we refer to keyboard shortcuts in this guide using the format
[Function] where Function represents the function that the
keyboard shortcut performs.

To display a list of keyboard shortcuts:
1. Choose Keyboard Help... from the Help menu.

[]

2. When you finish scrolling through the listing, choose OK to close
the window.

Attention: In addition to keyboard shortcuts, you can also invoke
functions that are identical to specific menu items by choosing
buttons from the toolbar. The toolbar replicates many commonly
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See Also

used menu items so you can invoke their actions quickly without
having to search for them in the menu bar.

Attention: Depending on your GUI environment, you can also
invoke menu items using keystroke combinations that are different
from the keyboard shortcuts described above. For example, each
menu item is identified by a unique underlined character. You can
press a function key that invokes the menu, and then type in the
underlined character of the menu item you want to invoke. For
example, the function key in Windows that invokes the menu is
[Alt]. To choose Print... from the Action menu, you enter [Alt] [A]
[P], where A is underlined in Action and P is underlined in Print....

Toolbar: page 2 - 10
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Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help
menu to pinpoint the type of information you want.

Flgure 1-1 2 Submit Request Window [User, System Administrator, and Flexfields Help) - Netscape

File Edit “iew Go Communicator Help

&P

?1 ’“%? L‘ﬂ ﬂ@’ I

Index Hawigation Glossary Library

Applications

Previous  Hext

Submit Request Window

Usze this window to run a request.

For help on a specific report, open the parameters window and press the help button. If the report
vou chose has no parameters, you can see help by choosing from the st of products and reports.

Oracle Applications Reports and Processes

Tasks

Submitting a Request

Rerun a Prior Request

Customimng the Submit Requests Window
Reference

Owerview of Reports and Prosrams

[=F] |Document; Done

» Todisplay help for a current window:

? 1. Choose Window Help from the Help menu or hold down the
Control key and type 'h’.

A help window appears, providing you with information and a list
of topics associated with the current application window.

2. Click on atopic of interest to display more detailed information.

3. You can use the menus or buttons in the help window to navigate
to other topics of interest, or from the File menu in the help
window, you can choose Exit to quit from Help.
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» Example

m  Suppose you are using Oracle General Ledger and are in the Define
Budget Organization window. You want to know how to create a
budget organization using this window. Choose Window Help
from the Help menu to display a help window.

p To display online help for any of the Oracle Applications products:

1. Choose Oracle Applications Library from the Help menu.

2. Oracle Applications Library opens a help window that lists Oracle
Applications and product family documentation.

Figure1-12 s

+ _Oracle Applications Documentation Library - Netscape

File Edit Yiew Go Communicator Help

|»

O I aCIe Oracle Applications

Library

Applications

Getting Started and
Using Cracle Applications

Product Documentation o

@ Alert @ Crder Entry / Shipping

@ Application Data Export @ Payables

@ Ascets @ Payroll

@ Automotive @ Product Confiourator

@ Bills of Matenial @ Project Costing / Project Billing

@ Cash Management @ Project Manufacturing

@ Capacity @ Purchasing

@ Cost Management @ Quality

@ EDI Gateway @ Receivables

@ Engineering @ Sales Compensation

@ Financial Analyzer Intecration @ Bales and Marketing

@ Ceneral Ledeer @ Service =
4 T - o o ;l_l
= |Document: Done

3. Click on a product of interest to display the contents (list of topics)
for that product’s online documentation.

4. Click on a topic of interest to display a list of subtopics for the
topic.
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Click on a topic to display a window with help on that topic. Use
the buttons in the help window to navigate through the online help.

Select Contents from the help window to return to the main list of
topics for this product at any time.

When you are done using the help window, choose Exit from the
File menu in the help window to close the help window.

» Todisplay version information for Oracle Applications:

1.
2.

Applications User’s Guide

Choose About Oracle Applications from the Help menu.

An About Oracle Applications window, similar to the one shown in
Figure 1 — 13, appears on your screen.

The window provides details about the version of the Oracle
Applications components you are using, your login information,
and information about the current form you are using.

You can supply this information to your system administrator or to
Oracle Customer Support if you need to report a problem.



Figure 1-13

E%Ahuut Oracle Applications

Oracle Applications

s Copyright (c) 1994, 1996 Oracle Corporation,
Redwood Shores, California.
All Rights Beserved.

Product Information —
Oracle Applications  11.0.23
Application Object Library  11.0.23
Oracle Forms  4.5.9.6.0
RDEMS  8.0.3.1.0

Login Information
Site  Global Computers
Application  System Administration
Responsibility  System Administrator
User Hame GLOBAL

Form Information
Form Application  Application Object Library
Form Hame FHDSCAUS
Form Yersion 11.0.6
Form Last Modified 08-0CT-1997 16:15:30 —

o]

3. Choose OK to close this window.

See Also

Toolbar: page 2 -10

Using Keyboard Shortcuts: page 1 — 20
Learning About a Record: page 3-7
Interpreting Messages: page 2 — 22
Requests Window: page 7 - 2
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Exiting Oracle Applications

When you complete your work, you can choose to save or discard any
unsaved work in your form(s) before exiting Oracle Applications.

» Toexit Oracle Applications:

1. Choose Exit Oracle Applications from the Action menu.

If there are no changes to save in your window or windows, Oracle
Applications asks you to confirm your exit.

Figure1-14 E;g Caution
& Exit Oracle Applications?
Cancel | _ |

2. Choose OK to exit Oracle Applications and return to your desktop.
If there are recent changes that you have not yet saved, a window
appears as shown:

Fi 1-15
aure [E3 Decision
:{) You have changes pending.
Cancel ‘ Discard ‘

3. Choose Save to save the changes before exiting. Choose Discard to
exit without saving any changes. Choose Cancel to close this
window and cancel the exit.

Note: You will be asked once for each form that is currently
open and has changes pending.
See Also

Closing Multiple Windows: page 2 — 20
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Oracle Applications
User Interface Basics

CHAPTER

T his chapter introduces you to the anatomy of the Oracle
Applications user interface and teaches you a few simple concepts and
functions you need to start working with Oracle Applications.
Specifically, this chapter describes how to:

» Navigate around Oracle Applications
e Use window functions
« Interpret message explanations

* Access linked forms

Export data to a spreadsheet
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Oracle Applications User Interface

To use Oracle Applications effectively, you need to understand the
components that make up its user interface. The following figures
show Oracle Applications running in a Browser window, displaying
windows typically seen when submitting a single request. We use
these and other figures to illustrate the following major components
and terms:

e screen
e window

e window title

» Oracle Applications window
* modal window

« form

» block

 field

e region

e record

 current record indicator

e message line

* status line

* toolbar

* alternative region

» master—detail relations

* combination block

Figure2-1 1 I3 Toolbar [-[ol=]

2 Action Edit Query Go Folder Special Help
3 2 = Y W o S e N T R e d
4 Entera query; press Cirl+F11 to execute, F4 to cancel
5 Record: 151 Enter-Guery

1. Window

2. Window Title

3. Toolbar
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Figure2-2

4.
5.
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Figure2-3 [535 chedule [x]
(=]
Apply a Saved Schedule... |
— Run the Joh...
15 Start At
" As Soon As Possible
G/once Leave End Date blank to run indefinitely)
16 — Periodically { g
€ On Specific Days Re-tun every [t [pavis) -
17 = Ldvanced
Apply the Interval...
@& From the Start of the prior run
¢ From the Completion of the prior run
[™ Increment date parameters each run
18
™ Save this schedule for use again later Cancel 0K
15. Option Group
16. Selected Option
17. Disabled Option
18. Poplist
Figure2-4 [ Requests T[]
Refresh Data ‘ Find Requests | Submit a New Request... ‘
19 Request ID Parent
| Mame | Phase Status Parameters
= I1736591 Process transaction interf Pending Scheduled {None)
20 jﬁﬁﬁﬁﬂﬂ AutoCreate Configuration Completed Normal 2, 1000946, 115, 2
=1
Hold Request ‘ View Details... | Yiew Dutput ‘
Cancel Request ‘ Diagnostics | ViewLog... ‘
19. Current Record Indicator (If the record allows drill-down the
Current Record Indicator is twice as wide.)
20. Scroll Bar
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Screen

A screen represents the part of your computer monitor that displays
information. A screen is also referred to as a desktop.

Window

A window, as shown in Figure 2 - 2, is a box around a set of related
information on your screen. Many windows can appear on your screen
simultaneously and can overlap, appear adjacent to, or on top of each
other. You can move a window to a different location on your screen.

Window Title

A window title at the top of each window indicates the name of the
window, and occasionally, context information pertinent to the contents
of the window, as shown in Figure 2 — 2. The context information,
which is contained in parentheses, can include the organization, set of
books, or business group that the window contents is associated with.

Oracle Applications Window

Modal Window

Every session of Oracle Applications is associated with a special
window called the Oracle Applications window. The Oracle Applications
window displays the main menu bar and toolbar. The appearance of
the Oracle Applications window varies depending on the Browser you
use.

Certain actions that you perform in Oracle Applications may cause a
modal window to display. A modal window requires you to act on its
contents before you can continue, usually by choosing OK or Cancel.
Examples of modal windows include the list window, shown in
Figure 3 -7: page 3 - 13, the field editor window, shown in, or any
error or message window that may appear.
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Form

Block

Field

2-6

A form is an organized display of fields through which you can quickly
and easily access and enter information to complete a business task.
When you use the Navigate window in Oracle Applications, you
navigate to a form. Each form displays one or more windows and
maps to a complete business or task flow. Figure 2 — 4 displays the first
window of the Requests form. Note that a given window can appear in
more than one form if it accomplishes a task that is part of more than
one business flow.

The forms you can navigate to depend on the responsibility you choose
when you sign on to Oracle Applications. A form in one responsibility
may vary from the same form in another responsibility, such that
certain windows or buttons may exist in one but not the other. This
enables your organization to maintain security at a functional level so
that only a user with a given responsibility can access a particular set of
functions (for example, windows or buttons). See: Overview of
Function Security, Oracle Applications System Administrator’s Guide.

Every Oracle Applications window consists of one or more blocks. A
block contains information pertaining to a specific business entity. All
required fields in a block must be completed before you can move to
the next block. Generally, the first or only block in a window assumes
the name of the window. Otherwise, a block name appears across the
top of the block with a horizontal line marking the beginning of the
block.

Each block contains fields you use to enter, view, update, or delete
information. A field prompt describes each field by telling you what
kind of information appears in the field or what kind of information
you should enter in the field. For example, the Submit Request
window shown in Figure 2 — 2 includes fields named Request Name,
Parameters, and Language. Fields that allow you to enter data are
white and display a beveled border. Fields that are display—only are
white and do not have a beveled border. Fields that provide drill-down
capability, accessed by double clicking on the field, are displayed in
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Region

green underlined text on a white background. If a field is disabled, it is
dimmed, as shown in Figure 2 — 2.

The term field generally refers to a text field, an area in a window that
either displays data or allows you to enter data. However, a field can
also include the following:

button—You choose a button to initiate a predefined action. A
button is usually labeled with text to describe its action or it can be
an icon whose image illustrates its action.

check box—You can indicate an on/off or yes/no state for a value
by checking or unchecking its check box.

option group—An option group is a set of option buttons. You can
choose only one option button in an option group at a time, and the
option group takes on that button’s value after you choose it. An
option button or option group is also referred to as a radio button or
radio group, respectively, using the metaphor of a car radio’s station
buttons.

poplist—A poplist lets you choose a single value from a short list.
To choose a value, click on the poplist to display the list of choices,
then drag your mouse through the list to the desired value. Release
your mouse button to choose the value you highlight and display it
in the poplist field. A poplist is also sometimes known as a list.

A region is a collection of logically-related fields set apart from other
fields by a horizontal line across the window or a rectangular box as
shown in the At These Times... region of the Submit Request window in
Figure 2 — 2. Each block can optionally contain one or more regions.
Regions help to organize the information within a block.

A scrollable region is a region whose contents are not entirely visible in a
window. A scrollable region contains a horizontal or vertical scroll bar
so that you can scroll horizontally or vertically to view additional fields
hidden in the region. In addition, if a field is partially hidden you can
scroll the region to fully display the field by clicking on the partially
hidden field.
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Record

A record is one occurrence of data stored in all the fields of a block. A
record is also referred to as a row or a transaction, since one record
either corresponds to one row of data in a database table or one logical
transaction.

The Submit Request window is an example of a single—record block. To
view the next record of information, you choose Next Record from the
Go menu to replace all the field values in that block with field values
for the next record.

The Requests window, by contrast, displays up to ten records of
information simultaneously, with each record representing a request
submitted from the Submit Request window. The Requests window
contains fields arranged on the screen horizontally adjacent to each
other, leaving enough space in the window to display up to ten records
of information beneath the field headings. The Requests window is an
example of a multi-record block.

The fields in a multi-record block appear as columns. You can use the
vertical scroll bar located to the left of the first column to view any
additional records hidden in that block.

Current Record Indicator

Figure2-5

Multi-record blocks often display a current record indicator to the left of
each record. A current record indicator is a one character field that
when filled in, identifies a record as being the current or ’active’ record.

ser

+Name
Lol

[z1 nrA

Sometimes, a current record indicator appears as a two character—-wide
field, indicating that the current multi-record block supports a
capability called drill-down. Drill-down lets you click on a current
record indicator to navigate directly to another window that displays
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either details of the current record or information related to the current
record. See: Combination Block: page 2 — 14.

Message Line

The message line near the bottom of the Oracle Applications window
displays helpful hints or messages when you encounter a minor error,
as shown in Figure 2 — 2. See: Interpreting Messages: page 2 — 22.

Status Line

Figure2-6 E2 Toolbar = S

Action Edit Query Go Folder Special Help
i B

e 1 - S

ww
pad

Enter a query, press Ctrl+F 11 to execute, F4 to cancel

4’ Record: 111 Enter-Query

The status line appearing below the message line of a Oracle
Applications window displays status information about the current
window or field, as shown in Figure 2 — 6. A status line can contain the
following:

e ~or v—these symbols indicate that there are previous records
before or additional records following the current record in the
current block.

 ENTER QUERY—this phrase indicates that the current block is
in Enter Query mode, so that you can specify search criteria for a
query.

e Count—this counter indicates the number of records you have
accessed in this window. For example: a query may return
several records but the count number displayed is 1. This
number increases with each new record you access but does not
decrease when you return to a prior record.

» <Insert>—this indicator or lamp informs you that the current
window is in insert character mode.

» <List>—this lamp appears when a list of values is available for
the current field.
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See Also

Using a List of Values: page 3-9

Searching for Information: page 3 -19

Toolbar

The toolbar, as shown in Figure 2 — 1, is a collection of iconic buttons
that each perform a specific action when you choose it. Each toolbar
button replicates a commonly—-used menu item. Depending on the
context of the current field or window, a toolbar button can be enabled
or disabled. You can display help for an enabled toolbar button by
holding your mouse over the button.

The toolbar buttons and the actions they perform are as follows:

Navigate To...—open the Navigate window. See: Navigating to
Another Form: page 2 - 17.

Zoom—invoke a custom-defined Zoom. See: Navigating to a
Custom-Defined Form: page 2 — 18.

Save—save any pending changes in the current form. See: Saving
Your Work: page 2 — 20.

S| (B (& (@

Save and Proceed—save any pending changes and prepare the
form for the entry of the next record. See: Saving Your Work: page
2-20.

= Print...—print the current screen or in special cases, display a list of
reports to print. See: Printing a Window: page 2 - 19.

ol

Clear Form—clear all pending changes in the current form. Clears
all child windows but does not close them. See: Clearing Data:
page 3-3.

7

Summary/Detail—switch between the summary and detail view of
the current record. See: Navigating Within a Combination Block:
page 2 - 17.

A Find...—open Query Find window to select records. See: Using
Query Find: page 3 - 20.

4

New Record—create a new record. See: Creating and Deleting
Records: page 3 - 5.

% Delete Record—delete the current record from the database. See:
Creating and Deleting Records: page 3 - 5.
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Clear Record—clear the current record from the window. See:
Clearing Data: page 3 - 3.

Folder Tools—open the Folder tool palette. See: Using the Folder
Tool Palette: page 4 - 3.

Translations...—open the Translations window. See: Creating
Translations for a Record: page 3 - 5.

Attachments...—open the Attachments window to update or view
the current attachment or add a new attachment. See: About
Attachments: page 8 - 2.

or

No Attachments—open the Attachments window to create a new
attachment. See: About Attachments: page 8 — 2.

Note: Only one of the above two toolbar buttons appears at
any given time to indicate if an attachment exists in the current
context.

List of Values...—show the list of values for the current field. See:
Choosing a Value from a List: page 3 - 13.

Edit Field...—open the Editor window for the current field. See:
Invoking an Editor for a Field: page 3 - 6.

Window Help—open help for the current window. See: Getting
Help: page 1 - 22.

Up to three additional toolbar buttons may appear to the right of the
Help button. The presence of these additional buttons depends on the
application window you currently have active. For example, if you
make the Navigate window the active window, you see the following
additional button:

Switch Responsibility...—display the Responsibilities window.
See: Changing Your Security Access: page 1 - 15.

If your cursor is in a window for a specific Oracle Applications
product, such as Oracle Human Resources, you may see a different set
of buttons that perform actions that are specific to that product. The
actions for these buttons replicate menu items on the Special menu,
which also vary depending on the application window that is currently
active. Check the reference guide or display Oracle Applications
Library Help for your product to learn more about these additional
buttons and the Special menu.
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Alternative Regions

[— 18]

An alternative region is one of a collection of regions that occupy the
same space in a window where only one region can be displayed at any
time. You can identify an alternative region by a poplist that displays
the current region title, which sits on top of a horizontal line that spans
the region. You can choose to display another alternative region by
clicking on the poplist and selecting another region name from the list.
The region updates to display the fields of the new alternative region
you choose.

Master—detail Relations

2-12

Master—detail relations are an association between two blocks—a master
block and its detail block. As in the relationship between the Batch and
Journals windows in your Oracle General Ledger application. Each
batch (master record) is associated with a set of journal entries (detail
records).

When two blocks are linked by a master—detail relation;

« the detail block displays only those records that are associated
with the current (master) record in the master block

» querying between the two blocks is always coordinated

 usually you cannot enter information in the detail window until
you have selected a master record.

For example, when you display a different record in a master block, the
detail block displays the detail record(s) that correspond to the new
master record. Similarly, if you perform a search in a master block, the
detail block displays the detail record(s) associated with the master
record that was retrieved from the search.

Master and detail blocks can often appear in the same window or they
can each appear in separate windows. When querying the details may
be slow (usually when they are in separate windows), an unlabeled
coordination check box appears in the upper right corner of the detail
block window. This check box lets you decide whether to constantly
update the coordination of records between a master and a detail
window when the detail window is open in the background.
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For example, suppose you have a master and a detail window, and the
detail window displays records that pertain to the current record in the
master window. If you uncheck the coordination check box and then
display another record in the master window, the detail window clears
itself and does not display any data until you move your cursor into
the detail window. At that point, it displays the detail record(s) that
match the current master record. If you check the coordination check
box and display another record in the master window, the detail
window automatically refreshes to display the detail record(s) that
match the current master record.

Note: When you first open a detail window or when you
query a new record in the master window, the detail window
always updates to display the detail record that matches the
current master record regardless of whether the coordination
check box is checked or unchecked.

Drill Down Indicators

When a record or field provides the drill-down capability, it lets you
navigate directly to another window that displays details of the current
record or field, or information related to the current record or field.

Records that provide drill down are indicated by a wide width current
record indicator. By double—clicking on the indicator you will navigate
to the detail window.

When a field provides drill-down it is rendered in green—-underlined
text on a white background. Double—click on the field to navigate to
the detail window.
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Combination Blocks

Although a multi-record block shows you several records at once, it
usually does so at the expense of showing you fewer fields for each
record or only having some of the fields visible simultaneously. A
combination block gives you the benefits of both multi-record and
single-record blocks by displaying the fields of a record in both
multi-record (summary) and single-record (detail) formats. Each
format appears in its own separate window that you can easily
navigate between.

it

When you first navigate to a combination block, a summary window
appears. You can select a record in the summary window and choose
Summary/Detail from the Go menu to display the detail window for
that record. This menu item, as well as the Summary/Detail toolbar
button, lets you switch back and forth between the two windows which
are always coordinated to show the same record.

You can also drill down from the summary window to the detail
window for a record by clicking on the record’s current record
indicator. To return to the summary window, simply choose the
Summary/Detail toolbar button or menu item. See: Current Record
Indicator: page 2 - 8.
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Navigating in Oracle Applications

To accomplish a business task in Oracle Applications, you need to
know how to navigate around Oracle Applications. There are several
types of navigation you can perform. You can navigate:

e within a window

* between windows

between the windows of a combination block

to another form

¢ to acustom form

Navigating Within a Window

>

To navigate within a window:

m  Choose one of the following three methods:
< move the cursor with your mouse
« choose an appropriate menu item
« enter an appropriate keyboard shortcut

Table 2 — 1 illustrates the default menu and keyboard shortcut methods
you can use to navigate around the records, fields, and blocks of an
Oracle Applications window running in the Microsoft Windows
environment.

Window Navigation Functions

Function
Type Function Menu Item Keyboard Shortcut
- _________________________________
Record Go to Previous Go—>Previous Record [Up Arrow]
Go to Next Go—>Next Record [Down Arrow]
Go to First Go—>First Record

Table2-1 (Page 1of2)
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Function

Type Function Menu Item Keyboard Shortcut
Go to Last Go->Last Record

Field Go to Previous Go->Previous Field [Shift]-[Tab]
Go to Next Go->Next Field [Tab]
Go to Next (From a [CtrI]-[tab]

Multi-Line Text Item)

Block Go to Previous Go—>Previous Block [Ctrl]-[Page Up]

Go to Next Go—>Next Block [Ctrl]-[Page Down]

Table2-1 (Page 2 of 2)

Note: You can navigate to a display only field using your
mouse or the Go to Previous function.

Note: The keyboard shortcuts mappings outlined in the
Window Navigation Functions table are the default mappings
and may be different if your System Administrator modifies
your Oracle Terminal Settings.

Suggestion: You can choose Next Block or Previous Block
from the Go menu to help you distinguish between the blocks
and regions in a window, since blocks and regions can have a
similar appearance.

Suggestion: If you are working in a window and accidentally
press a wrong key or button that prevents you from further
navigation, you can choose Clear Record from the Edit menu,
to undo your changes in the window and begin again.

L1 O =)

Attention: Whereas [Tab] moves you between fields, pressing
[Enter] selects the default button in the window (if there is a
default). If you try using [Enter] to navigate between fields,
you may unintentionally activate the default button.

Attention: If a large number (more than 100) records are
queried, Go—>Last Record will retrieve 100 records then open a
decision window prompting you to either:

Stop — Displays the last record of the records retrieved.

Continue to End - Retreives all records queried and displays
the last record of the query.
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Continue — Retreives the next 100 records and repeats the
decision window unless all records have been retrieved. If all
records have been retrieved then the last record will be
displayed

Navigating Between Windows

In a GUI environment, you can navigate between the windows of an
application by simply choosing a specific window with your mouse.
This, however, can be inconvenient if you have many overlapping
windows where you have to move or close one or more windows
before you can find the window of interest.

p To navigate between the open windows of an application:

®  Click on the desired window.

m  Choose the name of the window you want to navigate to from the
Window menu.

The Window menu automatically lists all the titles of the windows
that are currently open in Oracle Applications.

Navigating Within a Combination Block

If you are working in a combination block, you can easily navigate
between the summary and detail windows of the block.

p To navigate between the summary and detail views of a block:

Bz ®  Choose Summary/Detail from the Go menu.

Navigating to Another Form

To open another form in your application use the Navigate window.
The Navigate window is always available during a session.
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p To navigate to another form in an application:

<k m  |If the Navigate window is hidden behind another window or is
minimized, choose Navigate To... from the Action menu or
Navigator from the Window menu.

See Also

Opening a Form From the Navigate Window: page 1 - 10

Navigating to a Custom-Defined Form

You can create a custom form to use with Oracle Applications and
define a zoom that takes you from a specific Oracle Applications form
or window to your custom form.

Note: This entry is only enabled if you have coded a zoom for
the current form or block.

» Tozoom to a custom form:

& m  Choose Zoom from the Action menu.

See Also

Zoom: page 2 - 24
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Using Window Functions

As you use Oracle Applications, you may find a need to perform any of
the following miscellaneous window functions:

* refreshing a window
e printing a window
* saving your work

 closing multiple windows

Refreshing a Window

If a window is improperly drawn, you can refresh your window to
correct the problem.

p» Torefresh a window:

m  Choose Refresh from the Action menu.

Printing a Window

You can print an image of a current window at any time.

p To printacurrent window:
1. Choose Print... from the Action menu.

2. A consecutive series of modal windows appear. In general, the
windows prompt you for information such as the printer to print
to, size of image to print, orientation to print, number of copies to
print, format to save the image to if you want to save it to a file,
and so on. Enter the necessary information in these windows.

Attention: In the Microsoft Windows GUI environment, if your

|:| PC does not have a printer driver installed, you do not see any
modal windows appear after choosing Print... from the Action
menu. These modal windows must appear for your window to
print. Make sure you install a printer driver and define at least one
printer before trying to print.

Refer to your Microsoft Windows documentation for information
on how to install printer drivers and define printers.
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3. Another window appears that tells you Oracle Applications is
about to capture the image of your window and that you should
not move or obstruct the window you want to print. Choose OK
and wait for the image capture to complete.

4. A final window appears to confirm that the image capture is
complete. Choose OK.

|:| Attention: In some screens of Oracle Applications the Print...
action may display a dialog that allows you to print specific reports
in addition to the current window.

Saving Your Work

When you save your work, Oracle Applications updates the underlying
database with the work you have done and then informs you that the
transaction is complete. Saving your work is sometimes referred to as
saving a change or a transaction.

Oracle Applications always validates your work upon saving it. If any
of the data you enter is invalid or missing, Oracle Applications
provides you with a message describing the problem and does not save
your work.

» To save your work:

Tl m  Choose Save from the Action menu.

p To save your work and automatically proceed to the next transaction:

W m  Choose Save and Proceed from the Action menu to save any
changes you have made to the current window(s) and move to the
next record (new or existing).

Closing a Form

p» Toclose a form:

¢ Choose Close Form from the Action menu.

» Check Close Other Forms in the Navigate window and navigate
to another form.

¢ Choose Close from the control menu for that window.
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» Exit the application by choosing Exit Oracle Applications from
the Action menu.

Note: When you close the initial window of a form, all of it’s
related windows close also.
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Interpreting Messages

Figure2-8

Figure2-9

When your application needs to give you a hint or a basic error (such
as the current field is not updatable) it displays a short message in the
message line, as shown in the Oracle Applications window in

Figure 2 - 8.

& Toolbar [_To]=]
Action Edit Query Go Folder Specizl Help
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4} Enter a query; press Cirl+F11 to execute, F4 to cancel

Record: 111 Enter-Query
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When your application needs to inform you of something more
significant (such as you entered fewer than five characters when
changing your password) it displays an error dialog, as shown in
Figure 2 - 9. Choose OK to close the error dialog.

Passwords must be at least 5
characters long.

A History button may also appear in the error window if an error of a
more serious nature occurs. Choose History to view more details
about the current error and about recent errors you got in other error
windows. Your application saves a history of your five most recent
error messages and displays them when you choose History.

Note: After you view you error history, the next error will start
a new blank history list. It also clears previous messages when
you change your responsibility.

Attention: Often, messages and errors are preceded by a

|:| message or error code. Codes that contain the preface FRM-
arise from Oracle Forms, the underlying product that provides
Oracle Applications with its graphical user interface. Codes
that contain the preface ORA- arise from the Oracle database.
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Codes that contain the preface APP- arise from Oracle
Applications. These codes help your system administrator or
Oracle Customer Support expert diagnose the errors you may
encounter.
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Linked Forms

In certain cases, it is useful to be able to access one form directly from
another. For example, it may be very convenient to be able to open the
Customers form directly from the Sales Orders form, to allow entry of
a new customer while creating a new order, or to view information
about a customer that has already been defined. From within certain
forms you can open another form directly by using the Special menu or,
depending on how Oracle Applications has been customized at your
site, by choosing Zoom from the Go menu.

Special Menu

In some Oracle Applications windows, related inquiry or entry forms
may be available from the Special menu. Depending on how many of
these related forms are linked, they may be available directly as entries
on the Special menu or by choosing the Go To... entry from the Special
menu. Look in the Special menu of the window you are in or check the
Reference Guide of the product you are using to see if the above
options are available.

Zoom

In certain cases, you may be able to access one form directly from
another by choosing Zoom from the Action menu. Oracle Applications
ship with no Zooms defined, and the Zoom entry on the Action menu
is disabled. When this feature is available and how it behaves are
determined by how Oracle Applications is customized at your site.
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Entering and Querying
Data

CHAPTER

T his chapter discusses features that help you enter and query data
from Oracle Applications. Specifically, this chapter describes how:

» To use editing functions
« To use a list of values to simplify your data entry
« To enter a date using the Calendar

» To search for information
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Using Editing Functions

To enter or update data in a form, you can use the following field and
record editing functions:

 cutting, copying, and pasting text
 clearing data

» duplicating data from a previous record
 creating and deleting records

« displaying a list of values for a field
 invoking a field editor

« getting information about a record

Many of these editing functions are listed on the Edit menu of the main
menu bar.

See Also

Edit Menu: page A-3
Using a List of Values: page 3-9
Overview of Flexfields: page 5 -2

Entering Data into Flexfields: page 5 - 10

Cutting, Copying, and Pasting Text in a Field

You can choose Cut, Copy, or Paste from the Edit menu to manipulate
data in fields.

p To cut, copy, and paste data in a field:

1. Select the data in a field. You can either drag your mouse over the
data or double—click on the data to highlight and select it. When
you tab to a text field the data is automatically selected and ready
to cut or copy.

2. Choose Cut or Copy from the Edit menu to cut or copy the selected
data. Cutis only available if the field can be updated.

Note that Cut is like Copy, except Cut also removes the data from
the field.
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Clearing Data

3.

Move your cursor to another field, then choose Paste from the Edit
menu to paste the cut or copied data into the current field.

You can clear data from the screen at almost any time. The data you
clear is simply erased from the screen and not deleted from your
database. Note however, that if the data is new and has never been
saved to the database, it will be lost permanently when you clear it
from the screen.

To clear selected data from a field:

Choose Clear Field from the Edit menu.

Note that the data you clear from the field is not available for
pasting into another field. Choose Cut from the Edit menu if you
want to paste the data elsewhere.

The Clear Field function is not available for fields that cannot be
updated.

To clear a record of data:

Choose Clear Record from the Edit menu.

This action erases the values in all the fields of your current record
and returns your cursor to the first field of the prior record.

@ Suggestion: If you are in a window that you do not want to

be in or you accidentally perform an unwanted action, you can
use Clear Record from the Edit menu to clear the current
record and begin again.

To clear data from the current block:

Choose Clear Block from the Edit menu.

When completed, this action returns your cursor to the first field in
the current block. Note that if the current block is a multi-record
block, this action erases all records displayed in the block. If any
changes are pending you will be asked for confirmation before the
records are erased.

Attention: If you enter data in only some of the fields in a block or
window, you must first choose Clear Record from the Edit menu to
clear the partial record before choosing Clear Form.
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» Toclear all data from a form:

Choose Clear Form from the Edit menu.

After this action erases the data from all the fields of the current
form, it returns your cursor to the first field of the form.

Duplicating Data From a Previous Record

To save time during data entry, you can duplicate data from a previous
record if much of the data needs to be repeated in a new record.

p Tocopy a field value from the previous record:

1.
2.

Enter a new record or query an existing record in your form.

Navigate to the field whose value you want to duplicate in the new
record.

Choose Duplicate Field Above from the Edit menu to copy the
field value from the previous record to the current record.

» Tocopy all field values from the previous record (when available):

[]

See Also
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1.
2.

Enter a new record or query an existing record in your form.

Choose New Record from the Edit menu to insert a new record
after the existing record.

Choose Duplicate Record Above from the Edit menu.

Attention: If your current block requires all records to be unique,
the Duplicate Record Above menu item may not duplicate those
fields that must be unique.

Also, the Duplicate Field Above and Duplicate Record Above
menu items are not available if there is no previous record, that is,
if you are currently on the first record of a block.

Saving Your Work: page 2 — 20

Searching for Information: page 3 -19



Creating and Deleting Records

4

[]

You can enter new records in the database or delete existing records
from the database.

To create a new record:
1. Choose New Record from the Edit menu.

When you select this menu item in a multi-record block, Oracle
Applications moves the current record down and inserts a new
blank row. You add a new record simply by filling in this blank
row.

When you choose New Record in a single-record block, Oracle
Applications displays a blank record in the current block so you
can enter data for a new record.

2. When you finish entering the data for your new record, choose

Save or Save and Proceed from the Action menu to save the record

to the database.

To delete a record from the database:

1. Choose Delete Record from the Edit menu.

This action initially erases the current record from your screen, and

returns your cursor to the first field of the next record.

2. To actually delete the record from the database, choose Save or
Save and Proceed from the Action menu.

Attention: If you exit Oracle Applications without saving your
work, the record does not get deleted from the database.

Creating Translations for a Record

You can enter translated values for specific records in the database or
update existing records in the database. You can identify windows
where translations are allowed by the enabled translation icon.

To enter a translation for a record:

1. Select the record you wish to translate.

2. Choose the Translation icon from the Toolbar..
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[ Translation

[ [User Function Name [Descriptian [Source Language
AL Define Attribute Values \Deﬁne attribute values for object instance \ American English
American English [Define Attribute Values ‘Deﬁne attribute values for object instance ‘ American English
4] | »
Cancel QK

This action opens the Translations window. When you open the
translations window, the fields that can be translated are displayed
in a multi-record block as columns. You may need to use the
scrollbar to see all of the columns. Each row represents an installed
language version of the Applications. The source language
represents the original language version of the apps used to enter
the data record.

3. Enter the translation for the appropriate fields.
4. Choose OK

Invoking an Editor for a Field

Figure3-1

You can display an Editor window to view, enter, or update the entire
contents of a text field. The Editor window is especially useful for
editing scrollable text fields. A scrollable text field is a field whose
actual width is longer than its display width and whose content you
can view by scrolling through the field.

p To use the Editor window for a field:

1. Choose Edit Field... from the Edit menu.

2. Enter a new value or edit the existing value in the Editor window.

[=: E ditor
Adjustment Account Class| =
k2
Search | 0] 4 ‘ Cancel
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|:| Attention: If the current field is a display-only field, then the
Editor window does not allow changes.

3. To search for a phrase and replace it with another phrase, you can
choose Search in the Editor window to display a Search/Replace
window.

Fi 3-2
igure E;a Search/Heplace

Search far: " |

Replace with: | |

Search | Replace ‘ ReplaceAII| Cancel |

4. Enter a value in the Search for: field, and if you want to replace
that value with another value, enter a value in the Replace with:
field.

5. Choose Search to search for the value, or choose Replace or
Replace All to search for the value and replace the first occurrence
or all occurrences with your new value, respectively.

6. Choose Cancel to close the Search/Replace window.

7. When you are satisfied with the value in the Editor window, choose
OK to close the window and insert the value into the field.

Learning About a Record

You can always display information about a record that has been saved
before. The information includes who created the record, the date of
creation, and the database table where the record resides. You can also
learn who last changed the record using Oracle Applications, the date
of change, and that user’s system logon and terminal information.

p To learn about the current record:
1. Choose About This Record from the Help menu.

A window appears that shows you information about the current
record.
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Figure3-3
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Using a List of Values

A list of values provides you with a powerful, easy-to—use data entry
method that increases your accuracy and productivity. A list of values
makes data entry an easy task for novice users, and lets power users
enter correct data with a minimum number of keystrokes.

Oracle Applications tells you when a list of acceptable input values is
available for a field by illuminating the <List> lamp on the status line
and enabling the LOV icon. When you display a list, the values appear
in a window with a title that describes the contents.

Note: The list that we describe here differs from the list
associated with a poplist field. You identify a poplist field by
its special poplist icon. You identify a text field containing a
list of values by the <List> lamp that appears on the status line
and the enabled LOV icon when your cursor is in that text
field.

Note: One of the first list of value windows you encounter
when you use Oracle Applications is the Responsibilities
window that appears when you sign on if you have more than
one responsibility.

Note: This indication is not reliable when in query mode. The
LOV lamp and icon may be enabled even though no list is
available when you are in query mode. This occurs when an
LOV exists for that file, but that LOV is not correct for all the
values available in Query Mode.

Basic Business Needs

A list of values provides you with the features you need to satisfy the
following basic data entry needs:

« Enter data quickly and easily without having to memorize or
look up valid data for each field. You can choose data from an
online list of acceptable input choices whenever you wish.

« Rely upon Oracle Applications to validate your input during
data entry. When you enter incorrect data, you know right away
so that you can make appropriate corrections.
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Major List Features

AutoSelection

A list of values offers a feature called AutoSelection that lets you
choose a valid value from the list with a single keystroke. When you
display the list window, you can type the first character of the choice
you want in the window. If only one choice begins with the character
you enter, AutsoSelection selects the choice, closes the list window, and
enters the value in the appropriate field.

AutoReduction

In addition to AutoSelection, you can also use a feature called
AutoReduction to help you further simplify and accelerate your data
entry. For example, you might want to shorten a list so that you only
have to scan a subset of values before choosing a final value. Type in
the list window, the first character or characters of the subset you want.
If there are several values that match, AutoReduction shortens the list
to just those matching values.

To expand a reduced list of choices in a list window, simply press
[Backspace]. Just as AutoReduction incrementally reduces a list of
values as you enter additional character(s), pressing [Backspace]
incrementally expands a list.

Any time you reduce the list to a single entry, AutoSelection selects the
entry and enters it into the appropriate field for you.

List Search

You can use AutoReduction to reduce a list when you know the first
few characters of your choice. But if you do not know the initial
characters of your choice, but do know that your choice contains a
certain word or set of characters, you can perform a list search to
reduce a list.

In the list window, enter any group of characters as search criterion in
the Find field, as shown in Figure 3 — 4 and choose Find. You can use
wildcard characters such as percent sign [%], which represents any
number of characters, or underline [_], which represents a single
character, in your search criterion.
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Figure 3-4

Figure3-5

E%a Reports

Find|% |

AF Credit Balance Repart
AP Poruguese EFT Listing

Europear
AF Taxpayer |D Exception Repart Europeat
AP Third Party Operations Europear
AF Third Party Operations Electranic Transfer Europear
AP WAT Compliance Report Europear
AP VAT Reconciliation Detail Repart Europeat
AP Yendar Recapitulative Extract File Europear
AP Yendors Recapitulative Repoart Europear
AR Credit Balance Report Europear
AR Customer Recapitulative Extract File Europear
AR Customers Recapitulative Report Europeat

AR Invoice Format

Europear =
4 | »

Find ‘ QK ‘Cancel‘

For example, to reduce the above list to just those choices containing
the phrase “schedule”, enter %schedule% in the Find field and choose

Find. A reduced list appears, displaying just those choices containing
the phrase “schedule”.

i Reports
Find[%schedules |
Anplicatic
¥ ccumulated Depreciation B dule Europes
Hungarian Asset Movement Schedule ; Gross Changes Europear
Inventary ltem History Schedule Europear
Japanese Payment Schedule Report Oracla P
1 | o
Find ‘ [0 :4 ‘ Cancel ‘
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Figure 3-6

|:| Attention: The phrase you enter for a list search is not
case-sensitive.

LongList

If a field has a longlist, that is, it typically has a list of more than 100
values, Oracle Applications displays the following window when you
try to display the list of values:

This is a long list. Please enter partial segqment values to shorten list

[tern | ‘

Cancel | 0K |

Since it takes less time to display a reduced list than a complete
longlist, Oracle Applications prompts you to enter the first few
characters that occur in your value of interest to reduce the complete
list. The partial value you enter can also include wildcard characters.

If you have to view the entire longlist, you can enter % at the prompt to
display all the values.

|:| Attention: To avoid excessive network traffic and reduced
performance, try to enter criteria other than just "%’ whenever
possible.

Power List

Power list provides an even faster method of data entry. If a field
displays a <List> lamp and you know the value you want, simply enter
the first few characters of the value in the field and press [Tab] to let
Power list complete the entry for you. You can also include wildcard
characters with the characters you enter. You do not have to display
the list window.

If more than one value matches the characters you specify, a list
window containing those values appears. If no values match the
characters you enter, an error message is displayed on the message line.
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Choosing a Value from a List

When you display a list of values, you may notice that some list
windows display one column of information while others display
more. All list windows, however, provide a descriptive heading at the
top of each column. Below each heading is a list of choices.

p Tochoose a value from a list:

1. Choose List of Values... from the Edit menu to display a list similar
to the one shown in Figure 3 -7.

Figure 3-7 [E} Applications

Find|s |

Application ipti =
on Implementation

Application Object Library Oracle Application Object Library

Application Report Generator Application Report Generator

Application Liilities Oracle Application Utilities

Applications DBA Applications DBA

AgiaiPacific Localizations Oracle AsiafPacific Localizations

Demo Order Entry (A0L Class) Demao for AOL class (Develop Extensions to

European Localizations Oracle European Lacalizations

Glohal Accounting Engine Glohal Accounting Engine

Imaging

Latin America Localizations Oracle Latin America Localizations

Oracle Advanced Benefits Oracle Advanced Benefits

Oracle Advanced Planning Foundation Oracle Advanced Planning Foundation -

J @ 1 f
Find | Ok ‘ Cancel ‘

2. You can reduce the length of a list using one of two methods:

« Without clicking in the Find field, type the first character(s) of a
value to autoreduce the list to just those values in the first column
that match the characters you enter. Press [Backspace] to undo
an autoreduction. If you autoreduce the list to a single value, the
list window closes and inserts the final value in the current field.

» Search for a value in the first column of a list by clicking in the
Find field and then entering search criteria in the Find field and
choosing the Find button. If the search finds a single value, the
list window closes and inserts the value in the field. If the search
finds several values, you can perform a more specific search or
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Modifying a List

use one of the methods described in step 3 to choose a specific
value from the reduced list.

3. You can also choose a value directly from the list using one of three
methods:

« Use your mouse to scroll through the list and double—click on a
value to choose it.

» Use your mouse to scroll through the list and single—click on a
value and then press OK to choose it.

» Move your cursor into the list window and press [Up Arrow] or
[Down Arrow] to select a value, and press [Return] to choose
the selected value.

4. Once you choose a value, the list window closes and inserts the
value into the current field.

5. If you want to close a list window without choosing a value, choose
Cancel.

You define new values or delete existing values in a list by editing the
data in the form that stores the source of values for the list. Consult the
reference guide for your Oracle Applications product to identify the
form that contains the source of values for a specific list.

For example, in your Oracle General Ledger application, the list of
values that appears in the Source field of the Suspense Accounts form
come from the journal source values entered in the Journal Sources
form.

Applying Standards to a List

To take full advantage of all Oracle Applications features, including a
list of values, remember the importance of standards. For example,
you should follow consistent, helpful naming conventions when you
enter a value in a ”list source” field. Where possible, use source values
whose initial letters are unique to best take advantage of Power list.
Similarly, develop names with memorable key words or groups of
characters to help simplify your search through a list window.
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Using the Calendar to Enter Dates

You can enter a value directly into a date field using the
DD-MON-YYYY format (i.e. 08—-AUG-1996) or use the calendar to
enter a value. When entering the date directly always enter the
complete date. Entering the year as only two digits may cause the date
to be stored incorrectly. For example, if you enter 08—AUG-96 as your
date, it may be stored as 08-AUG-0096. If you are unsure of the date
you should enter in a field, you can display the Calendar window to
help you select a valid value. If your date field also supports time, you
can also use the Calendar window to choose a valid time with the date.

Basic Business Needs

The Calendar lets you satisfy the following business needs:

* Represent dates and time graphically so that you can make a
quick date and time selection without additional typing.

» Select only those dates or date ranges that are appropriate for the
current field.

Using the Calendar Window

If you navigate to a date field that displays the <List> lamp on the
status line, you can use the Calendar window, as shown in Figure 3 - 8,
to help you enter a date.
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Figure 3-8

3-16

Eg’%[lalendal
Pre;é?_:'t': k| =5 February 2000 | 4| =]
S M T W T F S Current
Current 1 2 3 4 s5——Month
Date 6 7o w0 1 12
13 14 15 16 17 18 19
20 M 22 73 M 25 W Nenct
27 28 29[1 2 3 4 Month
Current 5 5 7 8 9 10 N
Date 08-FEB-2000
Cancel | 0K

p» To choose a date in the Calendar window:

i 1. With the cursor in the field of interest, choose List of Values... from
the Edit menu to display the Calendar window.

The date value that appears below the calendar is called the selected
date. If the current field already contains a date, that date appears
as the selected date, otherwise the selected date reflects a value
determined by the current field or by the current system date.

2. Todisplay the next or previous month, click on the right arrow or
o[ e left arrow buttons in the upper left corner of the window,

respectively. You can also press [Down arrow] or [Up arrow] on
your keyboard to display the next or previous month.

The days of the displayed month appear with bold text, while the
days of the previous and next months appear with light text.

3. To display the next or previous year, click on the right arrow or left
] 45| arrow button in the upper right corner of the window, respectively.

You can also press [Next Record] or [Previous Record] on your
keyboard to display the next or previous year, respectively.

the calendar, click on the month and year display located above

@ Suggestion: To quickly display the current month and year in
the calendar.

4. Click on a date to choose a day.

The day you select appears in a box.
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|:| Attention: Disabled buttons that show dimmed text represent
invalid days. You cannot choose an invalid day. Similarly, if a date
field is display—only, you can display the Calendar window for the
field, but you cannot change the date shown on the calendar. The
Cancel button is only shown if you can change the date value.

5. Choose OK to accept the selected date and close the window.
Choose Cancel if you want to close the window without choosing a

date.
p To choose a date and time in the Calendar window:

1. Follow steps 1 through 4 in the section above to choose a date. If
the current field supports both date and time, the Calendar
window also reveals additional time items as shown in Figure 3 - 9.

Figure3-9 —
E‘-‘fj Calendar

4| | February 2000 | 4| 5]

= M T W T F =
o o x1 1 2 3 4 5

6 79 w1 12

13 14 15 16 17 18 19
20 21 22 23 24 25 26

Minute 27 2 29 1 2 3 4
Poplist 5 B 7 8 9 10 11
08-FEB-2000
Hour — ~38 |~ am & PM
Pﬂpllst Cancel OK

2. Select the hour poplist icon to choose an hour between 1 and 12.

3. Select the minute poplist icon to choose a minute value. The
minute poplist displays twelve values between 00 to 55 at 5 minute
increments.

|:| Attention: If a value already exists in the current date and time
field when you display the Calendar window, and the minute value
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is not a 5 minute increment, then the minute poplist displays
thirteen values to include the minute value displayed in the field.

For example, if the current field displays the time 13:16:00, then the
minute poplist includes the twelve values from 00 to 55 at 5 minute
increments plus the value 16.

Choose AM or PM.

Choose OK to accept the selected date and time and close the
window. Choose Cancel if you want to close the window without
choosing a date and time.



Searching for Information

Oracle Applications provides you with easy—to—use search capabilities
to access application information. You can quickly retrieve and review
all available information in your database without having to remember
the information displayed in windows, or print lengthy reports to see
the data. Instead, you can simply run a search to obtain the
information you want and review the data online in the same window
used to enter the data.

This section describes the two methods you can use to search and
retrieve records in a window:

e Query Find
e Query-by-example

In addition, this section also describes a type of window that lets you
immediately query records for review or editing:

« Direct entry windows

Note: We use the words search and query interchangeably to
describe the retrieval of records.

Note: Some windows cannot be searched because they display
only run-time output or they can only be used to submit or run
specific processes. An example is the Run Requests window.
Your application displays a helpful message in the message line
if you attempt to search in such a window.

See Also

Overview of Flexfields: page 5 -2

Searching for Data Using Flexfield Criteria: page 5 - 23

Basic Business Needs

Oracle Applications lets you satisfy the following basic information
search needs:

» Have instant, online access to all of your application information.
You can find information quickly and easily, without having to
use a complex query language.

» Search for a specific record or for a group of records based on
criteria you enter before executing the search. You can retrieve
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this information directly, without having to review all the
information in your application database.

« Search for information using criteria of different types or lengths,
including a single letter, a single word, a group of characters, or
anything else you wish to enter.

» Find out how much information is available that matches your
search criteria before running the search. Otherwise, you might
waste both computer time and your time should your search for
a single piece of information yield 10,000 responses. This feature
is available only when using query-by—-example.

Using Query Find

If you want to query for records in your current block or window, the
simplest way to proceed is to use Query Find. Query Find displays a
window that lets you specify search criteria. Depending on the block
that you invoke Query Find from, one of two types of windows
appears:

* A Find window that contains fields for entering search criteria.
These fields are specific to the current block and often validate
the search criteria you enter against a list of valid values.

Figure 3-10 E%Find Requests M=l E3

& My Completed Requests:

My Requests In Progress
" All My Reguests
—{ Specific Requests
Request 1D I:I
Mame
Date Subrmitted
Date Completed ’—‘

Status -
Phase -
Reguestar | |

[ Include Request Set Stages in Query
Order By |Request 1D |-|

Submit a New Request... | Clear ‘ Find
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Figure 3-11

« A list window, as shown in Figure 3 — 11, that shows all the
possible records that you can retrieve for the block.

[ Find Descriptive Flexfield

Find[% |

Application Title

Application Ohject Library Attachment context

Application Object Library Attachments

Application Object Library Comman Lookups

Application Object Library Concurrent Program Mame

Application Object Library Currencies

Application Object Library Define Sequences

Application Object Library Document Attachments

Application Object Library Document Flexfield =
Find | Ok | Cancel |

Generally, a Find window appears for those blocks that display
multiple records. A list window generally appears for those blocks that
display one record at a time.

To use Query Find:
1. Choose Find from the Query menu.

2. If alist window appears, select the record you want to retrieve and
choose OK to retrieve the record into your current block.

3. IfaFind window appears, enter your search criteria in the
appropriate fields.

If a field does not provide a list of values for you to choose from,
you may enter wildcard characters in the search phrase. You
cannot, however, use query operators (such as >, <, etc.) in a Find
window.

4. Choose Find or choose Next Block from the Go menu, to find any
matching records.

5. Choose Clear to clear the current search criteria from the Find
window so you can enter new search criteria.

Attention: Clearing the Find window does not clear the records
retrieved in your current block, only the conditions of your query
in the find window. If you want to clear the records in your current
block, you must choose Clear Block from the Edit menu, while
your cursor is in that block or perform another search in the Find
window.
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6. Choose New to enter a new record in your current block if your
search finds no matching records.

Attention: The New button exists only if your current block
allows you to enter new records.

7. The Find window remains open even after you perform a search.
You can return to the Find window by clicking on it (if visible),
using the Windows menu, or choosing Find again. When you are
done or when you want to cancel Query Find, choose Close from
the control menu of the Find window.

Performing Query-by—-Example and Query Count

3-22

If you want to retrieve a group of records based on more sophisticated
search criteria than what Query Find allows, you can use a feature
called query-by—example. As an expert user you can use
query-by—example to specify complex search criteria in any of the
fields of your current block. The search criteria can include specific
values, phrases containing wildcard characters, and/or phrases
containing query operators to help you pinpoint the data of interest.

In addition, if you do not actually need to retrieve the records from a
query-by—-example search, but only want to know how many records
match your search criteria, you can perform a query count to save
yourself some time.

Matching Exact Values

In some cases you want to search for information that matches exact
values in one or more fields. For example, suppose you want to search
for a budget named FY90 in the Define Budget window of your Oracle
General Ledger application. Simply enter the value FY90 in the Name
field. You should be precise in your use of uppercase and lowercase,
since “fy90” is not always equivalent to “FY90” in query-by-example
mode (some fields may not have case-insensitive query).

Finding Patterns With Wildcards

Include wildcard characters in your search criteria to search for
particular patterns in your data. You can use the percent ‘%’ wildcard
within a field to represent any number of characters (including no
characters), or use the underline ’_" wildcard to represent any single
character. For example, if you want to retrieve all records that contain
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the word “Central” in a specific field, you would enter the search
criterion %Central% in that field.

Using Query Operators

Use query operators in your search criteria to restrict your search to the
information you need. The query operators you can use in most fields
include:

Query Operators

Operator Meaning Example Expression

= equals ="Janet’
=107

I= is not 1="Bob’
1=109

> greater than >99.1
>’01-JAN-93’

>= at least >=55

< less than < 1000.00

<= at most <=100

#BETWEEN between two values | #BETWEEN 1 AND 1000

Table 3-1 Query Operators (Page 1 of 1)

Attention: If your field contains character or date values and

|:| you are using operators, you must enclose the character or date
value in your expression in single quotes as shown in the above
examples.

|:| Attention: You cannot use query operators on time fields.

Attention: When you use the #BETWEEN query operator, the

|:| search criterion “#BETWEEN valuel AND value2” retrieves all
records containing values between and including valuel and
value2. For example, the search criterion "#BETWEEN
'01-JAN-93" AND '01-MAR-93"" entered in a date field
retrieves all records with dates between and including
01-JAN-93 and 01-MAR-93.
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The query operator expressions retrieve results according to character
ordering rules for character fields and numeric ordering rules for
numeric fields. For example, suppose you have the following field
values:

002, 003, 004, 005, 078, 123,
253, 441,576, 775, 1274, 3298,
4451, 5600, 9578, 10500, 58437, 70845

These values are shown in the order you expect for numeric values,
where 005 is between 004 and 078. If the field is defined as a numeric
field, then the phrase “4BETWEEN 004 AND 078 would retrieve 004,
005, and 078. However, if the field is a defined as a character field,
then the phrase “#BETWEEN 4 AND 7” would retrieve the values 441,
576, 4451, 5600, and 58437, which all start with characters between 4
and 7. The values 775 and 005 would not appear because 775 is
lexically greater than 7, and 0 is lexically less than 4.

Some fields contain date values that are actually “Date-format”
character values. These fields behave like character fields, such that the
value 01-FEB-92 would be lexically less than 01-JAN-92, because F
precedes ] in a character set.

Sometimes you cannot instantly tell if a field containing numeric values
is defined as a character or numeric field. To identify what the field
type is, you may have to enter and experiment with different search
criteria expressions to see what results get returned.

To use query—-by-example:
1. Choose Enter from the Query menu.

This action switches your window from data entry mode to Enter
Query mode, as indicated by the Enter Query message that appears
in the status line.

2. Enter search criteria in any of the fields, using wildcard characters
and/or query operators as necessary. You can also choose Show
Last Criteria from the Query menu to display the search criteria
used in your last search if there was one.

Attention: In Enter Query mode, all check boxes are in a null
state; that is, they are neither checked nor unchecked, although
they may appear checked or unchecked as a default. If you want
your search criteria to include a checked check box, you have to
explicitly check it, regardless of whether it initially appears to be
checked. Similarly, if you want your search criteria to include an
unchecked check box, you have to explicitly uncheck it, regardless
of what it initially appears as.
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Choose Run from the Query menu to perform the search.

Attention: To retrieve all the database records for a block, you can
bypass 1 and 2 and simply choose Run from the Query menu. This
is referred to as a blind query. You can also retrieve all the records
for a block by choosing Find All from the Query menu.

Choose Cancel from the Query menu if you want to cancel from
Enter Query mode.

p To obtain a query count:

See Also

Reviewing Records

[]

1.
2.

Perform steps 1 and 2 above.

Choose Count Matching Records from the Query menu to display
on the message line the number of records query-by—-example
would retrieve if you ran the search.

Attention: If you simply choose Count Matching Records from
the Query menu without specifying any search criteria in a block,
query count displays the total number of records in the database
for that block.

Using Query Find: page 3 -20

After you perform a search, Oracle Applications retrieves any records
that match your search criteria. The status line shows a count of the
number of retrieved records currently displayed in the block and may
also display a down arrow (V) if there are more retrieved records not
yet shown. Once you display a next record, an up arrow (") appears
on the status line to indicate that there is now a previous record you
can redisplay.

To review retrieved records in a single-row block:

1.

If a down arrow (v) appears on the status line, press the [Down
arrow] key or choose Get More Records from the Query menu or
choose Next Record from the Go menu to display the next
retrieved record.
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Each time you display another retrieved record, the count
increases. After you display the last retrieved record, an asterisk
(*) appears before the count to indicate there are no more retrieved
records to display.

2. Press the [Up arrow] key or choose Previous Record from the Go
menu to see a previous record.

p» Toreview retrieved records in a multi-record block:

1. Ifadown arrow (v) appears on the status line, choose Get More
Records from the Query menu to display the next set of records
that can fit in the multi-record block.

2. Use the [Down arrow] and [Up Arrow] keys or choose Next
Record or Previous Record from the Go menu to move the cursor
down or up one record at a time, or Last Record or First Record to
move the cursor to either the first or last record in the block.

3. Alternatively, you can use the scroll bar to view additional records
currently not visible on the screen.

Each time you display another retrieved record, the count
increases. After you display the last retrieved record, an asterisk
(*) appears before the count to indicate there are no more retrieved
records to display.

Using a Direct Entry Window to Retrieve a Record

3-26

Some Oracle Applications products use special windows called direct
entry windows to help you retrieve records of interest. A direct entry
window consists of a master block and a detail block with a Find
button on the master block.

To retrieve records in a direct entry window:

1. Enter values in the fields of the master block by using the list of
values associated with each field.

2. Choose the Find button in that window to retrieve all the detail
records that correspond to the values you enter in the master block.
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Selecting Multiple Rec

ords

Some Oracle Applications enable you to take an action on several
records at once. These records are presented in a multi-record block
where you must specify which records will be affected. When a record
is selected, the background color changes to pale blue. In addition, the
number of records selected is indicated in the action buttons which act
on all selected rows, i.e. (Add 3) indicating that three records will be
added to the new group. Buttons which act only on the current row do
not display the number of records. For example, the Open button the
which only opens the current record regardless of your selections does
not include this number.

Note: If no records are selected using the following methods
the current record is used as the selected record. Once another
record is explicitly selected the current record is not considered
selected unless it too is selected using one of the following
methods.

To select multiple records:

1. While holding down the Ctrl key, click on each desired record.

To select a range of records:

1. Click on the first record of the desired range.

2. Hold the Shift key down and click on the last record of the desired
range with your mouse to highlight the selected range.

To select all records:

1. Choose Select All from the Edit menu.

To deselect all records:

1. Choose Deselect All from the Edit menu.

To deselect a single record:

1.  While holding down the Ctrl key, click on each record you wish to
omit.
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CHAPTER

4 Customizing the
Presentation of Data

T his chapter discusses how you can customize the layout of your
data in a folder block.
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Customizing the Presentation of Data in a Folder

A folder block is a special block whose field and record layout you can
customize. The following helps you distinguish a folder block from a
regular block:

= * An Open Folder button appears in the upper left corner of a
folder block.
= * An enabled Folder Tools button appears on the toolbar when

your cursor is in a folder block.

* An enabled Folder menu appears in the main menu bar when
your cursor is in a folder block.

You can customize a folder block to retrieve just a subset of records and
display those records in a different layout. You can save your
customizations as a folder which defines the layout of your fields and
the query criteria used to retrieve your subset of records.

When you first install Oracle Applications and navigate to a folder
block, what you see is the original default folder definition or a folder
defined by your system administrator. You can modify this default
folder definition and save your customizations to be the new default.
You can distinguish a custom default folder definition from the original
default folder definition because a custom default folder definition
always displays its name next to the Open Folder button.

Attention: If your system administrator sets the profile option

|:| Flexview: Allow Customization to No, you cannot create or
customize folders. The only item available from the Folder
menu is Open, to open a predefined folder.

This section teaches you how to use folders to present the data you
want and in particular, shows you how to:

* use the folder tools
* query records in a folder block
« customize the layout of a folder block

« manage folder definitions

See Also

Folder Menu: page A-5
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Basic Business Needs

A folder block lets you satisfy the following basic customization needs:
« Display only those fields that are of interest to you.

« Instantly modify the width, sequence, and prompts of the fields
you want to display.

» Display a subset of records based on your specific criteria.
« Display records in a specific order.
« Save your folder customizations for later use.

« Automatically query for a subset of records each time you open a
specific folder.

» Keep your folder customizations private or make them public for
others to access.

« Make your customizations the default layout for a folder block.

Using Folder Tools

= When you navigate to a folder block, the Folder Tools button gets
enabled on the toolbar. Choose this button to display the folder tools

palette on your screen. The folder tools include the following buttons

that replicate the actions of some commonly used Folder menu items:

= * Open Folder—open another folder.

Leh » Save Folder—save the current folder.

Lk + Create New Folder—create a new folder.

3¢ * Delete Folder—delete an existing folder.

L= * Widen Field—increase the width of a field.

HEA + Shrink Field—decrease the width of a field.

B * Show Field—show a currently undisplayed field.
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See Also

Hide Field—hide a currently displayed field.

Move Left—swap the current field with the field to its left in a
multi-record block. In asingle-record block, move the current
field one character width to the left.

Move Right—swap the current field with the field to its right in
a multi-record block. In a single-record block, move the current
field one character width to the right.

Move Up—move the current field up by one character height for
a single-record display.

Move Down—move the current field down by one character
height for a single-record display.

Folder Menu: page A-5

Querying Records in a Folder

4-4

A main advantage of a folder block is that you can customize it to
display only the records you want to see. You can easily alter the query
criteria for a folder and save that criteria with a folder. You can also
control the sorting order of the records you display in a multi-record

folder.

» Todefine query criteria for a folder:

1. Run the query you want, either by using Query Find or
query-by—-example.

2. Choose Save As from the Folder menu if you want to save this
query criteria in a folder.

3. Enter a name for the folder.

4. Select Always, Never, or Ask Each Time from the Autoquery
Option Group. If you select:

Always The query will be automatically performed each

Never
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time you open the folder.

The query will be saved with the folder, but will
not automatically run when you open the folder.



Ask Each Time You will be prompted when you open the folder to

decide if you would like the query to be performed
immediately.

Choose OK when you are done.

Attention: When you save a folder, the query criteria gets “locked
in” to the folder. When you perform another query on that same
folder, your new query will only be performed on the subset of
records retrieved by the folder. If you want to perform a new
query-by—-example on the complete set of records, you need to first
reset the query for the folder definition before performing another

query.

To view the query criteria for a folder:

Choose View Query from the Folder menu.

A window titled Folder Contents appears. The window may
contain a SQL WHERE clause that defines the criteria used to
retrieve the subset of records displayed in the current folder. An
empty window indicates that there is no special query criteria and
that the current folder retrieves all records for the folder entity.

To reset the query criteria for a folder:

1.

Choose Reset Query from the Folder menu.

This clears the WHERE clause from the current folder, but retains
the current folder name and its field layout.

Perform another query and choose Save from the Folder menu to
save the new query to your current folder.

To alter the sorting order of data in a multi-record folder:

1.

Choose Show Order By from the Folder menu.

This menu item acts as a toggle switch to display the Order By
buttons for the first three fields that can be "ordered by’ of a
multi-record folder block. The Order By buttons appear beneath
the first three fields in the block.
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Figure4-1 2 invoices (US HE [West): USD) M= B
Batch Contral Total

Actual Total
=] r
Type Supplier Supplier Num  Site Invoice Date Invoice Mum  Invoice Curr Invoice Amor
L{.‘ UsSD
I I 2+
A t Paid
Haolds DistributionTotal 0.00
usp 0.00
Status  Never Approved Posted No
Desc
Actions... 1 Holds | Payments | Match |
Scheduled Payments | Overview | Distributions |

2. Select an Order By button to switch it to any one of three settings:

il * Ascending—sorts the column in ascending order
lis « Descending—sorts the column in descending order
il » Unsorted—does not sort the column

These settings determine how the folder sorts the records it
displays. The folder applies these settings from left to right when it
retrieves and sorts the records.

3. Choose Run from the Query menu to rerun the query in your
folder to apply any changes of ordering to the records.

» Example

m  Suppose you want to create a folder definition called Unposted
Batches in the Enter Journals folder block of your Oracle General
Ledger application, as shown in Figure 4 — 2. You want this folder
definition to automatically display unposted batch records. First
choose Show Field... from the Folder menu to show the Batch
Status field, if it is not already displayed. Next, choose Enter from
the Query menu to perform a query-by—example. Enter the value
Unposted in the Batch Status field, then choose Run from the
Query menu to retrieve all unposted batch records.
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Flgure 4-2 EgiEnlel Journals [ (O] x]
Q Unposted Batches
Batch Status  Batch MName Journal Mame  Period Journal Debits Journal Credits
Hl@ [AR 1002094 Receivables 13[Sales Invaic{[GEN 96 2,260 2,260
[ ] Unposted AR 1002094 Receivables 13 |Adjustment [||GEN-96 45 45
Unposted AR 1002094 Receivables 13(Trade Receif |GEN96 4,430 4,430
Unposted Payables 1797 Purchase Ind|FEB96 324,870 324,870
Unposted Payables 1797 Payments |T||FEB-96 872,000 872,000
. ]
New Journal | Review Journal | Requery |
New Batch | Review Batch | More Actions |

Choose Save or Save As... from the Folder menu to save this query
criteria and layout. Enter a unique name to identify the folder. Make
sure to set the Auto Query option group to the desired behavior. You
can also choose View Query... from the Folder menu at any time to
display the WHERE clause for this query in the Folder Contents

window.

See Also
Folder Menu: page A-5

L]
Customizing the Layout of a Folder

The Folder menu and folder tools provide you with many options to
help you customize your folder layout.

Note: Some Folder menu items are not available when you are
in Enter Query mode.

p Toshow a hidden field:

= 1. Choose Show Field... from the Folder menu to display a list of
currently undisplayed fields.
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2. Select a value from the list and choose OK to display the field in
the folder layout.

The new field is inserted after the current field, and the cursor
moves to the new field.

To hide a field:

m  Choose Hide Field from the Folder menu to remove the current
field from the folder layout.

Your cursor moves to the field sequenced after the field that was
removed.

To move a field to the right:

m  Choose Move Right from the Folder menu.

In a multi-record block, this swaps the position of the current field
with the field to its right. In a single-record block, this moves the
current field one character—width to the right.

To move a field to the left:

m  Choose Move Left from the Folder menu.

In a multi-record block, this swaps the position of the current field
with the field to its left. In a single-record block, this moves the
current field one character-width to the left.

To move a field up in a single-record block:

m  Choose Move Up from the Folder menu.

This moves the current field one character-height up.

To move a field down in a single-record block:
m  Choose Move Down from the Folder menu.

This moves the current field one character—height down.

To widen a field:

m  Choose Widen Field from the Folder menu.

This increases the width of the current field by a 0.2 inch increment,
up to a maximum width of 20 inches.
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» Toshrink the width of a field:

MEA m  Choose Shrink Field from the Folder menu.

This decreases the width of the current field down to a minimum
width of 0.2 inches.

p To autosize all the fields of a folder:
m  Choose Autosize All from the Folder menu.

Resizes displayed fields based on a sample of values for the field in
the block, ensuring that no field is smaller than the width of it’s
prompt. The number of records (sample of values) is determined
by selecting one of three options: 10, 50, or 100 in the decision
window.

p Torename a field prompt:
1. Choose Change Prompt from the Folder menu.

2. Enter a new prompt name in the Alter Prompt window that
appears.

If you precede a prompt name with a hyphen, ‘~’, and you choose
to show the field in the folder, the field appears without a prompt.

3. Choose Default if you wish to recover the original prompt name
for the field.

4. Choose OK when you are done.

Attention: Shorten or abbreviate a prompt name rather than

|:| change it altogether. This ensures consistency with the similar
prompt names that appear in the non-folder windows of your
application.

See Also

Folder Menu: page A-5
Using the Folder Tool Palette: page 4 - 3

Managing Folder Definitions

Once you learn to customize a folder block’s layout and query criteria,
you need to learn to save your customizations as a folder. You can
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create and save new folders, or open and delete existing folders. When
you open a new folder, the layout for the new folder simply replaces
the layout for the current folder.

p To create a new folder:

L 1. Choose New from the Folder menu.

The Create New Folder window appears.

Figure4-3

E%%Ereate Hew Folder Ed
Folder | |
Autogquery
" Always [ Open as Default
" Never [ Public

& Ask each time

Cancel 0K

2. Enter a new folder name.

The name must be unique for the Oracle Applications sign—on you
use and for the entity that the folder represents. For example, if

your folder queries employees working in the sales department of
Chicago, you could title your folder similar to 'Salereps — Chicago’

3. Check an Autoquery option:

« Always - automatically queries for a subset of records each time
you open the folder definition

» Never - does not query

» Ask each time — opens the decision box when the folder is
opened. Choose Yes to query.
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Figure4-4

L) | - -
=3 Decizion E4

Find all records in this folder?

4. Check Open as Default if you want this specific folder definition to
open as your default each time you navigate to this folder for the
first time after invoking the form.

5. Check Public if you want other Oracle Applications users to have
access to this folder definition. They can even use it as their default
folder, but only you can modify it.

6. Choose OK when you are done.

The name that you assign to this folder appears in the upper left
corner of the folder block next to the Open Folder button,
whenever you open this folder. The original default folder
definition provided with the product does not have a folder title
unless you save it with a new name.

To recover the original default folder definition for a folder block:

Once you create a custom folder definition and make it the default, you
can recover the original default folder definition shipped with the
product by performing these steps.

1. Select Save As from the Folder menu when you are in the custom
default folder.

2. Uncheck Open as Default in the Save As window that appears.
3. Choose OK when you are done.

4. To display the original default folder definition, close and reopen
the form.

Attention: If you like this original default folder, you should give
it a name and save it without making any changes before you
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create any new folders. This way, you can open the original folder
by choosing it from a list of predefined folders.

» Toopen another folder:

= 1.

Choose Open from the Folder menu to load a predefined folder.
You can also press the Open Folder button located in the upper left
corner of the folder block.

Select a private or public folder from the list window that appears
and choose OK to replace the current folder with the new folder.

» To save changes to a folder:

Lk 1.

Choose Save from the Folder menu to save any layout or query
changes made to the current folder or choose Save As from the
Folder menu to save the current folder under a new name. If there
are any pending changes to the data in the form you will be
prompted to save the changes or cancel the save.

If you choose Save As, complete the information requested in the
Save Folder window that appears and choose OK.

This window prompts you for the same information as the Create
New Folder window.

Attention: If you save a folder to “Open as Default”, then open
another folder and save that second folder also as “Open as
Default”, the second folder becomes the new default.

Attention: If you modify a public folder in any way, saving it
makes it a private folder. However, if you open and save a public
folder to “Open as Default” with no other changes, you merely
save a reference of that folder as a private default.

» To delete an existing folder:

Y 1.
2,
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Choose Delete from the Folder menu.

Select a folder from the list that appears and choose OK to delete
the folder. You can only delete folders you have created. If there
are any pending changes to the information in the folder you will
be prompted to save the changes or cancel the delete.

If another user is referencing that folder definition as their ”Open
as Default” folder, that reference gets deleted as well.



See Also

Folder Menu: page A-5
Using the Folder Tool Palette: page 4 - 3
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Using Flexfields

CHAPTER

T his chapter provides you with a conceptual overview of flexfields
as well as how to use flexfields. You learn about:

e The features of flexfields
« The differences between a key and a descriptive flexfield
« How to enter data into flexfields

* How to query data using flexfields
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Overview of Flexfields

Basic Business Needs

A flexfield is a flexible data field that your organization can customize
to your business needs without programming. Oracle Applications
uses two types of flexfields, key flexfields and descriptive flexfields. A key
flexfield is a field you can customize to enter multi-segment values
such as part numbers, account numbers, and so on. A descriptive
flexfield is a field you customize to enter additional information for
which your Oracle Applications product has not already provided a
field.

Oracle Applications flexfields let you satisfy the following business
needs:

* Have “intelligent fields”—fields comprised of one or more
segments, where each segment has both a value and a meaning.

* Rely upon your application to validate the values or the
combination of values that you enter in intelligent fields.

» Have the structure of an intelligent field change depending on
data in your application.

» Capture additional information if you so choose.

» Customize data fields to your meet your business needs without
programming.

* Query intelligent fields for very specific information.

Definitions

5-2

Key Flexfields

A key flexfield is a field made up of segments, where each segment has
both a value and a meaning. You can think of a key flexfield as an
“intelligent” field that your business can use to store information
represented as “codes.”

Most organizations use “codes” to identify general ledger accounts,
part numbers, and other business entities. Each segment in the code
represents a characteristic of the entity. For example, your organization
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Figure5-1

may use the part number code “PAD-NR-YEL-8 1/2x14” to represent
a notepad that is narrow-ruled, yellow, and 8 1/2” by 14”. But another
organization may identify the same notepad with the part number code
“PD-8x14-Y-NR”. Although both codes represent the same part, they
each have a different segment structure that is meaningful only to the
organization using that code.

A key flexfield is flexible enough to let you use any code scheme you
want to describe an entity. When your organization initially installs an
Oracle Applications product, your organization’s implementation team
customizes all the key flexfields in that product to use meaningful code
segments to describe each key flexfield entity. Your organization
decides for each key flexfield, how many segments an entity has, what
each segment means, what values each segment can have, and what
each segment value means. Your organization can also define rules
that govern what combination of segment values are valid
(cross—validation rules), or define dependencies among the segments.
The result is that your organization can use the codes it needs rather
than change its codes to meet someone else’s requirements.

The Accounting Flexfield in your Oracle Assets application is an
example of a key flexfield that identifies a unique chart of accounts.
One organization may choose to customize the Accounting Flexfield to
have three segments called Company, Department, and Account, while
another organization may choose to customize the flexfield to have six
segments called Company, Cost Center, Account, Product, Product
Line, and Subaccount, as shown in Figure 5 -1 in the Account column.

& Distributions (US HQ (West): USD) - EDIO3-Aug-121, Alpha Trading

Invoice Tatal <§00.00>
Distribution Total <§00.00>
=] ~
Mum  Type Amount Tax Name GL Date Account
L{Iﬂ Item <800.00>||zero tax 04-JAN-2000 01.120.540.0000.000.0000
A 2
Account Description US-.Materials Manag.Accounts Payahle.Unspecified.Unspecified. Unspecified
Status  Approved PO Mumber 120114
Posted Partial
View PO Calculate Tax
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Figure5-2

A key flexfield looks like any other field in a block. You can simply
type into a key flexfield, the segment values you want and separate
each segment with a character called a segment separator. In

Figure 5 - 1, the designated segment separator for the Accounting
Flexfield is a period “.”. Alternatively, as shown in Figure 5 -2, you
can open a flexfield window for a key flexfield to display a separate
field for each of its segments.

Cormpany US- Global Computers
CC I'H'Iaterials Management
Account ﬂccuunu; Payable
Praduct Unspeciﬁed
Product Line Unspeciﬁed

Sub-Account {0000 Unspecified
| | 2+

oK

Combination of Segment Values

A combination of segment values, also known as a key flexfield code
combination, uniquely describes a business entity stored in a key
flexfield. When you change the value of one or more segments in a key
flexfield, you change the combination of segment values.

Descriptive Flexfields

A descriptive flexfield gives you room to expand your forms, since
Oracle Applications cannot predict all the possible information you
may want to track. Your organization can use descriptive flexfields to
capture additional information that is important and unique to your
business.

A descriptive flexfield appears in a block as a two character, unnamed
field enclosed in brackets, as shown in Figure 5 - 3. A descriptive
flexfield window appears when you move your cursor into a
customized descriptive flexfield, as shown in Figure 5 - 4. Your
organization’s implementation team can customize a descriptive
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Figure5-3

flexfield to include as many additional fields as your organization
needs. These fields, also called segments, appear in the descriptive
flexfield window.

Note: We refer to the fields that appear in a customized
descriptive flexfield as segments even though they differ from
the segments that make up a single value in a key flexfield.

Each segment in a descriptive flexfield window has a name, and can
have a set of valid values. Your organization can define dependencies
among the segments or customize a descriptive flexfield to display
context-sensitive segments, so that different segments appear
depending on the values you enter in other fields or segments.

In Figure 5 — 3, your organization might customize the descriptive
flexfield to display fields that store more information about the asset
category.

EgaAsset Details [_[O] =]

Asset Number |[IIIEN Description [rel11 test |

Tag Mumber |PR1101 Category |VEHICLE.OWNLUXURY [B]
Serial Number Agset Key |-

Assat Type |Capitalized - Units |1
Farent Asset l:l Description
Manufacturer Wodel I:l
Warranty Mumber
Lease Number Description | ‘ [|:|]
Lessar ¥ In Use
I+ In Physical Inventory
Property Type |PERSONAL Ownership [Owned -
Property Class [1248 Bought [New -
Cancel Done
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Figure5-4 E\i’zf’,ghsset Category

2|

License Mumber |:|

License Renewal Date | |

Insurance Company |

Insurance Policy Murmber | |

Palicy Renewal Date | |

Clear | Cancel‘ OK ‘

Range Flexfield

A range flexfield is a variation of a key flexfield that allows you to input
a low and a high combination of segment values so that you can
express a range of key flexfield combinations.

Structure

A structure is a specific configuration of flexfield segments. If your
organization’s implementation team adds or removes segments, or
rearranges the order of segments in a flexfield, you get a different
structure.

Major Features

Flexfield Window

Both key and descriptive flexfields display flexfield windows. A
flexfield window displays the segments of a flexfield as individual
fields with field prompts.

ul |z Choose List of Values... or Edit Field... from the Edit menu to display
key flexfield windows.

Note: Single segment key flexfields and range flexfields
display all of their segments in fields on the form and are
therefore not displayed in a flexfield window.
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For a descriptive flexfield, you can define whether you want the
flexfield window to automatically appear when you navigate to a
customized descriptive flexfield. If you set a user profile option called
Flexfields: Open Descr Window to No, the window does not open unless
you choose Edit Field... from the Edit menu. If you set the user profile
option to Yes, a flexfield window automatically opens when you
navigate into a customized descriptive flexfield except in a folder.

The menus on the main menu bar change when you open a flexfield
window. We refer to the updated menu bar as the flexfield window
menu bar, which contains the following menus:

» Edit—Use the Edit menu to edit the data in the flexfield window.
You can clear the data from a segment field, display a list of
values for a segment field (if it contains a list), invoke the field
editor for a segment, or clear all data from the block.

» Go—Use the Go menu to navigate to the next or previous
segment field.

« Special—Use the Special menu to display the default value for a
segment field (if it has a default) or to display default values for
all the segments in the flexfield window that have defaults.

¢ Window—The Window menu lets you select different ways to
arrange your currently open windows.

Automatic Segment Validation

Some flexfields can validate the segment values that you enter against a
list of valid values. If you enter an invalid segment value, a list
window appears so that you can choose a valid value from the list.

Automatic Segment Cross—Validation

A key flexfield can perform automatic cross—validation of segment
values according to rules your organization defines when it customizes
that key flexfield. A cross—validation rule defines whether a value of a
particular segment can be combined with specific values of other
segments. When you finish entering segment values in your key
flexfield window, your application checks to see if it is a valid
combination of values before it updates the database. If you enter an
invalid combination, a modal window appears with a message telling
you to choose a combination that is already defined.
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Dynamic Insertion

Dynamic insertion allows you to create a combination of segment
values for a key flexfield without using a combinations form. During
the implementation of a key flexfield, your organization can either
explicitly define a list of valid code combinations for the key flexfield
using a combinations form, or allow you to create valid combinations
as you enter values in the key flexfield for the first time on a form other
than the combinations form. Your organization can also specify
cross—validation rules for a key flexfield so that you can only define
specific code combinations during dynamic insertion.

Multiple Flexfield Structures

In some applications, different users may need a different arrangement
of flexfield (key or descriptive) segments. Or, you might want different
segments to appear in a flexfield depending upon, for example, the
value of another field.

Depending on the flexfield, your organization can define multiple
segment structures for the same flexfield. The flexfield can display
different prompts and fields for different users based on a data
condition in a form or application database.

Your Oracle General Ledger application, for example, can provide
different Accounting Flexfield structures for users of different sets of
books. The Oracle General Ledger application determines which
flexfield structure to use based on the value of a profile option called
GL Set of Books Name.

Shorthand Flexfield Entry

Shorthand flexfield entry lets you enter key flexfield data quickly using
alias names that represent valid flexfield combinations or patterns of
valid segment values. Your organization can specify which key
flexfields use shorthand flexfield entry, and define shorthand aliases for
those key flexfields to represent complete or partial sets of key flexfield
segment values. Once your organization customizes a key flexfield to
use shorthand flexfield entry, you can set the user profile option
Flexfields:Shorthand Entry to take advantage of this feature.

Flexfield Value Security

Flexfield value security allows your organization to restrict the set of
key flexfield segment values you have access to during data entry. The

Applications User’s Guide



See Also

security is based on a your responsibility and the access rules your
organization defines.

Entering Data in a Range Flexfield: page 5 - 20
Setting Your Personal User Profile: page 9-5
Cross—Validation Rules: Oracle Applications Flexfields Guide

Overview of Shorthand Flexfield Entry: Oracle Applications Flexfields
Guide

Defining Shorthand Aliases: Oracle Applications Flexfields Guide

Overview of Flexfield Value Security: Oracle Applications Flexfields Guide
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Entering Data into Flexfields

Oracle Applications provides many aids to help you enter data into
descriptive and key flexfields. This section describes how to enter data
ina:

« descriptive flexfield window

» key flexfield

» key flexfield window

 key flexfield using a shorthand alias

« range flexfield

Entering Data in a Descriptive Flexfield Window

You enter data into a customized descriptive flexfield by using its
flexfield window. Figure 5 -5 displays a customized descriptive
flexfield window. .Your organization can customize a descriptive
flexfield to display default values in any of the segments.

Figure5-5 E‘E’iﬁusset Category
3

License Mumber |:|

License Renewal Date | |

Insurance Campany |

Insurance Palicy Mumber | |

Palicy Renewal Date | |

Clear | Cancel‘ OK ‘

» Toenter data in a descriptive flexfield:

1. Move your cursor into a customized descriptive flexfield to display
the flexfield window. If your profile option Flexfield:Open Descr
Window is set to No or if you are in a folder, choose Edit Field...
from the Edit menu to open the flexfield window.

5-10 Applications User’s Guide




When the window appears, the cursor moves to the first segment
that does not contain a default value.

2. Enter avalue in each segment.

Depending on how your organization customizes a descriptive
flexfield, you can either type a value into a segment, or if the <List>
lamp appears on the status line for a particular segment, you can
display a list of values to choose from for that segment. See: Using
a List of Values: page 3-9.

3. If you wish to edit a default value, simply move your cursor into
the segment you wish to edit and type over the default value.

4. You can save yourself keystrokes when you enter segment values
by automatically skipping to the next segment as soon as you enter
a complete valid value into a current segment. Simply set the
profile option Flexfields:AutoSKip to Yes. Set the profile option to
No if you want to manually navigate to the next segment after
entering a value. See: Setting Your Personal User Profile: page 9 -5

5. Choose OK when you are done to close the flexfield window.

The segment value(s) you enter are concatenated in the two
character descriptive flexfield display. The concatenated segment
values in the descriptive flexfield are separated by a special
character called a segment separator that is specified in the
descriptive flexfield definition.

Note: If you display a customized descriptive flexfield in a
folder definition, you are able to move the cursor into the
flexfield so you can use folder functions. You cannot, however,
update or insert values directly into the descriptive flexfield;
you must use the descriptive flexfield window.

See Also

Customizing the Presentation of Data in a Folder: page 4 — 2

Entering Data Directly in a Key Flexfield

p To enter a known combination into a key flexfield:

1. Move your cursor into the key flexfield.
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2.

If you know the exact combination of segment values you want,
enter the concatenated combination directly into the key flexfield as
shown in Figure 5 - 1.

» Todisplay a list of existing combinations:

1.
2.

123
= 3

Move your cursor into the key flexfield.

Choose List of Values... from the Edit menu to open the Flexfield
window.

Choose the Existing Combinations icon in the flexfield window to
display the existing combinations.

If there are several combinations you may be asked to enter values
for the segments to shorten the list. To see all combinations enter
"%’ in one of the segment fields and choose OK.

» Todisplay areduced list of existing combinations:

1.
2.

[]
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Move your cursor into the key flexfield.

Enter segment values directly into the key flexfield. To specify
search criteria for a segment or part of a segment, use wildcards or
query operators.

You can use wildcard characters or query operators to enter inexact
concatenated combinations, also known as search phrases, directly
into a key flexfield. See: Using Query Operators: page 3 — 23.

Attention: When you enter a search phrase for a segment directly
into a key flexfield, the search phrase length should not exceed the
actual segment length. For example, if a segment is two characters
long, you should only enter a two character search phrase. You can
only use the query operators <, >, and =. You cannot use <=, >=,
<>, I=, or #BETWEEN in this case because these operators are
already two or more characters long, and are meaningless as search
phrases when used alone.

Note, however, that if you enter a search phrase in a key flexfield
window, you do not have to limit the length of the search phrase to
the segment length.

Also note that if the segments are character fields rather than
numeric, the search may not bring up the expected values. See:
Using Query Operators: page 3 — 23.

Attention: Make sure you use the correct designated character for
the segment separator in your concatenated combination. If your

key flexfield uses “.” instead of “~” to separate segments, you



would enter a concatenated combination such as
01.130.410.12%.000.000 instead of 01-130-410-12%-000-000. If you
enter the wrong character for the segment separator, the flexfield
interprets that character literally rather than as a segment
separator, and therefore assumes the combination you enter is just
the first segment.

Similarly, if you enter a partial phrase directly into a key flexfield,
and that phrase pertains only to the third segment, make sure you
include the appropriate wildcards and segment separator in the
phrase. For example if you want to specify a partial phrase where
the third segment is 410 and all other segments are unknown, you
enter %.%.410, assuming the key flexfield uses a period (.) as a
segment separator. Notice that even if the flexfield has more than
three segments, the remaining segments are assumed to have %
when the combinations list appears.

3. Press [Tab] to bring up a reduced list of values matching your
specified search criteria.

Note: If you enter an invalid value for one or more segments, the
Reduction Criteria for Long List window is displayed with your
search criteria filled in. The first invalid value is highlighted
allowing you to enter a different value or use LOV for a list of valid
values. Once a valid value is entered the next invalid value is
highlighted, and so on until all values are valid.

If you enter a valid search phrase but which matches no values, the
Reduction Criteria for Long List window is displayed with your
search criteria filled in. You can then edit the search criteria
directly in the flexfield Reduction Criteria window. See: Data
Entry in a Key Flexfield Window: page 5 - 14.

If you enter a partial valid combination without wildcard
characters directly in a multi-segment key flexfield, the Flexfield
Edit window appears with your partial combination filled in. You
can then use this window to fill in the rest of the segments. See:
Data Entry in a Key Flexfield Window: page 5 — 14.

In a single segment key flexfield, you cannot enter partial values
without wildcard or query operators. If you enter an incomplete
value, a message will appear telling you to enter a value that is
defined.

Single Segment Key Flexfields and Longlist

Single segment key flexfields behavior changes from the multi-segment
case if the flexfield definition for the single segment key flexfield has
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the Longlist argument. The Longlist argument for a flexfield definition
can indicate that the flexfield does not have a very large number of
valid values. If so, and the flexfield does not allow dynamic insert then
when you choose List of Values a window with a list of valid values
appears like in non—flexfield fields (you do not have to go through the
key flexfield Reduction Criteria window). You can then choose a valid
value from the list and the value appears in the flexfield. See: Longlist:
page 3 - 12.

Data Entry in a Key Flexfield Window

If you are not familiar with a key flexfield or you are not sure of the
combination of values to enter directly into a key flexfield, you can
display a key flexfield window to assist you with your data entry.

4 » Edit window—choose Edit Field... or for multi-segment

flexfields choose List of Values... from the Edit menu to display

i a key flexfield Edit window that lets you enter or edit a
combination of segment values.

Using a Key Flexfield Edit Window

When you choose Edit Field... from the Edit menu, a key flexfield Edit
window appears, as shown in Figure 5 - 6.

Figure5-6

Company US- Global Computers
cc I'I.I'Iaterials Management
Account Accnunts Payahle
Praduct Unspeciﬁed
Product Line Unspeciﬁed

Sub-Account {0000 Unspecified
dl | 2

ox]
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When you display a key flexfield Edit window, the name of the key
flexfield structure appears in the window title and you may see default
values in some of the segment fields. Three icon buttons called List of
Values, Existing Combinations, and Help also appear in the window.

In a key flexfield Edit window, you can manually type values into each
segment field, or display a list of values for the current segment if a
<List> lamp appears in the status line for that segment.

You can also save yourself keystrokes when you enter segment values
by having the flexfield automatically skip to the next segment as soon
as you enter a complete valid value in a current segment. Simply set
the profile option Flexfields:AutoSKip to Yes. Set the profile option to
No if you want to manually navigate to the next segment after entering
avalue. See: Setting Your Personal User Profile: page 9 - 5.

If the combination of segment values that you want to enter is an
existing combination, but you are not sure of its exact value, you can
choose Existing Combinations from the Special menu to search for that
combination among the list of existing combinations. See: Using a Key
Flexfield Reduction Criteria Window: page 5 — 15.

When you are done with the key flexfield Edit window and choose OK,
the Edit window closes and displays the concatenated combination of
segment values in the key flexfield.

|:| Attention: If you navigate to a key flexfield that cannot be
updated the Existing Combinations icon does not appear and
the List of Values function is not available when you display
the key flexfield Edit window. This is to reinforce that you
cannot change the value in the key flexfield.

Using a Key Flexfield Reduction Criteria Window

When you choose Existing Combinations from the Special menu, the
following occurs depending on the underlying segment structure of the
key flexfield:

« If the key flexfield is a multi-segment flexfield, or a
single-segment flexfield that uses the longlist feature, a key
flexfield Reduction Criteria window appears.

« If the key flexfield has only one valid value, that value
automatically appears in the key flexfield.

A key flexfield Reduction Criteria window lets you query for an
existing combination of segment values to help you complete your data
entry in a key flexfield. This window is useful when you know that the
combination you want to enter is a valid existing combination, but you
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Figure5-7

are not sure of its exact value. Use this window to enter criteria that
helps locate the combination of segment values that is of interest to
you.

Fraoduct I:I
Product Line Unspeciﬁed

Sub-Accoumnt I:I
4 | *

Cancel 0K

If you know the value for a particular segment, you can enter that
value manually or you can select that value from the segment’s list of
values. If you are not sure of a segment’s value, you can either leave it
blank or you can enter a search phrase using wild card characters or
query operators. See: Using Query Operators: page 3 — 23.

For example, suppose the combination of segment values you want
must satisfy the following criteria:

» Segment 1—is greater than 2
» Segment 2—is less than 0020
» Segment 3 and 4—unknown

You could specify this criteria in the key flexfield Reduction Criteria
window as shown in Figure 5 — 8.
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Figure5-8

This is a long list. Please enter partial segment values to shorten list

Company
G
Account I:I
Product I:I
Froduct Line Unspeciﬂed

Sub-Account |:|
/] | i

Cancel 0K

When you choose OK, the flexfield searches through all the existing
combinations of segment values for combinations that match and
displays the matches in a list, as shown in Figure 5 - 9.
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Figure5-9

Using Shorthand Aliases in a Key Flexfield

E%At:c:uunting- STD
Find|% |
(1] [ Acct Pri PrdLine | Sub-Account =
oon oon non 0ooo
22 oo 1430 Qoo oo M TLY
22 oo 1431 Qoo oo O HY
22 oo 2540 Qoo oo oooo
71 oo 1220 oo ooo oooo
71 ooo 2540 nao noo oooo
71 ooo APLI nao noo oooo
71 ooo APLI nao noo ACCR
71 ooo IMNTR nao noo oooo
71 ooo IORE nao noo oooo
71 ooo [P nao noo oooo
71 ooo mMACH aoo ooo ABSO
T4 oo 1220 Qoo oo oooo
T4 oo 2540 Qoo oo oooo
T4 oo ARPLI Qoo oo oooo
T4 ooo APLI nao noo ACCR
T4 ooo COGES nao noo oooo -
1] IrH
Find | 0] | Cancel|

After you select a valid combination from the list and choose OK, the
list window closes and the segment values appear in the window from
which you invoked your key flexfield Edit window.

If your organization enables shorthand data entry for a key flexfield
and you set the user profile option Flexfield:Shorthand Entry to Yes, a
shorthand alias window appears for a key flexfield when you choose
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Figure5-10

Edit Field... from the Edit menu. You can do one of the following in
that window:

* Enter an alias
» Display a list of valid aliases

* Cancel the shorthand alias window

E‘%Accounling- 5TD

Short Hand |

Clear Cancel Ok

Entering an Alias

If you enter an alias to represent a complete key flexfield combination,
your application automatically closes the shorthand alias window and
displays the equivalent concatenated segment values in the flexfield
display. See: Shorthand Flexfield Entry: page 5 - 8.

If you want to force the key flexfield window to appear after the
shorthand alias window closes, you can set your user profile option
Flexfield:Show Full Value to Yes. When you activate this user profile
option, the key flexfield Edit window automatically appears after you
enter a valid shorthand alias. The default for this option is No. See:
Setting Your Personal User Profile: page 9 — 5.

If you enter an alias that represents a partial key flexfield value, your
application displays the key flexfield Edit window and inserts the
partial values into the appropriate segment fields, positioning the
cursor on the first segment field that does not have a value.

If you enter an invalid alias, your application displays a list of valid
aliases for you to select from.

Choosing a Valid Alias from a List

If you do not know what alias to enter in a shorthand alias window,
you can display a list of valid aliases by choosing the List of Values
button.
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Canceling the Shorthand Alias Window

You may bypass shorthand flexfield data entry by choosing OK or
Cancel in the shorthand alias window without entering a value. The
key flexfield Edit window appears instead, containing separate
prompts and fields for each of the key flexfield segments.

Entering Data in a Range Flexfield

Figure5-11

A range flexfield allows you to input a low and a high combination of
segment values to express a range of key flexfield combinations. Your
Oracle General Ledger application illustrates how you can use a range
flexfield. The Accounting Flexfield Ranges block of the Define Budget
Organization form contains a range flexfield called Accounting
Flexfield, as shown in Figure 5 — 11. This range flexfield is actually
based on the Accounting Flexfield key flexfield.

EgiAccnunl Ranges [_[O] %]
[

A Currency
Line  Low High Type [1

= Entered

4 4 4 4 4 4 4 4

Status

Range Assignments |

This range flexfield requires you to enter a low and a high combination
of segment values to specify the Accounting Flexfield range you want
to include in a budget organization. To enter a value in a range
flexfield, just move your cursor into the first key flexfield of the range
flexfield. In this example, it is the field labeled Low. A range flexfield
window displays, as shown in Figure 5 - 11.
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Figure 5-12

Lo High
Company IE IE
Cost Center (120 200
Account (2300 4I]I]l]|

Clear | Cancel| OK |

Notice that this window displays two columns of fields for each
segment so that you can enter a low and a high value to express a
range. If the segment contains a list, as indicated by the presence of the
<List> lamp on the status line, you can choose the List of Values button
to display a list of valid values.

Once you finish entering your values, choose OK to close the Range

window. The range flexfield automatically inserts the concatenated

low and high combination of segment values that you entered in the
appropriate fields of the range flexfield display.
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Figure 5- 13 EgiAccnunl Ranges [ELOCONS) - Account Range [_[O] %]

A Currency
Line  Low High Type [1
=N 02.120.2300 04.200.4000 ere ~[UsD

Status [Adding

Range Assignments |

|:| Attention: You cannot enter values directly into a range
flexfield like you can in a key flexfield.
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Searching for Data Using Flexfield Criteria

In chapter 3, you learned how to search for records in a window using
a feature called query-by—example. In this section you learn how you
can also enter search criteria in a flexfield when you use
query-by—-example. By entering search criteria in a flexfield, you can
retrieve records of data that satisfy criteria in the individual segments
of your key or descriptive flexfields. For example, suppose you want
to search for all Accounting Flexfield combinations in the Accounting
Flexfields Combinations window that contain the segment value “01”
in the first segment. With query-by—-example, you can enter this
criteria in the Accounting Flexfield to accomplish this task. See:

When you enter search criteria for a flexfield segment, you can use
wildcard characters or any of the query operators as part of the search
phrase. See: Using Query Operators: page 3 — 23.

If your flexfield segment has a list available, you can choose the List
icon within the flexfield window to select a value from the list for your
search criteria. Note that if you enter a value for a segment, your
application automatically enters the default value for any other
segments that depend on the value you enter. If you do not want a
default value as part of your search criteria, you can clear the field, or
you can enter another value in that field.

Entering Search Criteria in a Key Flexfield

Recall that to initiate query—by—example, you choose Enter from the
Query menu to switch to Enter Query mode in the current block. In
addition to entering search criteria in any of the fields of the block, you
can choose Edit Field... or List of Values... (for multi-segment
flexfields) from the Edit menu to bring up a key flexfield window. Use
the key flexfield window to specify search criteria for any of the
segments of the flexfield. When you are done, choose OK to close the
flexfield window and then choose Run from the Query menu to
perform the search.

Note: If you prefer, you can also enter your concatenated
segment search criteria directly into a key flexfield display
when your block is in Enter Query mode. The concatenated
search criteria must include the appropriate segment separator
character. When you are done specifying the search criteria for
the block, choose Run from the Query menu to perform the
search.
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Entering Search Criteria in a Descriptive Flexfield

To enter search criteria in a customized descriptive flexfield when your
current block is in Enter Query mode, simply navigate to the
descriptive flexfield to automatically display the descriptive flexfield
window. When you are done entering search criteria in any or all of the
descriptive flexfield segments, choose OK to close the descriptive
flexfield window and then choose Run from the Query menu to
perform the search.

|:| Attention: If you set the user profile option Flexfields:Open
Descr Window to ‘No’, you must choose Edit Field... from the
Edit menu to open the descriptive flexfield window. See:
Setting Your Personal User Profile: page 9 - 5.
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CHAPTER

Running Oracle
Applications Reports
and Programs

T his chapter gives you an overview of how to run reports and
programs in Oracle Applications. Specifically, you learn about:

« The concurrent processing feature that allows you to run reports
and programs non-interactively

e How to run reports and programs using Standard Request
Submission

* How to define request sets
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Overview of Reports and Programs

Every Oracle Applications product contains reports and programs that
are specific to that product. A report generates a summary or detail
presentation of Oracle Applications information, whereas a program
can perform a function. The reports and programs you have access to
are defined by the responsibility you use.

For example, as an Oracle Receivables user, you may be able to run a
report to create invoices. Or in your Oracle General Ledger
application, your responsibility may allow you to run a program to
post journal entries.

Oracle Applications provides you with two features called concurrent
processing and Standard Request Submission to help you run the reports
and programs that are a part of your responsibility.

Overview of Concurrent Processing

Concurrent processing is a feature that allows you to run a
non-interactive, data—dependent function, such as a report or program,
simultaneously with online operations. With concurrent processing,
you can complete non-interactive tasks without interfering with the
interactive work you perform at your computer.

An example of concurrent processing occurs when you use the Post
Journals window in your Oracle General Ledger application. Once you
specify the journal batches to post and choose the Post button, your
Oracle General Ledger application uses concurrent processing to post
the journal batch entries without further involvement from you.
Meanwhile, your computer is still available for you to continue doing
other work in Oracle Applications.

Oracle Applications runs all of its reports and programs as concurrent
processes.

Overview of Standard Request Submission

6-2

Standard Request Submission is a feature that works with concurrent
processing to provide a common interface for running your Oracle
Applications reports and programs.

Standard Request Submission provides you with a set of windows for
running reports and programs and a set of windows for creating
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See Also

Basic Business Needs

groups of reports and programs to run together. These windows give
you control over the submission and output of your reports and
programs.

[]

Attention: Some Oracle Applications products provide, in
addition to the Standard Request Submission windows,
product-specific windows to submit certain reports and
programs. Such a window automatically runs a report or a
program as a concurrent process when you choose a specific
button or save your work in the form.

The Post Journals window in the Oracle General Ledger
application is an example of a window that submits a
concurrent program to post journal entries when you choose
the Post button. You should refer to the user’s guide for your
Oracle Applications product to learn if your product uses any
product-specific windows to submit reports or programs.

Using Standard Request Submission: page 6 — 9

Submitting a Request: page 6 — 9

Rerun a Prior Request: page 6 — 19

Defining Request Sets: page 6 — 22

Who Can Use a Request Set: page 6 — 33

Submitting a Request Set: page 6 — 20

Concurrent processing helps you satisfy the following business needs.
You can:

Keep working at your computer while running data—dependent
reports and programs.

Fully use the capacity of your hardware by executing many
application tasks at once.

Standard Request Submission lets you satisfy a related set of business
needs. You can:

* Use a standard interface to run your programs and reports.

« Control access to different programs and reports.
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 Pass parameters from your environment to your reports and
programs.

« View report output online.
» Create and run sets of reports and programs.

« Automatically run programs, reports, or request sets at specific
time intervals.

» Specify whether reports and programs in a request set run
sequentially or simultaneously.

» Specify whether to continue with a request set if a report or
program in a sequential set fails.

 Specify alternative requests to run based on the completion
status of previously run requests in a request set.

» View a log file that summarizes the completion information
about all the reports and programs in a request set.

Definitions

6-4

Concurrent Program

A concurrent program is program that does not require continued
interaction on your part to perform a specific task. In Oracle
Applications, for example, a concurrent program may be a program
written to create a report, or to post a batch of general ledger journal
entries.

Concurrent Process

A concurrent process is an instance of a running concurrent program.
Each time a concurrent manager receives a request and runs a
concurrent program, it creates a new concurrent process. A concurrent
process can run simultaneously with other concurrent processes (and
other activities on your computer).

Concurrent Request

A concurrent request is a request that you submit to run a concurrent
program as a concurrent process. You issue a concurrent request when
you submit a report or program to run using Standard Request
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Submission or when you choose an action button in a product-specific
submission window.

Concurrent Manager

A concurrent manager is a component of concurrent processing that
monitors and runs tasks without tying up your computer.

Report

A report is an organized presentation of specific Oracle Applications
information. You can view a report online, or send it to a printer. The
content of a report can range from summary information to a complete
listing of values. Reports run as concurrent programs in Oracle
Applications.

Request Set

A request set is a collection of reports and/or programs that you group
together. You can submit the reports and/or programs in a request set
all at once using a single transaction.

Stage

A stage is a component of a request set used to group requests within
the set. All requests in a stage are run in parallel, while the stages
themselves are run sequentially in the request set.

Parameter

In Standard Request Submission, a parameter is a report variable
whose value you can change each time you run a report. For example,
you might run an audit report that requires you to enter an audit date
each time you run the report. The audit date is a parameter for the
report.

Major Features

Background Processing

You use your Oracle Applications windows to submit all your
concurrent requests. Once your request is submitted, the concurrent
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managers immediately take over, and complete the task with no further
involvement from you.

Concurrent Processing Options

You can control and change certain run options for each of your
concurrent requests. Not only can you control and change the number
of copies to print, what print style to use, and which printer to use, but
you can also choose to hold a request from being run, choose a specific
date or time to start a request, or choose to save the results of your
concurrent request in a standard file format.

Online Request Review

You can review the output and log files from your concurrent requests
online. You can see the results of a concurrent request without the
delay of printing out the entire report or log file.

Automatic Error Notification

Every time you sign on, Oracle Applications informs you if any
concurrent requests completed unsuccessfully since your last session.
If so, you receive a message in a separate window when you first log
in. You can review any failed request’s log file online to help diagnose
the problem.

Scheduling

Using Standard Request Submission, you can define schedules to
automatically resubmit your program, report, or request set. At
submission time, you can specify:

« the starting date and time
« the time of day for resubmission

« the resubmission interval in months, days, hours, or minutes
from either the start or completion of the request

« the date and time to stop repeating the program, report, or
request set

« day or days of the week or month to resubmit

Oracle Applications automatically resubmits the program, report, or
request set until the end date.
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Concurrent Processing Options

All reports and programs in Oracle Applications run as concurrent
processes whether you submit them using the Submit Requests
window, or using a product-specific submission window. Throughout
this guide we refer to submitted reports and programs as concurrent
requests, or simply as requests.

Each concurrent request runs according to a set of concurrent
processing options.

Default Values of Concurrent Processing Options

The default values of the concurrent processing options are determined
by the values of the following user profile options:

» Concurrent:Hold Requests—Specifies whether to hold a request
temporarily

¢ Concurrent:Report Access Level—Specifies who has access to
report and log files

« Concurrent:Report Copies—Specifies the number of copies of a
report to print

e Concurrent:Request Priority—Specifies the priority of a
concurrent request

< Concurrent:Request Start Time—Specifies the start date and
time for a concurrent request

¢ Concurrent:Save Output—Specifies whether to save report
output to a file

e Concurrent:Sequential Requests—Specifies whether to run
your requests sequentially

« Printer—Specifies the printer to print your report output

If you want to change the value of a default, you must change the value
of the corresponding user profile option using the Personal Profile
Values window in your application. Some profile options, such as
Concurrent:Request Priority, can only be changed by your system
administrator. See: Setting Your Personal User Profile: page 9 - 5.

If you submit your report or program using the Submit Requests
window, you can also modify most of these concurrent processing
options for the request at the time you submit your request. If you use
a product-specific window that automatically submits a concurrent
request when you save your work or choose a button, Oracle
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Applications uses the values defined by your user profile options as the
concurrent processing options for your request.

See Also

6-8

Note: You can modify many of your request’s concurrent
processing options up until it starts running, even if you cannot
modify the options at the time you submit the request. The
Requests window lets you monitor and change the options for
your requests. See: Using the Requests windows: page 7 — 2.

Who Can Use a Request Set: page 6 — 33

Submitting a Request Set: page 6 — 20
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Using Standard Request Submission

This section describes step—by-step how to run and monitor Oracle
Applications reports and programs using Standard Request
Submission. If you want to learn more about a particular report or
program, or learn how to submit a report or program using a
product-specific submission window, you should refer to the user’s
guide for your Oracle Applications product.

To use Standard Request Submission, you must first sign on to Oracle
Applications and select a responsibility that allows you to run requests
in your application.

Note: For simplicity, this section uses the term request to refer
either to a program or report.

Submitting a Request

Standard Request Submission gives you control over how you run your
requests and request sets. This section describes how you customize
and submit a request using the Submit Request window.

There are three elements to submitting a request. Selecting the request
or request set to be submitted, defining a submission schedule, and
providing completion options.

« Selecting the request or request set may require you to provide
request parameters and the output language.

» Defining a schedule can be as simple as submitting as soon as
possible or using a more complex schedule that you define when
you first submit your request and may be used for other requests
in the future.

« Completion options allow you to deliver request output to
others and specify which printers and how many copies of the
output you want to produce for each request.

You can submit as many requests as you like from the Submit Request
window. You can even submit a request more than once if you want to
run the same request with different parameter values.

Refer to the user’s guide of your Oracle Applications product to learn
how to access the Submit Request window from your application.

|:| Attention: Some applications provide access to the Submit
Request window from multiple menu choices. However, the
list of requests that you can run and the name of the window
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6-10

itself may vary depending on the navigation path you use to
access the window.

The following flow diagram outlines the steps required to submit a

request.

Submit Request Flow

Choose to submit a
single request or a
set of requests

!

Enter Request
Information

'

May be Required

Choose Submit
Request

'

Record Request ID

Applications User’s Guide

Optional

Enter Parameter
values

Optional

Define a
submission
schedule

Define completion
options




Figure6-1 "
d [2: Submit a New Request

What type of request do you want to run?

& Single Reguest
Thig allows you to submit an individual request.

" Request Set

This allows you to submit a pre-defined set of
requests.

Cancel OK

» Tosubmitarequest:

1. Navigate to the Submit a New Request window.

2. Check the Request option to submit single requests, or choose to
submit a predefined group of requests by checking Request Set.

3. Choose OK.

Figure 6 -2 [E5 Submit Request

-

a2

Run this Request...

Request Mame

Parameters

Language

At these Times...
As Soon As Possible |

Upon Completion...
I~ Save all Output Files:
Motify |
Print To

Copy a Prior Request... Cancel Submit Request |
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Figure 6 -3

6-12

Submitting requests

4.

Use the Copy a Prior Request... button to take advantage of
previously entered request submissions.

Or

Select the Name of the request (report or program) you want to run
from the list of available requests.

Note: Your responsibility’s request group determines which
requests appear in the list.

Defining Parameters

6.

Reguest Set Name

Application Name |

A Parameters window automatically appears if you select a request
that requires parameter values and your profile option Flexfields:
Open Descr Window is set to Yes. The prompts in the Parameters
window are specific to the request you select. Figure 6 — 3 displays
the Parameters window for the Budget — Journals by Flexfield
report in your Oracle General Ledger application.

[Ej Parameters

Repart Marme

Clear Cancel 0K |
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Some requests require you to enter parameter values so that you
can specify the scope of information you want in the request
output. Some requests don’t have parameters at all. Some
parameter fields also have a list of values available to ensure you
choose a valid parameter value while other parameters are optional
and require no value. Choose List of Values from the Edit menu to
display a list of valid values for a parameter.

Note: Default values may be predefined for one or more of the
parameters associated with your request. The default values
are automatically applied to these parameters when the
parameters window is opened. However; if you do not open
the parameters window, default values are only applied to
required parameters.



Figure6-4

7. Once you enter the values in the required parameter fields and
choose OK, the Parameters window closes, and your parameter
values are concatenated and displayed in the Parameters field.

Determining Output Language

8. If your site supports multiple languages, you can select which
language is used for your request output.

Defining a Submission Schedule

The scheduling window provides you with several scheduling options.
You can choose to re-use a schedule you previously defined and saved,
or define a new schedule. You can define your schedule to run a
request as soon as possible, at a specific time, or repeatedly at specific
intervals, on specific days of the week or month.

9. Choose Schedule... to open the Scheduling window.

':i Schedule [ %]

-

Apply a Saved Schedule...

Run the Job...

& As Soon As Possible
¢ Once

¢ Periodically

& On Specific Days
ClAdvanced

[ 'Save this scheduleNoruse agai aten Cancel | 0K

10. Choose a type of schedule from the following:

Apply a Saved Allows you to re-use a previously defined and

Schedule saved schedule. You may modify the saved
schedule for this one submission or save the
modified schedule with a new name for future use.
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Figure 6 -5

Note: If you intend to use the saved schedule as defined, you
can proceed to step 13.

As Soon as Submits your request as soon as possible. If you

Possible choose this schedule type, proceed to step 13.

Once Submits your request once at the time and date you
specify.

Periodically Submits your request repeatedly at the interval you
specify.

On Specific Days Submits your request repeatedly on specific days
of the week or month.

Advanced This option is reserved for future releases.

11. Many schedule types require additional information to complete
the schedule. Use the steps associated with your selected schedule
type:

Egj 5chedule [ <]

£l ?

Apply a Saved Schedule... |

Run the Joh... ——————
& As Soon As Possible Run At
& Once

& Periodically

¢ On Specific Days
CilAdvaticed

7 Sawe this schedula far use again later Cancel | 0K |

Once When you choose Once, a special time field
appears that lets you specify the time of day you
want to submit your request. Use the calendar by
selecting the List of Values icon in the toolbar to
select a date and time to submit your request.
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Figure 6 - 6

& Schedule

-

£y 2

Apply a Saved Schedule... |

Run the Job...

" As Soon As Possible
" Once

& Periodically

¢ On Specific Days

I ET SN S FEB-2000 10:52:02
End At

(Leave End Date blank to run indefinitely)

Re-run every ‘1 ||Da!|'(5) |'|

ClAdvaniced
Apply the Interval...
# From the Start of the prior run
" Frorm the Completion of the prior run
™ Increment date parameters each run
[ Save this schedule for use again later Cancel | 0K |

Periodically

When you choose Periodically, several new fields
appear that let you specify the interval of minutes,
hours, days, or months that you want to wait
before resubmitting a request. You can also specify
whether to count your interval from the requested
start time of the request or from the completion
time of the request.

e Use the List of Values calendar to select start and
end dates to define the period in which you
want to submit your request.

Note: If you do not specify a start time, Oracle Applications
uses the value from your user profile option
Concurrent:Request Start Time or the current time as the

default.

Note: Whether a request completes successfully or in error,
Oracle Applications immediately submits the next run only if
the next requested start date and time is on or before the end
date and time you specify. If you do not specify an end date,
the request or request set repeats indefinitely until you cancel
it. See: Cancelling Requests: page 7 — 15.

¢ Select the interval from the poplist and enter the

number of intervals between each submission of
your request.
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Figure 6 -7

» Choose to count your interval from the
beginning or completion of the prior run.

« |If your request contains date parameters, you
can choose ’Increment date parameters each
run” to have the value for that parameter be
adjusted to match the resubmission interval. For
example, if the value for the parameter is
25-JUL-1997 07:00:00 and your interval is
monthly, the parameter is adjusted to
25-AUG-1997 07:00:00 for the next submission.

[ Schedule E

-

il 2

Apply a Saved Schedule... |

Run the Job...

e 28 -FEB-2000 10:52:02
¢ As Soon As Possible

End At
" Once

Dates of Every Month:

& Periodically
& On Specific Days
O Advanced

1

2

3

4

6

8

9

10

n

12

13

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

M

Last Day

Days of Every Week:
[SIim [T Jw]T]F]s]

[™ Increment date parameters each run

[~ Save this schedule for use again later Cancel | 0K |

On Specific Days When you choose On specific days, new fields and
calendars appear that let you specify which day of
the week and/or month to submit your request.

« Use the List of Values calendar to select start and
end dates to define the period in which you
want to submit your request.

Note: If you do not specify a start time, Oracle Applications
uses the value from your user profile option
Concurrent:Request Start Time or the current time as the
default.
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Figure6-8

Note: Whether a request completes successfully or in error,
Oracle Applications immediately submits the next run only if
the next requested start date and time is on or before the end
date and time you specify. If you do not specify an end date,
the request or request set repeats indefinitely until you cancel
it. See: Cancelling Requests: page 7 — 15.

¢ Use the monthly calendar template to specify
dates during the month to submit your request.
You can choose the date by clicking it. When
you select a date such as the 5th, your request is
resubmitted on the 5th of each month until the
end date is reached.

¢ Use the weekly template to specify which day of
the week to schedule your request.

|:| Attention: You can select as many dates as you require.

12. To save your schedule, check the Save this schedule for use again
later checkbox. You must also provide a unique name for each
schedule you save. Optionally, enter a description of your
schedule.

E&f’,ﬂ' Save Schedule

Mame || |

Description | |

Cancel 0K |

13. Choose OK.

Defining Completion Options

14. In the Upon Completion... region, use the Save all Output Files to
write your request output to a file. If you wish to view your output
online, you must use this check box.

15. Choose Completion Options...
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Figure 6 -9 [2 Upon Completion...

[
B

™ Save all Output Files:

— Motify the following people:

Y

*

- Print the Qutput To:

Printer

Copies

Style |Landscape

| — |

Cancel

OK ‘

Note: Oracle Applications automatically uses the default
values determined by your logon and profile options as listed
in the following table:

Logon

Used as the default for the notification field.

Printer

Determines the default printer

Concurrent:Re-
port Copies

Used as the default for the number of copies
for the printer defined in the Printer profile

option.

Concurrent:Save
Output

Determines whether to save your report out-
put by default.

In some cases the defaults are determined by the program

definition.

16. Specify additional people to notify, or replace your name if you do

not want to be notified.

17. Select a print style from the poplist.

18. Use the LOV to select the printers you want used to produce a hard
copy of your report. Each printer will produce at least one copy of
the report. If you need more than one copy for a particular printer,
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use the Copies field to enter the number of copies you want
printed.

Note: Some requests may have a required Style or Printer that you
cannot change.

19. Choose OK.

20. When you are done specifying scheduling and completion options,
choose Submit Request.

Once you submit your request, the Requests window opens and
provides you with the current status of your request and the
request ID number.

Oracle Applications assigns a request ID to each request
submission so that you can identify the results of the request when
it is complete. You can use the request ID to query for your request
output in the Requests window. Oracle Applications also assigns a
new request ID number to each resubmission of a request and
displays the request ID in the log file of the previous request.

21. If you wish to submit another request, simply repeat Steps 1
through 20. All the requests that you submit for the current session
appear in the Requests window.

See Also

Rerun a Prior Request: page 6 — 19
Using the Requests windows: page 7 — 2

Rerun a Prior Request: page 6 — 19

Rerun a Prior Request

You can resubmit any request you previously submitted that is part of
your current responsibilities request security group. The previous
requests are displayed in a Find window when you choose the Copy a
Prior Request... button. The list of requests include all of the requests
you submitted that are part of your current responsibilities request
security group and were submitted after the last time your System
Administrator ran the Purge Concurrent and/or Manager Data
program
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» Resubmit arequest:

1
2.
3.

Navigate to the Submit Request window.
Choose the Copy a Prior Request... button
Select a request from the Find window and choose OK.

The request information such as, request name, parameters, and
schedule appear in the Submit Requests window. You can modify
the request at this time or resubmit as is.

Choose the Submit Request button.

Submitting a Request Set

S

ubmitting a request set is very similar to submitting a request. You

use the same menu path for both, however, when you choose Request

Figure 6-10 @Submil Request Set

Set, the Submit Request Set window is opened.
£ 2
— Run this Req
Request Set
I Program Stage Pararmeters Language
d 2
Completion Options...
— At these Times...
As Soon As Possible Schedule... ‘
Copy a Prior Request... Cancel Submit Request ‘

» Tosubmit a request set:

m  The steps for submitting a request set are very similiar to those for

submitting a single request.
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1. Check Request Set in the Submit a New Request window and
choose OK.

2. Inthe Submit Request Set window enter the name of the Request
Set.

Alternatively, choose Copy a Prior Request button to use a
previously defined request set submission.

3. The requests assigned to the request set are displayed in the
multi-row region and may be modified for this request set
submission.

— When you move your cursor to the Parameters field for a
request, Oracle Applications displays a Parameters window
specific to that report. If there are no parameters, then the
field is disabled. See Defining Parameters: page 6 — 30

— When you finish entering the required parameter values for
a request, choose OK to close the window.

— If you wish to define completion options, open the Upon
Completion... window for each request and enter your
completion options. See Defining Completion Options:
page 6 — 17

Note: If you wish to view a request’s output online, you must
check the Save all Output Files check box for that request in the
Upon Completion... window.

4. Choose the Schedule window to define a schedule for this request
set submission. See Defining Submission Schedule: page 6 — 13
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Figure 6 - 11 [ Requests [ (O] ]
Refresh Data Fintd Requests | Submit a New Request... |
Request D Farent
4{ | MName | Phase Status Parameters
Hiold Reqguest View Details... | View Output |
Cancel Request Diagnostics | ViewilLog... |

5. When you submit a request set, Oracle Applications assigns a
request ID to the request set as well as to each request in the

request set. The request ID for each request is displayed in the
output and log files of the request set. Oracle Applications also
assigns a new request ID to each resubmission of a request set, and
displays the request ID of the new request set in the log file of the

previous request set.

See Also

Using Standard Request Submission: page 6 — 9

Submitting a Request: page 6 — 9

Defining Request Sets: page 6 — 22

Who Can Use a Request Set: page 6 — 33

Defining Request Sets

By defining request sets, you can submit the same set of requests

regularly using a single transaction. You use the Request Set window
to create and edit request sets. Alternatively, you can use the Request
Set wizard to create simple request sets. Refer to the user’s guide for
your Oracle Applications product to learn how to access the Request

Set window.
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[]

Request Set window available.

Defining a Request Set

Enter Request Set

name and other

general information

Define a Stage

| /
| Definea Stage

] \

* [

| Definea Stage

I
Enter Requests Entor R+e oSS *
u
for Stage q Enter Requests
T for Stage
v T T for Stage
Enter Request Ertor Reauest Y
Parameters Param ec'gers Enter Request
[ l | Parameters
Link Stages

1

Save Changes

Organizing Requests with Stages

Attention: Some Oracle Applications products do not allow
you to create request sets. These products do not have the

Request sets are divided into one or more ’stages” which are linked to

determine the sequence in which your requests are run. Each stage

consists of one or more requests that you want to run in parallel (at the

same time in any order). For example, in the simplest request set

structure, all requests are assigned to one stage. This allows all of the
requests to run in parallel.

Request Set

Stage 1
request 1
request 2
request 3

— End

Running Oracle Applications Reports and Programs
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6 - 24

To run requests in sequence, you assign requests to different stages,
and then link the stages in the order you want the requests to run.

Request Set

Stage 1 Stage 2 Stage 3

request 1 — request 2 — request 3 —= End

The concurrent manager allows only one stage in a request set to run at
atime. When one stage is complete the following stage is submitted.

A stage is not considered to be complete until all of the requests in the
stage are complete. One advantage of using stages is the ability to run
several requests in parallel and then move sequentially to the next
stage. This allows for a more versatile and efficient request set.

Request Set

Stage 1 Stage 2 Stage 3
request 1 request 5
request2 [~ | request4 reguest 6 |~ End

request 3

Using Stage Status

Like request sets and concurrent requests, stages can complete with
different statuses. Each stage can complete with a status of Success,
Warning, or Error. You can use these completion statuses to structure
your request set, by defining which stage will follow the current stage
based on its completion status. For example, the request set in

Figure 6 — 12 always begins with Stage 1. If Stage 1 were to complete
with the status Warning, then the Warning link would be followed, and
Stage 3 would be submitted. After Stage 3 completes, the set ends,
since there are no links that may be followed.
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Figure 6 — 12

Request Set

Stage 2

request 4

Success
Stage 1 Stage 3
request 1 Warning
request 2 request 5
request 3
Stage 4
request 6

In this example, the ”Standard” function calculates the status for a
stage using the statuses of the requests within the stage. The Standard
function sets the stage status to Success if all of the requests in a stage
complete with a status of Success. If one or more requests complete
with a status of Error, then the status of the stage is Error. For a stage’s
status to be Warning, one or more of the requests must have a status of
Warning and no request may have a status of Error.

Linking of Stages

There are no restrictions on linking stages within a request set. Any
stage may be linked to any other stage, including itself. Two or more
links can point to the same stage. For example, Stage 1 can link to
Stage 2 if the completion status of Stage 1 is Success or Warning, and
link to Stage 3 if the status is Error.

Running Oracle Applications Reports and Programs 6-25



Figure 6 — 13

Request Set

Stage 2 S _[Stage 4 S [Stage 6

Success W
(S) E E W S|W
. Y
Stage 1 W?w;”g [ End Request Set |
Start Stage W = T STWT
Error ] Stage 3 [S | Stage 5
(B)
E

Links can point to any stage in the set. The Request Set is
completed when a stage ends with a status that does not specify a
stage to follow.

You determine the end of a request set by not specifying a followup
stage for each completion status. You can end a request set after any
stage in the request set. When any stage completes with a status that
does not link to another stage, the request set ends.

You can use the linking of stages to control your request set. In
previous releases you had three options: run in parallel, run
sequentially, and run sequentially but abort on Error. All of these are
easy to recreate using the request set wizard. You can use the Request
Set Wizard button in the Request Set window to start the wizard. The
wizard takes your input and creates the request set as follows:

Run in Parallel Creates one stage containing all of the requests you
wish to run in parallel.

Run Sequentially Creates a separate stage containing the request or
requests for each step in the sequence and link in
the appropriate order.

Run Sequentially Sets up your sequence the same as it did for Run

but abort on Sequentially, but when it links the stages, it does

Error not enter a follow up stage as a link in the Error
completion status field.
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Figure 6 - 14

[% Request Set [_ o] x]
Set |
Set Code
Application
Description |
Owner |
Active Dates Run Options
From [28-FEB-2000 I Print Together
To I Allow Incompatibility

Request Set Wizard | Define Stages Link Stages

To create a request set:

1.
2.
3.

10.

Navigate to the Request Set window.
Enter a Name for your request set.

Enter a Short Name for your request set. This name is used
internally to reference your request set.

Enter the Application with which you want to associate your
request set.

Enter a Description of your request set if you like.

The Owner field defaults to your username and can only be
changed by your system administrator.

Enter the Active Dates From and To fields to define an effective
period when you and others can run the request set. If the current
date is outside the range you define, the request set will not be
available in the Submit Requests window.

Check the Print Together check box to send all your requests to the
printer together when they complete, or uncheck the check box to
send each request one at a time to the printer as it completes.

Check the Allow Incompatibility check box to allow your system
administrator to specify programs that this request is incompatible
with (may not run with). Leave Allow Incompatibility unchecked
to specify that this request set may run with all other concurrent
requests or request sets.

Choose Define Stages or Link Stages if you have finished defining
your stages. See Define Stages: page 6 — 28 or Link Stages: page
6-32
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Figure 6 — 15

E;g Stages =1 B3

Set Set Application

Display Sequence

e

Stage Description

-

— Stage Details

Stage Code ‘

E q
Function ‘ Parameters
Application

" The Return ‘alue of This Stage Affects the Set Outcome
™ Allow Incompatibility

Requests

Defining Stages

1. The value for the Display Sequence is defaulted in sequence as you
enter your stages. You may change the display order of the stages
by modifying this field.

2. Enter a Name for the stage.
3. Enter a Description of your stage if you like.

4. Enter a Short Code for the stage. This code is used internally to
reference the stage.

5. Inthe Function field of the Function region, use the List of Values
to select a function. The default value for this field is the Standard
Stage Evaluation function. This function bases its completion
status on the normal completion status of the requests it contains.
Other functions may be provided by your Oracle product. For a
description of these functions, refer to the user’s guide for that
product.

6. Use the "The Return Value of this Stage Affects the Set Outcome”
checkbox if you want to ensure that the request set’s completion
status is equal to the completion status of this stage.

Note: If you choose this checkbox for more than one stage, the
completion status of the request set will equal the completion
status of the last of these stages to run within the set.
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7. Use the Allow Incompatibility check box to allow your system
administrator to specify programs that this stage is incompatible
with (may not run with). Leave Allow Incompatibility unchecked
to specify that this stage of the request set may run with all other
concurrent requests or request sets.

8. Choose Requests.

Figure 6 - 16 3
@Stage Requests =1 3
Set Set Application

Stage

— Programs I

Allow Stage Function to Use This Program's Results
Seq Program Application Description
=l

L L I A I i

-

"Print Options

Copies [0 ¥ Save

Style Printer | |

Parameters |

Stage Requests window

In the Stage Requests window you define which requests you want to
include in the stage.

9.

10.

Select the report or program you want to include in your request
set. A description of the request you choose and its associated
application appears in the Description and Application fields.

The list of requests you can choose includes the requests that your
responsibility’s request group lets you access from the Submit
Requests form.

The Print Options region reflects the options for the current
request. Specify the number of Copies of output to print, the Style
to print, the Printer to print to, and whether to save the output to
an operating system file.
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Standard Request Submission saves these options so you do not
have to specify them again when you run the request set. If you do
not wish to specify these options for each request when you define
the set, Standard Request Submission uses the values of your
personal profile options as the default when you submit the request
set. See: Default Values of Concurrent Processing Options: page
6-7.

Note: Some requests may have a required Style or Printer that you
cannot change.

11. Use the Allow Stage Function to Use This Program’s Results check
box to indicate which programs or reports should be included.
12. When you are done with the Print Options, choose Parameters to
display the Request Parameters window.
Figure 6 - 17 E Request Parameters =[O x]
Set Set Application
Stage Seguence
Program Application
Display — — Default
Seq  Prompt Modify Parameter Type Walue
= Ul M o~
[ 0O
1 0O
1 0O
1 0O
1 0O
1 0O
1 [
1 [
1 [
1 [
=1 [
Request Parameters Window
The Request Parameters window lets you customize the parameter
values of a specific request in a request set. The fields at the top of the
Request Parameters window list general information about the current
request set and the request for which you can customize the parameter
values. The multi-row portion of the window lists the parameters for
that request.
13. The Sequence field displays the order in which each request
parameter appears when you run the request in the Submit
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14.

15.

16.

17.

Requests window (lower numbers appear before higher numbers).
Only your system administrator can change a parameter’s order.

The Prompt field is a display-only field that shows the request
parameter’s prompt.

Check the Display check box to specify that you can see a request
parameter at submission time, or uncheck the check box to specify
that a parameter should not be displayed at submission time.

Check the Modify check box to specify that you can insert or
change the value for a request parameter at submission time, or
uncheck the check box to specify that a parameter cannot be
changed at submission time.

Use the Shared Parameter field to set a default value for a
parameter that occurs in more than one report or program of a
request set. Once you enter the same parameter label in the Shared
Parameter field for each occurrence of the same parameter, the
value that you assign to the first occurrence of the parameter
becomes the default value for all subsequent occurrences of the
parameter. The shared parameter label simply enables you to set
an initial default value for all occurrences of the same parameter so
you can avoid typing the same value all over again for every
occurrence of the parameter.

For example, suppose you define a request set that includes three
reports, and all reports include a parameter called “Set of Books”.
You want the “Set of Books” parameter to default to the same value
in all reports. To accomplish this, enter a label called “Book” in the
Shared Parameter field for the first occurrence of this parameter.
You can also assign a value in the Default Value field of this
parameter now, or wait until you run the request set to assign a
default value when the parameter first appears. Enter the label
“Book™ in the Shared Parameter field of all other occurrences of the
“Set of Books” parameter in your request set. When you submit
this request set from the Submit Requests window, every
parameter that you label “Book” defaults to the value you assign to
the first occurrence of the “Set of Books” parameter.

Attention: Note that if you later change the value of a parameter
that contains a shared parameter label, you change only the value
for that instance of the parameter, and not the value for all other
occurrences of that labelled parameter.

We recommend that if you make a parameter with a shared
parameter label modifiable, that you also display the parameter so
you can always see what the parameter’s current value is. This
helps reinforce the understanding that a later value change to one
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Figure 6 - 18

|

labelled parameter cannot propagate a value change to all other
similarly labelled parameters.

18. Optionally enter a Default Type and Value for the parameter.
19. Save your work.

20. Go back to the Stage Requests window and repeat Steps 9 through
11 to add more requests to the request set stage.

You can select a request more than once if you want to run the
same request with different default parameter values.

21. To start a new stage, return to the Stage window and choose New
Record from the Menu.

E;g Link Stages B

-

Set Set Application

Start Stage

Display Sequence — Stage To Proceed To On...

Marne Success WWarning Erraor

=1

Description

Stage Properties
’7 ™ The Retumn Yalug of this Stage Affects the Set Outcome

Cancel Done

Link Stages

1. Enter the Start Stage. The stage you enter here is the first stage
submitted for the request set.

2. Enter the stages you want to run following the first stage in the
Success, Warning, and Error columns. To ensure that a particular
stage follows the preceeding stage regardless of the completion
status, enter the desired stage in all three columns. To stop the
request set if a stage ends in Error, leave the Error column blank.
Any time you do not specifically indicate which stage should
follow for a completion status, the request set will exit on that
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completion status. In the following example, the request set will
always exit if any stage returns a completion status of error. In
addition, stages C and D will terminate the request set regardless
of their completion status. If Stage A returns a status other than
Error, Stage B will be submitted. Finally, when Stage B completes
with a status of Success, it is followed by Stage C, or if the status is
Warning, Stage D will follow.

Name Success Warning Error
1 | Stage-A Stage-B Stage-B
2 | Stage-B Stage-C Stage-D
3 | Stage-C

4 | Stage-D

3. Choose Done.

Who Can Use a Request Set

See Also

After you define a request set, it becomes your private request set. You
can run it as long as you have access to a standard Submit Requests
window that does not limit access to specific requests.

Other users can run the request set only if your system administrator
assigns the request set to their responsibility’s request group. Itis
possible to have a request set in your request group that contains
individual requests that are not in your request group.

You can only edit request sets that you own. You can add any requests
in your request group to the request set. You can delete any request
from the request set, regardless of whether that request is in your
request group. To update information about an individual request in
the request set, however, the request must be in your request group.

Use the Request Sets window to edit a request set, and the Submit
Requests window to submit a request set to be run.

Submitting a Request Set: page 6 — 20
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CHAPTER

5

Monitoring Oracle
Applications Reports
and Programs

T his chapter tells you how to view and monitor your requests.
Specifically, this chapter tells you how to:

e Use the Find Requests window
« Use the Requests window
* View the progress of a concurrent request

« Cancel a request or change its processing options
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Viewing Requests

Since all reports, programs, and request sets are run as concurrent
requests in Oracle Applications, you use the Requests window to view
the status and output of your requests.

Monitoring Requests: page 7 — 12

Using the Requests Window

You can use the Requests window to view a list of all submitted
concurrent requests, check whether your request has run, change
aspects of a request’s processing options, diagnose errors, or find the
position of your request in the queues of available concurrent
managers.

You can navigate to the Requests window using the Navigate window.
Different Oracle Applications products use different menu paths in the
Navigate window to access the Requests windows.

3~ Suggestion: Refer to the Menu Paths appendix of your
@ application’s user’s guide to learn how to access this window
from your application.

Attention: If your system administrator sets the profile option

|:| Concurrent:Report Access Level to “User”, the Requests
window displays the concurrent requests for the current user.
If your system administrator sets the profile option to
“Responsibility”, the Requests window displays the concurrent
requests for the current responsibility in addition to requests
for the current user.
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Figure 7-1

Evgji Find Requests H[=]

& My Completed Requests:

" My Requests In Progress
Al My Requests
—( Specific Reguests
Request 1D
MName
Date Submitted

Date Completed

Status -
FPhase -
Reguestor | |

I Include Request Set Stages in Query
Order By |Request D |v|

Submit a New Hequest... Clear ‘ Find

p To use the Find Requests window:

1.

Upon initial navigation to the Requests window, you are directed
to the Find Requests window.

Use the Find Requests window to specify the types of requests you
want to see. You can choose to view your completed requests,
your requests in progress, or all of your requests by selecting the
appropriate option group.

In addition, you can look for a particular request using the Specific
Requests option group. Use the find criteria fields as you would
for any other find window to specify as many or as few details as
you need to locate the desired request information.

Note: You can use the Specific Requests region to view requests
that you did not submit by entering a requestor other than yourself
or using wildcards such as the "% to query all requests.

Note: Depending on the value of the profile option Concurrent:
Report Access Level, some concurrent requests may not be shown.

Note: Although you can list all submitted concurrent requests, you
can generally only view detail, report output, and request log file
information for your own concurrent requests. However, if the
user profile Concurrent:Report Access Level is set to Responsibility, you
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Figure 7-2

E%g Requests

can review the details of all requests submitted for the current
responsibility and username

Use the Order By poplist to specify the order in which you want
your requests displayed.

[H[=] E3

Refresh Data ‘ Find Requests | Submit a New Request... |

=

Request ID Parent

Mame Phase Status Parameters

Hold Request. ‘ View Details... | View Output |

Cancel Request ‘ Diagnostics | Yiew Loy, |

» To use the Requests window:

1.
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Move your cursor to the record that represents the request you
want to examine in detail.

Each record shows you the the request ID, request name, phase and
status of the request, as well as the parameters used by the request.
If the request is part of a request set, the request ID for the parent
request is provided in the Parent column.

The Phase and Status fields use color to draw your attention to
particular requests. If the color of the Phase and Status fields is:

Red
Yellow

The request has completed with a status of ERROR.

The request has either completed with a status of
WARNING or is currently INACTIVE.

The request is PENDING or RUNNING.

The request has completed with a status of NORMALL,
CANCELLED or TERMINATED.

Green
White

From the Requests window you can Cancel a request or put it on
hold if the status of the Request is pending. If the status is




completed, you can view the output or the logs generated by the
request. Lastly you can always review the details of the request
submission.

Choose View Details...

p Toreview and update a request’s schedule:

The Date Started and Date Completed are displayed in the At these
Times region.

Choose Schedule... to see more detailed information.

You can update the scheduling information for your request if it
meets all of the following criteria:

— you made the initial request.
— the request has not yet run.

— the program does not prevent request updates.

p Toreview and update a request’s completion options:

Choose Completion Options to see:
* Names of people to notify

* Name of printer used

« Number of copies to print

e Print Style

You can update the completion option information for your request
if it meets all of the following criteria:

— you made the initial request.
— the request has not yet run.

— the program does not prevent request updates.

p Tracking your request in the concurrent manager’s queue:

1.

With your cursor on a record of interest in the Requests window,
choose Managers from the Special menu.

This window lets you view your request’s position within each
available concurrent manager’s queue, if the request has not run
yet.
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FlgUI’e 7-3 Egil:oncunent Managers for the Request (=1 E3

Request [D Program
— Concurrent Manag !
— Number of Req
Request
MName Position Running Maximum Pending

Manager Queue |

Note: The Manager Log entry on the Special Menu is disabled for
all users except the system administrator. This choice lets the
system administrator open a window displaying the concurrent
manager’s log file for the request.

2. Choose the Manager Queue button to display the Concurrent
Manager Queue window. This window displays the queue of
requests waiting to be processed by the concurrent manager you
select in the Concurrent Managers window.
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Figure 7-4
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s

p Toreprint your request:

With your cursor on a record of interest in the Requests window,
choose Reprint... from the Special menu to reprint a request’s
output. When you choose Reprint..., a window appears allowing
you to enter a printer, number of copies, and style for reprinting of
the request. Choose Accept in the Reprint window to reprint the
request.

Note: This menu entry is disabled if the request has not yet run.

p To view Request Diagnostics:

With your cursor on a record of interest in the Requests window,
choose Request Diagnostics from the Special menu to display a
window containing information about when the request completed
and if it did not complete, a message explaining why not.
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Figure7-5 Egaﬂequest Diagnostics
Request ID
Fhase
Status
Mame
0K
See Also

Monitoring Requests: page 7 — 12
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Viewing Request Output and Log Files

Oracle Applications allows you to view your log and report output files
online with the Report File Viewer. The viewer provides navigational
buttons that enable you to go directly to the first or last page of your
report, or to move to the next or previous page. In addition, you can
choose Go To Page from the Special menu to specify the page of the
report you want to view. You can activate the viewer from the

Requests window.

Note: Some reports have special formatting characters that
printers use to print special effects, such as boldfacing or
underlining. If your computer does not support such special
characters, you may see these characters when you view your
report online. However, the report still prints correctly without
displaying these characters.

Figure 7-6 B2 Requests [ 100] ]
Refresh Data | Find Requests ‘ Submit a New Request... ‘
Request ID Parent
‘ Name Fhase Status Pararmeters
Hiold Reguest | View Details... ‘ Yiew Output ‘
Cancel Request | Diagnostics ‘ View/log... ‘

p To View Request Output:
Choose View Output
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Figure 7-7
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» Toview requests log files:
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Choose View Log to display the request’s error log file. If your
request ends in error, you can view a log of the error messages.
The log also contains information about the print options used and
a listing of child request IDs, if the original request is a parent

request.

See Example: Figure 7 -8




Figure 7-8

equest ID - 1809122

Page 1 Font Size

Application Chject Library: Version : 11.0.26 - Development
Copyright (o) Oracle Corporation 1979, 1991, Aill rights reserved.

FHDSCURS wodule: Acotive Users

Current system time is 29-DEC-1997 12:43:01

| Starting concurrent program execution...

No completion options were reguested.

-
1] | »

Go To... < First < Previous Hext > Last >l |

Monitoring Requests: page 7 — 12

Monitoring Oracle Applications Reports and Programs 7-11



Monitoring Requests

Oracle Applications lets you monitor your concurrent requests when
you display the Requests window. And, if your request has not yet
started running, Oracle Applications lets you cancel or change some of
the request’s parameter, scheduling, or completion options.

This section tells you how to monitor your concurrent requests and
modify their options after you submit them to run.

Concurrent Request Phase and Status

7-12

The Requests window displays a phase and status summary for each
concurrent request listed.

A concurrent request has a life cycle consisting of the following phases:
pending, running, completed, and inactive.

During each phase, a concurrent request has a specific condition or
status. Table 7 —1 lists each phase/status combination and describes
its meaning in relation to a request.

If a request is pending, you can determine when it will start by using
the Concurrent Managers For the Request window from the Requests

window to review the request’s position in the queues of current

managers that can run that request.
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Concurrent Request Phase and Status

Phase Status

PENDING Normal

Description

Request is waiting for the next available manager.

Standby

Program to run request is incompatible with other
program(s) currently running.

Scheduled

Request is scheduled to start at a future time or date.

Waiting

A child request is waiting for its Parent request to mark it
ready to run. For example, a request in a request set that
runs sequentially must wait for a prior request to
complete.

RUNNING Normal

Request is running normally.

Paused

Parent request pauses for all its child requests to finish
running. For example, a request set pauses for all
requests in the set to complete.

Resuming

All requests submitted by the same parent request have
completed running. The Parent request resumes running.

Terminating

Request is terminated by choosing the Cancel Request
button in Requests window.

COMPLETED | Normal

Request completed successfully.

Error

Request failed to complete successfully.

Warning

Request completed with warnings. For example, a
request is generated successfully but fails to print.

Cancelled

Pending or Inactive request is cancelled by choosing the
Cancel Request button in the Requests window.

Terminated

Request is terminated by choosing the Cancel Request
button in the Requests window.

INACTIVE Disabled

Program to run request is not enabled. Contact your
system administrator.

On Hold

Pending request is placed on hold by choosing the Hold
Request button in the Requests window.

No Manager

No manager is defined to run the request. Check with
your system administrator. A status of No Manager is
also given when all managers are locked by run-alone
requests.

Table 7-1 (Page 1 of 1)
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Individual Request Progress

Generally when you submit a request, its phase is Pending, which
means that it has not yet started running. When it does start running,
its phase changes to Running. Upon completion the status of the
request becomes either Success, Warning or Error. If your request ends
in warning or error, you can use the Special Menu to select Diagnostics
from the Requests window to view any diagnostic messages stored in
the log file.

Request Set Progress for Stages

When you submit a request set, all the requests in a stage run
simultaneously and the phase and status of the set begins as Pending
Normal until an available concurrent manager can process it. When a
concurrent manager becomes available, the stages’s phase and status
change to Running Paused as the stage waits for all of its requests to
finish. Then the stage changes from Running Paused to Running
Normal to write completion information in the report and log files.
Finally, the stage phase changes to Completed and its status becomes
Success, Warning, or Error.

Progress of Individual Requests in a Stage

When a stage submits its requests, all requests start as Pending
Normal, then change to Running Normal, and finally end as either
Completed Success, Completed Warning, or Completed Error.

Progress of Linked Stages

When you submit a request set with more than one stage, the request
set submits all the stages but only runs one stage at a time, ensuring
that each stage completes before submitting the next. Each stage shows
a phase of Pending and a status of Normal while it waits for a
concurrent manager to process it. As the next available concurrent
manager processes the stage, the request set phase and status changes
to Running and Paused, as the first stage begins to run. After each
stage finishes, the request set temporarily changes to a Normal status
to check whether the stage ended in error and to determine whether to
stop or which stage should be processed next based on how you linked
the stages when you defined the request set.

Once the check is done for a completed stage, the set goes back to
Paused status during which the next stage runs. The set alternates
between Normal and Paused status for each stage in the set. The set
itself resumes running (Running Normal), after all the requests finish,

Applications User’s Guide



See Also

Cancelling Requests

See Also

to write completion information in the report and log files. The set
ends in a Completed phase, either with Success, Warning or Error
status. A request set ends when a stage ends with a completion status
that does not link to a subsequent stage.

Monitoring Requests: page 7 — 12

Use the Requests window to cancel a request (report, program, or
request set) that has not yet completed.

To cancel a request that has not yet completed:
1. Navigate to the Find Requests window.

2. Check My Requests in Progress.

3. Choose Find.
4

With your cursor on the request you wish to cancel, choose Cancel
Request to terminate the request. You can only cancel a request if it
is in the Running, Pending, or Inactive phase. You can put your
request on hold by choosing Hold Request if the request is Pending
or Inactive.

Attention: If you cancel a request set, Oracle Applications
automatically cancels all requests in the set.

Attention: If you terminate a request while it is in the Running
phase, the current run stops, but the resubmission does not. While
the resubmitted request is in the Pending phase, you can go to the
Resubmission alternative region of the Requests window and
change the Interval for the request to 0 or change the End Date to a
date that has passed to cancel the resubmission.

5. Select Save from the Action menu.

Monitoring Requests: page 7 — 12
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Changing Request Options

7-16

If your request or request set has not started running, you can change
how your request or request set runs and prints its output using the
Requests window (accessed from the Requests window) or by using
the Print Options and Resubmission alternative regions on the Requests
window.

p Tochange the request options of a request or request set that has not
yet started running:

1.

2
3
4.
5

Applications User’s Guide

Navigate to the Find Requests window.

Check Specific Requests.

Enter the Request ID for the Request you want to modify.
Choose Find.

From the Requests window, you can cancel a request or request set,
put a request or request set on hold, or take a request or request set
off hold using the buttons in the window. A request or request set
on hold does not run until you take it off hold.

Attention: The cancel or hold action does not go into effect until
you choose Save from the Action menu or the toolbar.

With your cursor on the request you wish change and choose View
Details.

If the request is pending or scheduled, you can change the request
parameters, language and territory of the output, and if you want
to save your output.

Choose Schedule to change:

« start and end dates for recurring requests
+ schedule dates

Choose Completion Options to change:

» people notified

e printers

* number of copies

Attention: For requests in a request set, you can change the values
of the request options if the requests are in your responsibility’s
request group.



See Also

Monitoring Requests: page 7 — 12
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Working with
Attachments

CHAPTER

T his chapter teaches you how to use the Attachments feature to link
data such as images and word processing documents to your
application data. Specifically, this chapter tells you how to:

e Attach a document to an Oracle Applications record
« View an attachment

* Copy or delete an attachment
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About Attachments

To illustrate or clarify your application data, you can link
non-structured data such as images, word processing documents,
spreadsheets, web pages, or video to more structured application data.
For example, you could attach images to inventory items or video to
manufacturing operations.

Invoke the Attachment form to view an attachment by pressing the
Attachment toolbar button.

The toolbar Attachment icon indicates whether the Attachments feature
is enabled in a form block. When the button is dimmed, the Attachment
feature is not available. When the Attachment feature is enabled in a

. form block, the icon becomes a solid paper clip. The icon switches to a
b paper clip holding a paper when the Attachment feature is enabled in a
form block and the current record has at least one attachment. There is
also a profile option, Indicate Attachments, that allows you to turn off
indication of attachments when querying records for performance
reasons.

Note: The current version of the Attachments feature supports
attachments to a restricted set of applications data. Check your
product-specific documentation to determine if the Attachments
feature is enabled for your Oracle Applications product, and if so,
for what data.
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Attachments Window
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Use the Attachments window to view or delete existing attachments,
and create new attachments. You must provide the following
information when you create an attachment:

Category

The category controls which forms can access the document. Each form
that enables Attachments must list which document categories it can
access. A “Miscellaneous” category will be assigned to each form
registered for Attachments to facilitate “cross—form” visibility of

Attachments.

Datatype

An attached document can be:

Short Text Text stored in the database containing less than 2000
characters.

Long Text Text stored in the database containing 2000

characters or more.

Image An image that Oracle Forms can display, including:
bmp, cals, jfif, jpeg, gif, pcd, pcx, pict, ras, and tif.
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OLE Object for An OLE Object that requires other OLE server
Smart Client applications to view, such as Microsoft Word or
Microsoft Excel.

File for A file that requires other server applications to
Web Deployed view, such as Microsoft Word or Microsoft Excel.

Web Page A URL reference to a web page which you can view
with your web browser. You must define your web
browser in the profile option Web Browser to view a
web page attachment.

May be Changed

The May be Changed checkbox indicates if you are able to edit the
attachment.

Storage

Specify where images are to be stored:

Database Storing images in the database provides
centrally—accessible images without special file
system setup. However, database storage of images
will increase the amount of database space required
for applications.

File System File system storage of images requires a shared file
system that is accessible to all users and looks the
same to all users. For example, you should not
store an image on your local PC’ s C drive as
another PC accessing the system will not see your
PC’s C drive as its C drive.

Document Block

The document block is the section of the window below the multi-line
attachment block. The document block displays the current document
in the attachments block.

To improve performance while scrolling through lists of attachments,
uncheck the coordination checkbox. The document block will not
update until you turn coordination on again.

|:| Attention: If you maximize the document block window, no
other operations can be performed until you restore the block to
its original state.
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If the attachment is an image datatype, you can use the Magnification
poplist to choose from a list of percentages to enlarge or shrink the
image, or enter your own percentage sizing. Adjust to Fit will adjust the
image to fit within the form. Move your cursor into another field to see
your image in the new scale.

Figure 8-2 [ Attachments [-[O]x]
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Adding an Attachment

You can attach a document to any record for which attachments are
enabled, such as a supplier definition or an Order Line.
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Figure 8-3
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» To attach a new document to an Oracle Applications record:

1.
I} 2.

In an application window, query or enter a data record.

Choose the Attachment toolbar icon. The Attachments window
opens.

Enter a category and description.

To attach an image, supply an image format (e.g. TIFF) and afile
name, then select Database storage if you want to copy it to the
database. Otherwise, that image will be loaded from the file system
whenever you view it.

Save your work.

p To attach an existing document to an Oracle Applications record:

1.

I} 2.

In an application window, query or enter a data record.

Choose the Attachment toolbar icon. The Attachments window
opens.

Choose the Document Catalog... button. The Document Catalog
window opens.

Query an existing document.
Check one or more documents.
Choose Attach (1).
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7.

Save your work.

Viewing an Attached Document

p Toview an attached document:

1.
by 2.
3.

Deleting an Attachment

Query a record.
Press the Attachment toolbar icon.

Move your cursor to the document you want to view. The
Attachments appear in the document block.

To see an OLE document in the smart client environment, or a file in
the web environment, double—click on the object in the document
block or move the mouse into the document block then right—click
to get the menu; choose Document Object—>Open.

When you delete an attachment, you merely remove the association
between a record and a document. The document itself is not removed
from your file system or database.

p To delete arecord’s attachment:

1.

2
3
4,
5

In an application window, query a data record.
Choose the Attachment toolbar icon.

Move your cursor to the document you want to delete.
Choose Delete Record from the Edit menu.

Save your work.

Copying an Attachment from Another Record

Oracle Applications keeps a catalog of documents that have been
attached to applications data records so far; therefore, you can take
advantage of this catalog if you want to attach an existing document to
another data record.
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» To copy an attachment from another record:

1.

b

© N o O

In an application window, query the record that you want to attach
adocument to. (Don’t query the record that already has the
attachment.)

Choose the Attachments toolbar icon.
Choose Document Catalog....

Enter query criteria in the Attached To: field for the application
object you want to copy attachments from.

Choose Find.
Check one or more documents.
Choose Attach ().

Save your work.
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Using User Profiles

CHAPTER

T his chapter teaches you about Oracle Applications user profiles.
User profiles give you control over the behavior of certain Oracle
Applications features. Specifically, this chapter tells you:

» How to set user profile options

» Which user profiles are common to all Oracle Applications
products
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Overview of User Profiles

A user profile is a collection of changeable options that affect the way
your applications run. Oracle Applications establishes a value for each
option in a user’s profile when the user logs on or changes
responsibility. Oracle Applications provides these options so that you
can alter the behavior of your applications to suit your own
preferences.

Oracle Applications uses a set of user profile options that are common
to all the application products. In addition, each application product
has its own unique set of user profile options. The reference guide for
your application contains a complete list and a description of each user
profile option that is specific to your application.

User profile options can be set at one or more of four levels: Site,
Application, Responsibility, and User. Your system administrator can
set default option values at any of these levels.

Basic Business Needs

Oracle Applications user profiles help you satisfy the following
business needs. You should be able to:

» Set options that affect your application’s behavior to your
preference

» Modify product-specific variables that affect the functionality of
your application to suit your business environment

Major Features

9-2

User Profile Hierarchy

Oracle Applications treats user profile levels as a hierarchy, where User
is the highest level of the hierarchy, followed by Responsibility,
Application, and at the lowest level, Site. Each user profile option
ordinarily exists at each level. For example, Oracle Applications
provides a Site—level Printer option, an Application-level Printer
option, and so on. Oracle Applications enforces the level hierarchy to
ensure that a higher—level option value overrides a lower-level value.
For example, if your Site—level Printer value is “New York”, but your
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User-level Printer value is “Boston”, you can be assured that your
reports print to the Boston printer.

Definitions

User Profile Options

Changeable options that affect the way your applications run.

User Profile Levels

User profile options exist at four different levels: Site, Application,
Responsibility, and User levels. Oracle Applications treats user profile
levels as a hierarchy, where User is the highest level of the hierarchy,
followed by Responsibility, Application, and at the lowest level, Site.
Higher-level option values override lower-level option values.

Site Level

Site is the lowest profile level. Site-level option values affect the way
all applications run at a given installation site.

Application Level

Application is the profile level immediately above Site.
Application-level option values affect the way a given application runs.

Responsibility Level

Responsibility is the profile level immediately above Application.
Responsibility—level option values affect the way applications run for
all users of a given responsibility.

User Level

User is the highest profile level and is immediately above
Responsibility. User—level option values affect the way applications
run for a given application user.
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Determining User Profile Option Values

Your system administrator can set values for user profile options at
each profile level. Typically, your system administrator sets Site—level
option values after installing Oracle Applications at a site. These
Site-level option values apply until you or your system administrator
changes them.

Oracle Applications derives a run-time value for each user’s profile
option based on the value set at the highest hierarchy level. For
example, suppose your system administrator initially set your Printer
option only at the Site and Responsibility levels. When you sign on to
Oracle Applications, the Printer option assumes the value set at the
Responsibility level, since it is the highest-level setting for that option.
If you are not satisfied with that setting, you can set your own
preference at the User—level, since your User—level setting overrides the
Responsibility—level setting.

Note: Some option values can only be changed by the system
administrator. You can view the value of such a user profile
option, but you cannot modify that value. For example, you
can view the value of the user profile option
Concurrent:Request Priority, which is set at the User—level, but
only your system administrator can modify its value for you.

If the default value of a user profile option at any level is inappropriate,
your system administrator can change it at any time. Any change your
system administrator makes takes effect as soon as you log on again or
change responsibilities.
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Setting Your Personal User Profile

Figure9-1

You can change a user profile option value using the Profile Values
window, as shown in Figure 9 — 1. The Menus appendix in your
product’s reference guide tells you how to navigate to this menu.

Using this window, you can display all your options and review the
values your system administrator has set for them. You can also
change those options that are updatable if you like. Changes you make
to a User—level profile option take effect when you either change
responsibilities or close and re-login into the application. If changes
are made in character mode you must follow the same steps to apply
the changes to applications running in GUI mode. Changes you make
to your User-level options are still in force when you log in again.

If you never set your own User-level option values, your user profile
options assume the Site—, Application—, Responsibility—, or User—level
values your system administrator has set for them.

E%a Personal Profile ¥alues =]

Profile Mame Default */alue User Yalue

= I AK: Loaders input directory
I_IAK: Loaders output directory

| [P PAYMENT:Company details| | |
AP: Bank File Character Set
AP: Enter Alternate Fields Yes
||AP: Sort By Alternate Fields | | |
AR: Allow Transaction BatchingInvoice Only
AR: Allow Update Of Existing S
||AR: Alternate Name Search | |Nu |
AR: Automatic Contact Number|Yes

AR: Automatic Receipt Creatior|Create Faormat

- || ||AR: Automatic Remittance Cr94Create | |

p To change a profile option value:

1. Navigate to the Profile Values window.

This window displays all your user profile options and their
values. If you wish to display only specific user profile options,
first choose Enter from the Query menu to enter search criteria in
the Profile Name field, then choose Run from the Query menu to
run the search.
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The name of the user profile option appears in the Profile Name
field while the Default Value field displays the run-time value of
that option. The System Administrator sets default values for
many of the profile options. Some profile options may not display
a default value.

Move your cursor to the User Value field of the option whose value
you wish to modify.

Enter a new value for the option if it is updatable, or if the <List>
lamp appears, choose a value from the list of available values.

If the profile option is not updatable, the message “Item is
protected against update,” appears on the message line when you
try to change the value. You can change most of your user profile
options; values you enter in the User Value field override values
preset by the System Administrator. A few profile options cannot
be changed, but are displayed for informational purposes only.

For most personal profile options, Oracle Applications
automatically checks the value you enter to ensure it is valid.

Attention: Number or date values are not validated, therefore,
you must make sure that you enter a valid value for profile options
that require a number or date; otherwise, your personal profile
option may not work as you expect.

Though you cannot delete a profile option from your personal
profile, you can clear its value (if it is updatable) by highlighting
the field and pressing [Backspace] or by choosing Clear Field from
the Edit menu. If you clear the value, the change does not take
effect until you sign on again or change responsibilities.

Choose Save from the Action menu to save your change.

Your change will take effect when you either change responsibilities
or log out and log back in.
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Common User Profile Options

The following list of user profile options affects all Oracle Applications
products. The alphabetical list includes only those options that can be
viewed and/or changed by you at the User—level using the Personal
Profile Values window. These user profile options affect your user
interface and the behavior of Oracle Applications features, such as
concurrent processing and flexfields.

Account Generator:Purge Runtime Data

”Yes” ensures that the Oracle Workflow data used to generate
accounting flexfield code combinations using the Account Generator is
purged after the Account Generator has completed.

This profile option should always be set to ”Yes” unless you are
debugging the Account Generator. Running the Account Generator
with this profile set to ”No” fills up the workflow tables and slows
performance.

Applications Web Agent

Provides the base URL for the Apps Schema’s WebServer DAD. Your
System Administrator sets this profile option during the install process.

Use the following syntax to enter your URL.:

http://  <WebServer.Machine_Name> | <DAD_name*

Only the System Administrator can update this profile option.

Attachment File Upload Directory

Provides the directory path used to upload attachment files. Your
System Administrator sets this profile option during the install process.

Only the System Administrator can update this profile option.

Concurrent:Attach URL

Setting this option to ”Yes” causes a URL to be attached to request
completion notifications. When a user submits a request, and specifies
people to be notified in the Defining Completion Options region,
everyone specified is sent a notification when the request completes. If
this profile option is set to Yes, a URL is appended to the notification
that enables them to view the request results on-line.

Only the System Administrator can update this profile option.
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Concurrent:Hold Requests

You can automatically place your concurrent requests on hold when you
submit them.

The default is “No”. The concurrent managers run your requests
according to the priority and start time specified for each.

Changing this value does not affect requests you have already
submitted.

“Yes” means your concurrent requests and reports are automatically
placed on hold. To take requests off hold, you:

« Navigate to the Requests window to select a request
« Select the Request Control alternative region
» Uncheck the Hold check box

Concurrent:Multiple Time Zones

”Yes” sets the default value to 'Sysdate-1’ for the 'Schedules Start Date’
used by request submissions. Sysdate—1 ensures that you request is
scheduled immediately regardless of which time zone your client
session is running in. You should use this profile option when the
client’s session is running in a different time zone than the concurrent
manager’s session.

Concurrent:Report Access Level

Determines access privileges to report output files and log files
generated by a concurrent program. This profile option can be set by a
System Administrator to User or Responsibility.

If your Concurrent:Report Access Level profile option is set to ”User”
you may:

» View the completed report output for your requests online

» View the diagnostic log file for those requests online. (system
administrator also has this privilege)

« Reprint your completed reports, if the Concurrent:Save Output
profile option is set to ’Yes”.

 If you change responsibilities, then the reports and log files
available for online review do not change.
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If your Concurrent:Report Access Level profile option is set to
”Responsibility”, access to reports and diagnostic log files is based on
the your current responsibility.

« If you change responsibilities, then the reports and log files
available for online review change to match your new
responsibility. You can always see the output and log files from
reports you personally submit, but you also see reports and log
files submitted by any user from the current responsibility.

Only the System Administrator can update this profile option.

Concurrent:Report Copies

You can set the number of output copies that print for each concurrent
request. The defaultis setto 1.

< Changing this value does not affect requests that you have
already submitted.

Concurrent:Request Priority

This displays the default priority number for your concurrent requests.
Only a system administrator can change your request priority.

Requests normally run according to start time, on a “first-submitted,
first-run” basis. Priority overrides request start time. A higher priority
request starts before an earlier request.

Priorities range from 1 (highest) to 99 (lowest). The standard default is
50.

Only the System Administrator can update this profile option.

Concurrent:Request Start Time

You can set the date and time that your requests are available to start
running.

« |f the start date and time is at or before the current date and time,
requests are available to run immediately.

« |If you want to start a request in the future, for example, at 3:45
pm on June 12, 1998, you enter 12-JUN-1998 15:45:00 as the
profile option value.

¢ You must include both a date and a time.

» Changing this value does not affect requests that you have
already submitted.
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Concurrent:Save Output

You can save your request outputs in a file.
* Yes” saves request outputs.
« Some concurrent requests do not generate an output file.

 If your request output is saved, you can reprint a request. This is
useful when requests complete with an Error status, for example,
the request runs successfully but a printer malfunctions.

» Changing this value does not affect requests you have already
submitted.

Concurrent:Sequential Requests

You can force your requests to run one at a time (sequentially) according
to the requests’ start dates and times, or allow them to run concurrently,
when their programs are compatible.

« Concurrent programs are incompatible if simultaneously
accessing the same database tables incorrectly affects the values
each program retrieves.

* When concurrent programs are defined as incompatible with one
another, they cannot run at the same time.

“Yes” prevents your requests from running concurrently. Requests run
sequentially in the order they are submitted.

“No0” means your requests can run concurrently when their concurrent
programs are compatible.

Changing this value does not affect requests you have already
submitted.

Concurrent:Wait for Available TM

You can specify the maximum number of seconds that the client will
wait for a given transaction manager (TM) to become available before
moving on to try a different TM.

Concurrent;URL Lifetime

The numeric value you enter for this profile option determines the
length of time in minutes a URL for a request ouput is maintained.
After this time period the URL will be deleted from the system. This
profile option only affects URLs created for requests where the user has

Oracle Applications User’s Guide



entered values in the notify field of the Submit Request or Submit
Request Set windows.

|:| Attention: All request ouput URLs are deleted when the Pruge
Concurrent Requests and Manager... program is run even if the
URL liftime has not expired.

Concurrent:Use ICM

”Yes” allows you to use the Internal Concurrent Manager to resolve
request conflicts instead of the Conflict Resolution Manager.

Only the System Administrator can update this profile option.

Currency:Negative Format

You can use different formats to identify negative currency. The default

identifier is a hyphen (—) preceding the currency amount, as in ”—xxx”.
You can also select:

Angle brackets <> < XXX >
Trailing hyphen — XXX —
Parentheses O (xxx)
Square Brackets [ ] [ xxx ]

If you use the negative number formats of “(xxx)” or “[xxx],” in Oracle
Applications Release 11, your negative numbers appear as “<xxx>".

Note: Currency:Negative Format only affects the display
currency. Non-currency negative numbers appear with a
preceding hyphen regardless of the option selected here.

Currency:Positive Format

You can use different formats to identify positive currency values. The
default condition is no special identifier.

Currency:Thousands Separator

You can separate your currency amounts in thousands by placing a
thousands separator. For example, one million appears as 1,000,000.

Database Instance

Entering a valid two_task connect string allows you to override the
default two_task. This profile is specifically designed for use with
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Oracle Parallel Server, to allow different responsibilities and users to
connect to different nodes of the server.

Only the System Administrator can update this profile option.

Default Country

This is the default source for the Country field for all address zones and
is used by the Flexible Address Formats feature, the Flexible Bank
Structures feature and the Tax Registration Number and Taxpayer 1D
validation routines.

The profile can be set to any valid country listed in the Maintain
Countries and Territories form and can be set to a different value for
each user.

Flexfields:AutoSkip

You can save keystrokes when entering data in your flexfields by
automatically skipping to the next segment as soon as you enter a
complete valid value into a segment.

* “Yes” means after entering a valid value in a segment, you
automatically move to the next segment.

« “No” means after entering a valid value in a segment, you must
press [Return] to go to the next segment.

Note: You may still be required to use tab to leave some
segments if the valid value for the segment does not have the
same number of characters as the segment. For example, if a
segment in the flexfield holds values up to 5 characters and a
valid value for the segment is 4 characters, AutoSkip will not
move you to the next segment.

Flexfields:BiDi Direction

This profile option controls the appearance of the flexfields window in
Applications running in Semitic languages. Possible values are ”Left To
Right” and ”Right To Left”. If the profile option is not defined on a
particular installation, the default value is ”Right To Left”, where the
window appears in a normal, left to right fashion, and the text and
layout are reversed to accommodate the right-to-left nature of the
Semitic language environment.
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Flexfields:LOV Warning Limit

Use Flexfields:LOV Warning Limit to improve efficiency when
retrieving a list of values.

Sometimes, particularly when no reduction criteria has been specified,
an LOV can take a very long time to run if there is a very significant
amount of data in it. Set this profile option to the number of rows to be
returned before the user is asked whether to continue retrieving the
entire list.

Flexfields:Open Descr Window

You can control whether a descriptive flexfield window automatically
opens when you navigate to a customized descriptive flexfield.

* “Yes” means that the descriptive flexfield window automatically
opens when you navigate to a customized descriptive flexfield.

« “No” means that when you navigate to a customized descriptive
flexfield, you must choose Edit Field from the Edit menu or use
the List of Values to open the descriptive flexfield window.

Note: This profile option does not apply to descriptive
flexfields in folders.

Flexfields:Shared Table Lock

This profile option is reserved for a future release. You should not alter
the value of this profile option.

Flexfields:Shorthand Entry

If shorthand flexfield entry is defined for your flexfield, you can use a
shorthand alias to automatically fill in values for some or all of the
segments in a flexfield.

Not Enabled Shorthand Entry is not available for any flexfields
for this user, regardless of whether shorthand
aliases are defined.

New Entries Only Shorthand Entry is available for entering new
records in most foreign key forms. It is not
available for combinations forms, updating existing
records, or entering queries.

Query and New  Shorthand Entry is available for entering new
Entry records or for entering queries. It is not available
for updating existing records.
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All Entries Shorthand Entry is available for entering new
records or updating old records. It is not available
for entering queries.

Always Shorthand Entry is available for inserting, updating,
or querying flexfields for which shorthand aliases
are defined.

Flexfields:Show Full Value

If an alias defines valid values for all of the segments in a flexfield, and
Flexfields: Shorthand Entry is enabled, when you enter the alias the
flexfield window does not appear.

”Yes” displays the full flexfield window with the cursor resting on the
last segment.

Flexfields:Validate On Server

This profile option is set to ”Yes” to enable server side, PL/SQL
flexfields validation for Key Flexfields. This improves performance
when using Key Flexfields over a wide area network by reducing the
number of network round trips needed to validate the entered segment
combinations.

Folders:Allow Customization

Your system administrator controls whether you can create or customize
a folder definition layout in folder block.

* “Yes” means that you can create or customize a folder definition,
that is, the entire Folder menu is enabled in the folder block.

* “No0” means that you can only open an existing folder definition
in a folder block, that is, only the Open option is enabled in the
Folder menu.

Only the System Administrator can update this profile option.

Gateway User ID

Oracle login for gateway account. For example, applsyspub/pub.
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Help System Base URL

Help System Base URL provides the URL to the Applications Help
System. Your System Administrator sets this profile option during the
install process.

Only the System Administrator can update this profile option.

Indicate Attachments

This profile option allows you to turn off indication of attachments
when querying records (for performance reasons).

Only the System Administrator can update this profile option.

MO:Operating Unit

Determines the Operating Unit the responsibility logs onto.

Printer

You can select the printer which prints your reports. If a printer cannot
be selected, contact your system administrator. Printers must be
registered with Oracle Applications.

RRA:Delete Temporary Files

When using a custom editor to view a concurrent output or log file, the
Report Review Agent will make a temporary copy of the file on the
client. Set this profile to ”Yes” to automatically delete these files when
the user exits Oracle Applications.

Only the System Administrator can update this profile option.

RRA:Enabled

Set this user profile to Yes” to use the Report Review Agent to access
files on concurrent processing nodes.

Only the System Administrator can update this profile option.

RRA:URL

Specify a URL which points to the CGI script on your WebServer to use
the Report Review Agent to access files on concurrent processing nodes.

Only the System Administrator can update this profile option.
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Note: This profile option is valid only for those environments
which support Oracle Web-Deployed Applications report
viewer.

RRA:Maximum Transfer Size

Specify, in bytes, the maximum allowable size of files transferred by the
Report Review Agent, including those downloaded by a user with the
”Copy File...” menu option in the Oracle Applications Report File
Viewer and those “temporary” files which are automatically
downloaded by custom editors. For example, to set the size to 64K you
enter 65536. If this profile is null, there is no size limit.

Only the System Administrator can update this profile option.

Sequential Numbering

Sequential Numbering assigns numbers to documents created by forms
in Oracle financial products. For example, when you are in a form that
creates invoices, each invoice document can be numbered sequentially.

Sequential numbering provides a method of checking whether
documents have been posted or lost. Not all forms within an
application may be selected to support sequential numbering.

Sequential Numbering has the following profile option settings:

Always Used You may not enter a document if no sequence exists
for it.

Not Used You may always enter a document.

Partially Used You will be warned, but not prevented from

entering a document, when no sequence exists.

Only system administrators can change this profile option.

Session ID

This runtime profile option contains the session ID number of the last
database session that was created.

Sign—-On:Notification

”Yes” displays a message at login that indicates:

« If any concurrent requests failed since your last session,
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« How many times someone tried to log on to Oracle Applications
with your username but an incorrect password, and

« When the default printer identified in your user profile is
unregistered or not specified.

Signon Password Length

Signon Password Length sets the minimum length of an Applications
signon password. If no value is entered the minimum length defaults to
5.

Only system administrators can change this profile option.

Only system administrators can change this profile option.

Stored Procedure Log Directory

Specifying a log directory enables stored procedures used with Oracle
7.3 to generate and store log files. You must also set this log directory in
the init.ora file of the database.

For example, if the Stored Procedure Log Directory is
/rladev/rla/1.1/log and the Stored Procedure Output Directory is
/rladev/rla/1.1/0out, then the following entry should be made in the
init.ora file of the database containing stored procedures that write to
these directories:

UTL_FILE_DIR = /rladev/rla/1.1/lo0g,
Irladev/rla/1.1/out

Stored Procedure Output Directory

Specifying a output directory enables stored procedures used with
Oracle 7.3 to generate and store output files. You must also set this
output directory in the init.ora file of the database.

For example, if the Stored Procedure Log Directory is
/rladev/rla/1.1/1og and the Stored Procedure Output Directory is
/rladev/rla/1.1/0out, then the following entry should be made in the
init.ora file of the database containing stored procedures that write to
these directories:

UTL_FILE_DIR = /rladev/rla/1.1/log,
Irladev/rla/1.1/out

Using User Profiles 9-17



9-18

Two Task

TWO_TASK for the database. This profile is used in conjunction with
the Gateway User ID profile to construct a connect string for use in
creating dynamic URLSs for the Web Server. This should be set to the
SQL*NET. alias for the database.

Note: The TWO_TASK must be valid on the node upon which
the WebServer is running

Viewer: Text, PostScript, PDF, and HTML

You can use the viewer of your choice when reviewing online the log
and output files from your concurrent requests. In almost all cases, you
need to specify different viewers for reviewing text files, postscript
(bitmap) files, PDF files, and HTML files. Oracle Report programs with
VERSION=2.0b as the concurrent program’s execution option produce
postscript files.

To link the Oracle Applications concurrent processing facility with a
text, postscript, PDF, or HTML, with the appropriate application
installed on your computer, enter as the profile option value the:

* Name of the application’s executable file, when the file can be
found in your computer’s default path (for example, write.exe),
or

« Full path to the application’s executable file, when the file is not
in the default path of your compute (for example,
c:\windows\bin\write.exe).

You should also enter any required parameters that may be necessary to
invoke the application in a particular mode.

|:| Attention: In aclient-server environment, PC clients can
access log and output files on the servers by using either a
Report Review Agent or a PC-NFS mount.

Only system administrators can change this profile option.
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APPENDIX

A Oracle Applications
Menus

T his chapter provides you with a description of each menu item
listed on the menus of the main menu bar.
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Oracle Applications Main Menu Bar

| Acion I

Navigate To...
Zoom

Save
Save and Proceed

Print...
Export...
Refresh

Close Window
Close Form

Exit Oracle Applications

The Oracle Applications main menu bar includes the following menus:

» Action
« Edit

* Query
+ Go

» Folder
» Special
* Window

* Help

Action Menu

The Action menu lets you perform several actions in Oracle

Applications:

Navigate To...
Zoom
Save

Save and
Proceed

Print...

Export...
Refresh

Close Window
Close Form

Exit Oracle
Applications
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Display the Navigate window.
Invoke custom-defined zooms.
Saves any pending changes in the current form.

Saves any pending changes, and returns the form
to a state where the next transaction can be started.

Print your current window. An application may
override this action to instead allow printing of one
or more specific reports.

Export information in your folder form to a file.
Repaint the entire screen.

Close the current window.

Close all windows of the current form.

Quit Oracle Applications.



EINEN

Cut

Copy

Paste

Clear Field

Duplicate Field Above

List of Values...
Edit Field...

New Record

Delete Record

Clear Record

Duplicate Record Above

Translations...
Attachments...

Select All
Deselect All

Clear Block
Clear Form

| Query IS

Find...
Find All

Enter
Run

Cancel

Show Last Criteria
Count Matching Records
Get More Records

Edit Menu

Use the Edit menu to edit your data in Oracle Applications:

Cut

Copy
Paste

Clear Field

Duplicate Field
Above

List of Values...
Edit Field...
New Record
Delete Record
Clear Record

Duplicate Record
Above

Translations...
Attachments...
Select All
Deselect All

Clear Block

Clear Form

Query Menu

Cut the current selection to the clipboard.
Copy the current selection to the clipboard.

Paste the contents of the clipboard into the current
field.

Clear the data from the current field.

Copy the value from the prior row.

Display the list of values for the current field.
Display the Editor window for the current field.
Insert a new record.

Delete the current record from the database.
Erase the current record from the window.

Copy all values from the prior record to the current
record.

Display the Translations window.
Display the Attachments window.
Select all records (for blocks with multi-select).

Deselect all selected records except for the current
record (for blocks with multi-select).

Erase all records from the current block.

Erase any pending changes from the current form.

The Query menu provides you with options for retrieving records:

Eind...
Find All

Display the Find window to retrieve records.

Retrieve all records.
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See Also

co I

Next Field
Previous Field

Next Record
Previous Record
First Record
Last Record

Next Block
Previous Block

Summary/Detail

Enter

Run

Cancel

Show Last
Criteria

Count Matching
Records

Get More
Records

Invoke "Enter Query’ mode to enter search criteria
for a query-by—-example.

Execute the query-by-example.

Cancel the query-by—-example by exiting from
"Enter Query’ mode.

Recover the search criteria used in the previous
guery-by-example.

Count the number of records that would be
retrieved if you ran the current query-by—example.

Fetch the next set of records retrieved from the
current query.

Searching for Information: page 3 - 19

Go Menu

Use the Go menu to navigate within an Oracle Applications form:

Next Field
Previous Field
Next Record
Previous Record
First Record
Last Record
Next Block
Previous Block

Summary/Detail
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Move the cursor to the next field.

Move the cursor to the previous field.
Move the cursor to the next record.
Move the cursor to the previous record.
Move the cursor to the first record.
Move the cursor to the last record.
Move the cursor to the next block.
Move the cursor to the previous block.

Switch between the summary and detail views of a
combination block.



EIIll

New...
Open...
Save
Save As...
Delete...

Folder Menu

Show Field...
Hide Field

Move Right
Move Left
Move Up
Move Down

Widen Field
Shrink Field

Autosize All...

Change Prompt...

Show Order By
View Query...
Reset Query

Folder Tools

See Also

The Folder menu lets you customize the presentation of data in a

folder:

New...
Open...

Save

Save As...
Delete...
Show Field...
Hide Field
Move Right
Move Left
Move Up
Move Down
Widen Field
Shrink Field

Change Prompt...

Autosize All...

Show Order By

View Query...

Reset Query

Folder Tools

Create a new folder definition.

Open an existing folder definition.

Save changes to the current folder definition.
Save current folder definition to a new name.
Delete an existing folder definition.

Display a field that is currently hidden.

Hide the current field.

Move the current field to the right.

Move the current field to the left.

Move the current field up.

Move the current field down.

Increase the width of the current field.
Decrease the width of the current field.
Change the prompt for the current field.

Adjust all field widths to completely show their
data.

Toggle the display of the Order By Buttons so you
can specify the sort order for the first three fields.

Display the query criteria for the current folder
definition.

Erase the current query criteria.

Display the folder tool palette.

Customizing the Presentation of Data in a Folder: page 4 — 2
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| special I

speciall
special2
special3
special4
special5

| window

Cascade
Tile
Arrange Icons

1. First window

2. Second window
3. Third window

E @

Window Help
Oracle Applications Library
Keyboard Help...

Display Database Error...
Tools 4

View My Requests

About This Record...

About Oracle Applications...

Special Menu

The Special menu may contain up to fifteen product-specific entries.
Examples of product-specific entries may include a list of commonly
used Inquiry windows in the application, or perhaps a commonly used
window that a user may want to take a side-trip to.

If the current application does not have any product-specific entries,
the Special menu is disabled.

Window Menu

The Window menu displays the names of all open application win-
dows. On Microsoft Windows, the following three menu choices are
also available:

Cascade Display any open windows in a ”cascaded” or stair
stepped fashion.
Tile Display any open windows in a tiled”

(non—-overlapping) fashion.

Arrange the icons of any minimized windows side
by side in the lower left of the container window.

Arrange Icons

Help Menu

Use the Help menu to get additional information about Oracle Applica-
tions:

Window Help Display help for the current window.

Oracle Display a window that lists all available Oracle
Applications Applications help text.

Library

Display the current key mappings of specific
functions and menu options.

Keyboard Help...

Display Database Display the last database error.
Error...

Bring up Tools submenu. All of the entries in the
tools submenu are used for debugging. You may

Tools
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View My
Requests

About This
Record...

About Oracle

Applications...

be asked to use some of these functions if you need
to contact Oracle Support. Before you can use
these functions, your system administrator must
set the profile option Utilities:Diagnostics to Yes.

Show the status of your Concurrent Requests

Display information about the current record, such
as who created or updated it.

Display information about the current window and
application, including version information.

Oracle Applications Menus A-T7



Oracle Applications
from Character
to GUI

APPENDIX

T his appendix provides you with a description of how some of the
new features in this current release of Oracle Applications map to the
features of the previous release of Oracle Applications.
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Advantages of 11

The Oracle Applications Graphical User Interface provides you with:

» The ability to see an entire business flow by having various
windows open simultaneously.

» A toolbar for easy access to commonly used functions.

» The ability to open multiple windows at the same time, allowing
interruptions without commiting or discarding your current
work first.

* Reduced number of windows to accomplish tasks.

» Full point and click capability to move right to a field you want
to change, a button, or a menu.

» A look-and-feel that is native to your computer.

» Enter new data in the order you are given it, not in the screen
order necessarily (within database limitations).

» More ergonomic presentation, entry field outlines allows the
option of not using reverse video.

» Graphical fields such as checkboxes allow faster reading of data.
« Differentiation of fields which are always display—only.

» Poplists for short fixed lists, rather than having to go to an LOV
for them.

New Features of the Graphical User Interface (GUI)

Entering dates

» A graphical representation of a calendar that allows you to enter
the date in your form by clicking on the desired date in the
calendar.

» Access the calendar in date fields by using the LOV icon or
through the menu under Edit, List of Values.

Folders are special blocks that allow you to:
» Only display the fields you are interested in.
» Arrange the fields to best meet your needs.

» Define query parameters to automatically call the records you
need when opening the folder.
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» Sort in any order relevant to your needs.
Toolbar

* Most commonly used menu items are duplicated as icons at the
top of the Applications window.

Attachments

» Used to link non-structured data such as images, word
processing documents, or video to application data.

Multiple windows

» Allows you to display all elements of a business flow on the
same screen.

» Does not require that you complete entering data in one form
before navigating to another form. Each form can be committed
independently.

On-line Help

» Help is now based on the functional flow of the task rather than
according to the form’s structure.

» Lets you select the task you want to perform and provides a step
by step description of the task.

» Allows navigation to any part of the Help system.

Character Mode menus — GUI-Equivalents

Function Character Mode GUI-Equivalent
Main Menu Choices
Navigation | \Navigate Action—>Navigate to... or Navigator icon
Help \Help Help menu
Field Help->Window Help or Help icon
Zone ) Note: Help is now task
oriented, so
specific field help may be
Screen unavailable.
Error Help->Display Error

Table 9-1 (Page 1 of 4)
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Function Character Mode GUI-Equivalent
Keyboard Help->Keyboard Help
Version Help->About Oracle Applications...
User
Lamp Help for these features is available online in the
Edit User’s Guide.
Help
Pick
Zoom
Requests Help—>View My Requests
Query \Query Query menu
Enter Query—>Enter
Run Query—>Run
Count Query->Count
Next Query—>Get More Records
Quit Query—>Cancel
Field \Field Go, Help, and Edit menus
QuickPick Edit—>List of Values... or LOV icon
Help Help->Window Help or Help icon
Next Go—>Next Field
Prior Go—>Previous Field
Delete Use system functionality
Copy Edit->Duplicate Field Above
Edit Edit->Edit Field... or Editicon
Mode No longer applies
Row \Row Go, Help, and Edit menus
Erase Edit->Clear Record or Clear Record icon
Copy Edit->Duplicate Record Above
Delete Edit->Delete Record or Delete Record icon
Insert Edit->New Record or New Record icon

Table 9 -1 (Page 2 of 4)
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Function Character Mode GUI-Equivalent
Next Go—>Next Record
Prior Go—>Previous Record
Who Help->About This Record
Zone \Zone Go, Help, and Edit menus
Help Help->Window Help or Help icon
Erase Edit->Clear Block
Next Go—>Next Block
Prior Go—>Previous Block
Screen \Screen Action, Help, and Edit menus
Help Help->Window Help or Help icon
Refresh Action—>Refresh
Erase Edit->Clear Form
Print Action—>Print or Print icon
Save Action—>Save or Save icon
Action—>8ave and Proceed or Save and Proceed
icon
User \User Available in the Navigator Window only.
Special menu
Responsibility Special->Switch Responsibility or
Switch Responsibility icon
Menu No longer applies
Password Special->Change Password
Signon Special->Sign On Again
Tools Can now be opened directly with your
computers native system such as the Windows
Explorer in Microsoft’s Windows95.
Other \Other Action, and Help menus
ZOOM Action—>Zoom or Zoom icon
Browse Navigator

Table 9 -1 (Page 3 of 4)
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Function Character Mode GUI-Equivalent
Calculate Use system calculator
Utilities
Examine Help->Tools, Examine...
Zoom This menu entry is no longer used
HelpText Help->Window Help or Help icon
UserExit No longer applies
Debug Help->Tools, Debug
Trace Help->Tools, Trace
Memory No longer applies
Exit \Exit Action—>Exit Oracle Applications

Table 9 -1 (Page 4 of 4)

Architectual Changes

With the change to a graphical user interface many of the forms in
Oracle Applications have been redesigned to make the business flow of
the task more intuitive and easy to learn. In addition, by enabling one
form to perform several functions, the number of screens required to
accomplish a task have been reduced.

Behavioral Differences
The Return key

In character mode the return key provided a means to advance to the
next field the same as the tab key. In the GUI environment while the
function of the tab key remains the same the return key now activates
the default button for the window if it contains one. The default button
is indicated by a black border. In the following figure the ’"Connect’
button is the default button.
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Cancel Connect

QuickPick
Quickpick has been replaced by the List of Values feature
Saving Your Work

In character mode, Oracle Applications required that you either save or
discard changes before moving to a new form. In the GUI environment
most forms are independent of each other and do not require you to
complete work in one form before moving to a new form.
Consequently, if you make changes in one form and need to access
those changes in another form you must explicitly save those changes
before you can access them from the other form.

Browse

The Browse feature allowed you to suspend work in your current form
and view other forms in your application. The ability to open multiple
windows in the GUI environment renders the Browse feature obsolete.

Zoom

Oracle Applications no longer provides predefined Zooms. Most
zooms have been replaced with buttons or Special menu functions. In
addition, the GUI environment allows you to open most forms at any
time regardless of what windows are currently open. You can then cut
and paste data from one form to another. Custom zooms may still be
defined by your System Adminstrator to meet your specific needs.

More

The More fields were a mechanism to allow you to see additional fields
belonging to the same block or zone. The GUI environment uses
Scrolling and Alternative Regions to provide access to additional fields.

Default Key Mappings in GUI

Your Oracle Applications products are shipped with default accelerator
keys. The following table shows the most commonly used functions
accelerator keys that map to them. For a complete list of accelerator
keys choose Help—>Keyboard Maps. These key mappings may be
changed by your System Administrator.
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Function

Accelerator Key Mapping

Alternative Region Shift+F10
Menu

Cancel Esc

Clear Item Ctrl+u

Clear Record Shift+F4
Edit Ctrl+e

Exit Ctrl+q

Help F1

List of Values F9

Next Field Tab

Next Record Down
Previous Field Shift+Tab
Previous Record Up

Default Button Return/Enter
Next Character or Right Arrow
Ortion Group Value

Previous Character or | Left Arrow

Ortion Group Value

Table 9 -2 (Page 1 of 1)
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Glossary

alternative region An alternative region is one
of a collection of regions that occupy the
same space in a window where only one
region can be displayed at any time. You
identify an alternative region by a poplist
icon that displays the region title, which sits
on top of a horizontal line that spans the
region.

AutoReduction An Oracle Applications
feature in the list window that allows you
to shorten a list so that you must scan only
a subset of values before choosing a final
value. Just as AutoReduction incrementally
reduces a list of values as you enter
additional character(s), pressing
[Backspace] incrementally expands a list.

AutoSelection A feature in the list window
that allows you to choose a valid value
from the list with a single keystroke. When
you display the list window, you can type
the first character of the choice you want in
the window. If only one choice begins with
the character you enter, AutoSelection
selects the choice, closes the list window,
and enters the value in the appropriate
field.

AutoSkip A feature specific to flexfields

where Oracle Applications automatically
moves your cursor to the next segment as
soon as you enter a valid value into a
current flexfield segment. You can turn this
feature on or off with the user profile
option Flexfields:AutoSkip.

balancing segment An Accounting Flexfield

segment that you define so that Oracle
General Ledger automatically balances all
journal entries for each value of this
segment. For example, if your company
segment is a balancing segment, Oracle
General Ledger ensures that, within every
journal entry, the total debits to company 01
equal the total credits to company 01.

block Every Oracle Applications window

(except root and modal windows) consists
of one or more blocks. A block contains
information pertaining to a specific
business entity Generally, the first or only
block in a window assumes the name of the
window. Otherwise, a block name appears
across the top of the block with a horizontal
line marking the beginning of the block.
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business entity A person, place, or thing that
is tracked by your business. For example, a
business entity can be an account, a
customer, or a part.

button You choose a button to initiate a
predefined action. Buttons do not store
values. A button is usually labeled with
text to describe its action or it can be an
icon whose image illustrates its action.

check box You can indicate an on/off or
yes/no state for a value by checking or
unchecking its check box. One or more
check boxes can be checked since each
check box is independent of other check
boxes.

child request A concurrent request submitted
by another concurrent request (a parent
request.) For example, each of the reports
and/or programs in a report set are child
requests of that report set.

combination block A combination block
displays the fields of a record in both
multi-record (summary) and single-record
(detail) formats. Each format appears in its
own separate window that you can easily
navigate between.

combination of segment values A
combination of segment values uniquely
describes the information stored in a field
made up of segments. A different
combination of segment values results
when you change the value of one or more
segments. When you alter the combination
of segment values, you alter the description
of the information stored in the field.

combination query See Existing Combinations.
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concurrent manager A unique facility that
manages many time—consuming,
non-interactive tasks within Oracle
Applications for you, so you do not have to
wait for their completion. When you
submit a request in Oracle Applications
that does not require your interaction, such
as releasing shipments or running a report,
the Concurrent Manager does the work for
you, enabling you to complete multiple
tasks simultaneously.

concurrent process A non-interactive task
that you request Oracle Applications to
complete. Each time you submit a
non-interactive task, you create a new
concurrent process. A concurrent process
runs simultaneously with other concurrent
processes (and other interactive activities
on your computer) to help you complete
multiple tasks at once.

concurrent queue A list of concurrent
requests awaiting completion by a
concurrent manager. Each concurrent
manager has a queue of requests waiting to
be run. If your system administrator sets
up your Oracle Application to have
simultaneous queuing, your request can
wait to run in more than one queue.



concurrent request A request to Oracle

Applications to complete a non-interactive
task for you. You issue a request whenever
you submit a non-interactive task, such as
releasing a shipment, posting a journal
entry, or running a report. Once you
submit a request, Oracle Applications
automatically takes over for you,
completing your request without further
involvement from you or interruption of
your work.

current record indicator Multi-record blocks

often display a current record indicator to
the left of each record. A current record
indicator is a one character field that when
filled in, identifies a record as being
currently selected.

descriptive flexfield A field that your

organization can extend to capture extra
information not otherwise tracked by
Oracle Applications. A descriptive flexfield
appears in your window as a single
character, unnamed field. Your
organization can customize this field to
capture additional information unique to
your business.

dynamic insertion A feature specific to key

flexfields that allows you to enter and
define new combinations of segment values
directly into a flexfield pop-up window.
The new combination must satisfy any
cross—validation rules, before your flexfield
accepts the new combination. Your
organization can decide if a key flexfield
supports dynamic insertion. If a flexfield
does not support dynamic insertion, you
can only enter new combinations of
segment values using a combinations form
(a form specifically used for creating and
maintaining code combinations).

Existing Combinations A feature specific to
key flexfields in data entry mode that
allows you to enter query criteria in the
flexfield to bring up a list of matching
predefined combinations of segment values
to select from.

field A position on a window that you use to
enter, view, update, or delete information.
A field prompt describes each field by
telling you what kind of information
appears in the field, or alternatively, what
kind of information you should enter in the
field.

flexfield An Oracle Applications field made
up of segments. Each segment has an
assigned name and a set of valid values.
Oracle Applications uses flexfields to
capture information about your
organization. There are two types of
flexfields: key flexfields and descriptive
flexfields.

folder A flexible entry and display window in
which you can choose the fields you want
to see and where each appears in the
window.

form A logical collection of fields, regions,
and blocks that appear on a single screen.
Oracle Applications forms look just like the
paper forms you use to run your business.
All you need to do to enter data is type
onto the form. See window.

function security An Oracle Applications
feature that lets you control user access to
certain functions and windows. By default,
access to functionality is not restricted; your
system administrator customizes each
responsibility at your site by including or
excluding functions and menus in the
Responsibilities window.
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key flexfield An intelligent key that uniquely
identifies an application entity. Each key
flexfield segment has a name you assign,
and a set of valid values you specify. Each
value has a meaning you also specify. You
use this Oracle Applications feature to
build custom fields used for entering and
displaying information relating to your
business. The Accounting Flexfield in your
Oracle General Ledger application is an
example of a key flexfield used to uniquely
identify a general ledger account.

lamp A single word message that appears on
the message line to indicate whether a
function such as <Insert> or <List> is
available for the current field.

listing An organized display of Oracle
Applications information, similar to a
report, but usually showing setup data as
opposed to transaction data.

master—detail relationship A master—detail
relationship is an association between two
blocks—a master block and its detail block.
When two blocks are linked by a
master—detail relationship, the detail block
displays only those records that are
associated with the current (master) record
in the master block, and querying between
the two blocks is always coordinated.
Master and detail blocks can often appear
in the same window or they can each
appear in separate windows.

message line A line on the bottom of a
window that displays helpful hints or
warning messages when you encounter an
error.

multi-org See multiple organizations.
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multiple organizations The ability to define
multiple organizations and the
relationships among them within a single
installation of Oracle Applications. These
organizations can be sets of books, business
groups, legal entities, operating units, or
inventory organizations.

Multiple Reporting Currencies An Oracle
General Ledger feature that allows you to
report in your functional currency and in
one or more foreign currencies.

option group An option group is a set of
option buttons. You can choose only one
option button in an option group at a time,
and the option group takes on that button’s
value after you choose it. An option button
or option group is also referred to as a
radio button or radio group, respectively.

parent request A concurrent request that
submits other concurrent requests (child
requests). For example, a report set is a
parent request that submits reports and/or
programs (child requests).

pop-up window An additional window that
appears on an Oracle Applications form
when your cursor enters a particular field.

poplist A poplist lets you choose a single
value from a predefined list. To choose a
value, press your left mouse button while
on the poplist icon to display the list of
choices, then drag your mouse through the
list to the desired value. Release your
mouse button to choose the value you
highlight and display it in the poplist field.
A poplist is also sometimes known as a list.



query A search for applications information
that you initiate using an Oracle
Applications window.

record A record is one occurrence of data
stored in all the fields of a block. A record
is also referred to as a row or a transaction,
since one record corresponds to one row of
data in a database table or one database
transaction.

region A collection of logically-related fields
set apart from other fields by a dashed line
that spans a block. Regions help to
organize a block so that it is easier to
understand.

report An organized display of Oracle
Applications information. A report can be
viewed online or sent to a printer. The
content of information in a report can range
from a summary to a complete listing of
values.

report security group A feature that helps
your system administrator control your
access to reports and programs. Your
system administrator defines a report
security group which consists of a group of
reports and/or programs and assigns a
report security group to each responsibility
that has access to run reports using
Standard Report Submission. When you
submit reports using Standard Report
Submission, you can only choose from
those reports and programs in the report
security group assigned to your
responsibility.

report set A group of reports that you submit

at the same time to run as one transaction.
A report set allows you to submit the same
set of reports regularly without having to
specify each report individually. For
example, you can define a report set that
prints all of your regular month-end
management reports.

responsibility A level of authority in an

application. Each responsibility lets you
access a specific set of Oracle Applications
windows, menus, reports, and data to fulfill
your role in an organization. Several users
can share the same responsibility, and a
single user can have multiple
responsibilities.

root window The root window displays the

main menu bar and tool bar for every
session of Oracle Applications. In
Microsoft Windows, the root window is
titled ”Oracle Applications” and contains
all the Oracle Applications windows you
run. In the Motif environment, the root
window is titled ”Toolbar” because it
displays just the toolbar and main menu
bar.

row One occurrence of the information

displayed in the fields of a block. A block
may show only one row of information at a
time, or it may display several rows of
information at once, depending on its
layout. The term “row” is synonymous
with the term “record”.
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scrollable region A region whose contents are

not entirely visible in a window. A
scrollable region contains a horizontal or
vertical scroll bar so that you can scroll
horizontally or vertically to view additional
fields hidden in the region.

segment A single sub—field within a flexfield.

You define the structure and meaning of
individual segments when customizing a
flexfield.

shorthand flexfield entry A quick way to

enter key flexfield data using shorthand
aliases (names) that represent valid flexfield
combinations or patterns of valid segment
values. Your organization can specify
flexfields that will use shorthand flexfield
entry and define shorthand aliases for these
flexfields that represent complete or partial
sets of key flexfield segment values.

shorthand window A single-segment

customizable field that appears in a pop-up
window when you enter a key flexfield.
The shorthand flexfield pop-up window
only appears if you enable shorthand entry
for that particular key flexfield.

sign-on An Oracle Applications username

and password that allows you to gain
access to Oracle Applications. Each
sign-on is assigned one or more
responsibilities.

Standard Request Submission A standard

interface in Oracle Applications in which
you run and monitor your application’s
reports and other processes.
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status line A status line appearing below the

message line of a root window that displays
status information about the current
window or field. A status line can contain
the following: ”~ or v symbols indicate
previous records before or additional
records following the current record in the
current block; Enter Query indicates that
the current block is in Enter Query mode,
so you can specify search criteria for a
guery; Count indicates how many records
were retrieved or displayed by a query (this
number increases with each new record you
access but does not decrease when you
return to a prior record); the <Insert>
indicator or lamp informs you that the
current window is in insert character mode;
and the <List> lamp appears when a list of
values is available for the current field.

structure A structure is a specific combination

of segments for a key flexfield. If you add
or remove segments, or rearrange the order
of segments in a key flexfield, you get a
different structure.



toolbar The toolbar is a collection of iconic window A box around a set of related

buttons that each perform a specific action information on your screen. Many

when you choose it. Each toolbar button windows can appear on your screen
replicates a commonly-used menu item. simultaneously and can overlap or appear
Depending on the context of the current adjacent to each other. Windows can also
field or window, a toolbar button can be appear embedded in other windows. You
enabled or disabled. You can display a hint can move a window to a different location
for an enabled toolbar button on the on your screen.

message line by holding your mouse
steadily over the button. The toolbar
generally appears below the main menu bar
in the root window.

window title A window title at the top of
each window indicates the name of the
window, and occasionally, context
information pertinent to the content of the

user profile A set of changeable options that window. The context information,
affect the way your applications run. You contained in parenthesis, can include the
can change the value of a user profile organization, set of books, or business
option at any time. group that the window contents is

associated with.
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Index
A

Accelerator keys. See Keyboard shortcuts
Action menu, A-2

Print...,2-19

refresh, 2 -19

Save, 2-20

Save and Enter Next, 2 - 20

Adding new Documents to the Navigator, 1 -
15

Alias, shorthand, 5 -8
Alternative region, 2 - 12
alternative region, 2 - 12
Attachments, 8 -2
attaching a document, 8 -5
copying an attachment, 8 - 7
deleting an attachment, 8 - 7

Attachments window fields, 8 — 3
AutoReduction, 3-10,3-13
AutoSelection,3-10to 3-11
AutoSkip, 5-11

B

Batch processing. See Concurrent processing
Blocks, 2 -6

clearing, 3-3

combination, 2 — 14

erasing, 3-3
Business entity, 5 -2

Business flows, 2 - 6
Buttons, 2 -7

C

Calendar, picking dates, 3 -15
Calendar window, 3 - 15
Cancelling requests, 7 — 15
Case-sensitivity, in a List Search, 3 - 12
Check boxes, 2 -7
Enter Query mode, 3-24
Choose, 1-4
Clear field,3-3, A-3
Click, 1-3
Codes
See also Key flexfields
error and message, 2 — 22
Combination blocks, 2 - 14
Combination of segment values, 5 -4
creating, 5-8
Committing data, 2 — 20
Concurrent managers
See also Concurrent processing
viewing the queue, 7-5t0 7 -6
Concurrent processing, 6 — 4
error notification, 6 — 6
online requests, 6 — 5
overview, 6 — 2
run and print options, 6 - 6,6 -7
Concurrent programs. See Concurrent
processing
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Concurrent requests, 6 — 7
See also Concurrent processing
cancelling, 7-15
changing run and print options, 7-16to 7 —
17
phase/status combinations, 7-12to 7 - 15
run and print options, 6 — 7
status of, 7-2to7-5,7-12
viewing,7-2t07-6
Concurrent Requests window. See Viewing
requests
Container window, 2 - 5
Context, window title, 2 -5
Coordination check box, 2 - 12
Copy,3-2,A-3
Counting records, 3 - 25
Cross—validation, 5 -7
See also Key flexfields
Current record indicator, multi-record block, 2
-8
Current record indicators, drill-down, 2 -8, 2
-14
Customizing data presentation, 4 — 2
Customizing window layouts, folders, 4 — 2
Cut,3-2,A-3

D

Data
clearing, 3-3
committing, 2 — 20
copying, 3-4
deleting from database, 3-5
erasing from a block, 3 -3
erasing from a form, 3 -4
erasing from form, 3 -3
inserting, 3-5
querying, 3—19
saving, 1-26,2-20
searching, 3-19

Date, format, 3 - 15

DateTrack date, windowv title, 2 -5

Default parameters. See Shared parameters
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Define Request Sets window. See Standard
Request Submission
Descriptive flexfields
AutoSkip, 5-11
definition,5-4to5-5
multiple flexfield structures, 5 -8
querying, 5 - 23
using, 5-10
windows, 5-10
Desktop, 1 -3
Desktops, 2 -5
Detail block, 2 - 12
Detail record, 2 - 12
Detail windows, combination blocks, 2 — 14
Direct entry key flexfield, 5 - 11
Direct entry key flexfields, using, 5-11to 5 -
14
Direct entry window, retrieving records, 3 — 26
Double—click, 1 -3
Drag,1-3
Drill-down capabilities, 2 - 8,2 - 14
Dynamic insertion, 5 -8

E

Editmenu,3-2, A-3
clearall,3-4
clear block, 3-3
clear field,3-3, A-3
clear record, 3-3
delete record, 3-5
duplicate field above, 3 -4
duplicate record above, 3-4
invoke editor, 3-6
List,3-9t03-10
new record, 3-5

Editing, fields, 3 -2

Editing fields, 3-6to3-7

Error notification, 6 — 6

Exit
committing data, 1 — 26
discarding changes, 1 — 26
returning to form, 1 - 26
saving changes, 1 - 26



Exiting Oracle Applications. See Exit

F

Fields, 2 -6
buttons, 2 -7
check boxes, 2 -7
clearing data, 3-3, A-3
copying data, 3-4
editing,3-6to3-7
option buttons, 2 -7
option groups, 2 -7

Find window, 3 - 20

Flexfields

See also Descriptive flexfields; Key flexfields;

Range flexfields
AutoSkip, 5-11
combinations, 5 -4
descriptive, 5 -4
dynamic insertion, 5 -8
key,5-2
multiple flexfield structures, 5 -8
overview,5-2
querying,5-23to5-24
security, 5-8
segment validation, 5 -7
segments, 5-2
Shared Table Lock profile, 9 — 13
shorthand entry, 5 -8
Shorthand Entry profile option, 9 — 13
structures,5-6,5-8
using,5-10to 5-12
using alistin,5-11
windows, 5-10
Folder menu,4-2, A-5
Folders
autosize, 4-9
change prompts, 4 -9
create new, 4 — 10
customizing, 4 -2
decrease width, 4 -9
definitions, 4 -2
delete, 4 -12
hide field, 4 -8
increase width, 4 — 8

open, 4-12
recovering original folder layout, 4 — 11
reset query, 4 -5
save,4-12to4-13
save as, 4-12
scope of default folder, 4 — 10
show field, 4 -7
show ordering, 4 -5
swap left, 4 -8
swap right, 4 - 8
view query, 4 -5
Form, erasing, 3-4
Format, date, 3- 15
Forms,2-6
blocks, 2 -6
fields, 2 -6
message lines, 2 -9
record, 2-8
searching for data in, 3-19
status lines, 2-9
window title, 2 -5
Forms, opening
LOV,1-12
Navigator, 1 - 12
top ten list, 1 - 14
Function keys. See Keyboard shortcuts

G

Gomenu, A-4
Zoom,2-24t02-25
Graphical user interface. See GUI
GUI, 1-2
terminology, 1 -3

H

Help
accessing online, 1 - 22
show keys, 1-20to 1-21
System help, 1-23
using, 1 - 22
Window help, 1 -22
Help menu, A-6
About Oracle Applications, 1 -24
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about this record, 3 -7

Inquiry forms, A-6
Intelligent keys. See Key flexfields

K

Key flexfield Edit window, 5-14to5- 15
Key flexfield Find window, 5-15to 5- 17
Key flexfield windows

Edit window, 5 - 14

Find mode, 5-15
Key flexfields

cross-validation, 5 -7

directentry, 5-11

displaying the flexfield window, 5 - 14

dynamic insertion, 5 -8

entering data, 5 - 11

overview,5-2t05-3

qguerying, 5-23to5-24

security by value, 5-8

shorthand alias, 5-18to5- 19

shorthand entry, 5-8

specifying segment separators, 5 - 12

using a Find window, 5 - 15

using an Edit window, 5 — 14
Keyboard mappings, 1 -20to 1-21
Keyboard shortcuts, 1 - 20

for window navigation, 2 — 15

L

Lamps,2-9t02-10
List,3-9

List
accessing,2-7,3-9,3-14
AutoReduction, 3-10,3-13
AutoSelection, 3-10to 3-11
cancelling, 3-9
long, 3-12
multicolumn windows, 3 - 13
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Power list, 3-12to 3-13
search, 3-10
source, 3 - 14
standards, 3 -14
taking advantage of, 3-14
using,3-9to 3-13
Listlamp, 3-9
List of values
See also Lists
using,3-9to3-13
Loggingon,1-5
Long list, 3-12
Long text fields, accessing editor, 3 -6

M

Main menu, 1-18

Main window. See Root window
Master block, 2 - 12

Master record, 2 - 12
Master—detail relations, 2 — 12

Master—detail relationship, coordination check
box, 2 -12
Menu, 1-3
Folder, 4 -2
Menu bars
flexfield window, 5 -7
Oracle Applications main, A -2

Menus
Action, A-2
Edit,3-2,A-3
Folder, A-5
Go,A-4
Help, A-6
Query, A-3
Special, A-6
Windows, A -6

Menus, using
getting online help, 1 - 22
main menu, 1-18to1-20
security, 1 -9
selecting a responsibility, 1 -8
using keyboard shortcuts, 1 — 20
Message lines, 2-9



Messages, viewing, 2 —-22to 2 - 24
Modal windows, 2 -5
Monitoring requests
cancelling requests, 7 — 15
changing run and print options, 7 - 16 to 7 —
17
phase/status combinations, 7-12to 7 - 15
Requests window, 7-2to7-5

Moving around a window, 2 — 15
Moving between forms. See Zoom

Multi-record blocks
current record indicators, 2 -8
scroll bars, 2 -8

multi-select, 3 - 27

N

Navigating a window, 2 — 15
Navigator
adding new documents, 1 — 15
removing documents, 1 - 15

O

Online, view requests, 7 -9
Online help, using, 1 -22

Online inquiries, searching for information, 3 -
19

Online requests. See Concurrent requests
Opening forms
LOV,1-12
Navigator, 1 - 12
top ten list, 1 - 14
Opening the Navigator’s Document Region, 1
-15
Option buttons, 2 -7
Option groups, 2 -7
Options. See Profile options; User profiles
options
Oracle Applications
overview, 1 -2
sign-on,1-7t0o1-8,1-17
welcome window, 1 -7

Oracle Applications behavior
See also User profile options
customizing,9-2,9-5t09-6

Oracle Applications main menu bar, A - 2

Overview, Oracle Applications, 1 -2

P

Passwords
changing sign-on password, 1 -6, 1
Oracle Applications, 1 -6
security features, 1 -5,1-6
Paste,3-2,A-3
Poplist,2 -7
See also List
Powver list, 3 - 12
PowerSearch
entering search criteria, 3 - 22
features of, 3-19to 3-20
query operators, 3-23t03-24
Print options
changing, 7-16to 7 -17
for reports, 6 — 29
Printing, active window, 2 — 19
Profile Options, Flexfields:Open Descr
Window, 5 -7
Profile options
See also User profile options
Concurrent;Hold Request, 6 — 7
Concurrent:Report Access Level, 6 —

-16

7

Concurrent:Report Copies, 6 -7, 6 — 18

Concurrent:Request Priority, 6 — 7
Concurrent:Request Start Time, 6 — 7
6-16

, 6—15,

Concurrent:Save Output, 6 -7, 6 —-18
Concurrent:Sequential Requests, 6 — 7

Flexfield:Shorthand Entry, 5 - 18
Flexfield:Show Full Value, 5 -19
Flexfields:AutoSkip, 5 - 11

Flexfields:Shorthand Entry, 5 -8

Flexview:Allow Customization, 4 — 2

GL Set of Books Name, 5-8
Printer,6 -7,6-18

Profile Values, form description,9-5t0 9-7
Profiles. See Profile options; User profiles

options
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Programs,6-2,6-9
See also Concurrent requests; Standard
Request Submission

Q

Query
See also PowerSearch
entering criteria, 3 - 22
executing, 3-25t03-26
Query count, 3-25
Quiery criteria, use of wildcards, 3 — 22
Query Find, 3-20
Query menu, A-3
count matching records, 3 — 25
Enter, 3 -22
Quit, 3-25
retrieve next set, 3-25
Query operators, 3-23to 3-24
Query-by-example, 5-23to5-24
Querying data, 3—-19to 3-26
Quitting Oracle Applications. See Exit

R

Radio buttons. See Option buttons
Radio group. See Option group
Range flexfields, 5 — 20
Records, 2 -8
adding new, 3-5
clearing, 3-3
copying, 3-4
current record information, 3 -7
deleting from database, 3-5
erasing, 3-3
inserting to database, 3 -5
Redraw window, 2 — 19
Refresh, 2 - 19
Regions, 2 -7
scrollable region, 2 - 7
Removing Documents from the Navigator, 1 —
15
Renaming Documents in the Navigator, 1 — 15
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Report groups, access to request sets, 6 — 33
Report parameters, 6 — 5
Reports, 6-2,6-5,6-9
See also Concurrent requests; Standard
Request Submission
report parameters, 6 — 5
request, resubmit, 6 — 19
Request IDs, 6 — 19 to 6 — 20, 6 — 22
Request parameters, 6 —-12t0 6 -13,6-30to 6
-32
Request sets, 6 — 5
access to, 6 — 33
cancelling, 7-15
defining, 6 — 22 to 6 — 26
print options, 6 — 29
request IDs, 6 — 19 to 6 — 20, 6 — 22
request parameters, 6 — 30 to 6 — 32
run and print options, 7—-16to 7 - 17
running, 6 —20to 6 — 21
running reports in parallel, 6 — 27
scheduling, 6 - 6
security, 6 — 33
shared parameters, 6 — 31
status of, 7-2,7-12
Requests
See also Concurrent requests; Request sets
cancelling, 7 - 15
request IDs, 6 — 19
request parameters, 6 — 12
run and print options, 7-16to 7 - 17
running,6-9to6-14
scheduling, 6 - 6
security, 6 — 33
status of, 7-2,7-12
submitting, 6 -9to 6 - 14
Requests window, accessing, 7 — 4
Responsibilities
changing,1-9,1-16
description, 1 -8
security, 1 -8
selecting, 1 -9
standard, 1-9
using,1-8
resubmit a request, 6 — 19
Retrieving records, in a direct entry window, 3
- 26



Root window, 2 -5
Rows. See records
Run options, changing, 7—-16to 7 - 17

S

Saving, before exiting, 1 — 26
Saving data, 2 - 20
Screens, 2-5
Scroll bar, 1 -4
Scroll bars,2-7,2-8
Scrollable fields, 3-6
Search
See also PowerSearch
displaying records, 3 - 25
entering search criteria, 3 - 22
executing, 3-25t03-26
quitting, 3-25
through a list, 3-10
Search count, 3 - 25
Search criteria, use of wildcards, 3 — 22
Searching for data. See PowerSearch
Security
changing passwords, 1 -6
flexfields, 5 -8
Oracle Applications sign-ons, 1 -6
requests and request sets, 6 — 33
responsibilities, 1 - 8
Segment validation, 5-7
Segments, 5 -2
Select, 1-3
selecting, multiple records, 3 — 27
Shared parameters
changing a value, 6 — 31
request sets, 6 — 31
Sharing parameters, in request sets, 6 — 31

Shorthand flexfield entry, 5 -8
aliases,5-18to5-19

Sign-ons, changing, 1 - 17
Signingon, 1-6,1-17
Single-record blocks, 2 - 8

Special menu, A-6
Change Password, 1 -16to 1-17
Sign On, 1-17
Switch Responsibility, 1 — 16
Standard Report Submission, access to Run
Reports form, 6 — 9
Standard Request Submission
See also Reports; Request sets; viewing
requests
access to request sets, 6 — 33
defining request sets, 6 — 22 to 6 — 26
overview, 6-2t06-3
print options, 6 — 29
report parameters, 6 - 5
request IDs, 6 — 19 to 6 — 20, 6 — 22
request parameters, 6 —12to6-13,6-30to
6-32
running reports and programs, 6 —9to 6 — 14
running request sets, 6 — 20 to 6 — 21
scheduling, 6 - 6
Status line, lamps, 2-9
Status lines, 2-9
Structures, 5-6
multiple flexfield structures, 5 -8
Submitting jobs. See Concurrent requests;
Standard Request Submission
Submitting reports and programs. See
Concurrent requests; Standard Request
Submission
Summary windows, combination blocks, 2 — 14

T
Task flows, 2 -6
toolbar, 2 -10
U

User access restrictions, 1 -8
User interface. See Profile options
User profile hierarchy,9-2t09-4
User profile levels, 9 -3
User profile options

See also Profile options
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common options, 9 -7 W
concurrent processing options, 6 — 7

overview, 9 — 2 Welcome window, 1 -7
personal profile, 9 -5 Wildcard characters, in search criteria, 3 — 10
profile levels,9-4t09-5 Wildcards, in search criteria, 3 — 22
Profile Values form,9-5t09-7 Window, 1-3,2-5
setting values,9-4t09-6 printing, 2 — 19
User responsibility, 1 — 8 redrawing, 2 — 19
Usernames, 1 -6 refreshing, 2 - 19

saving datain, 2 - 20
Window functions, 2 — 19

V Windowv title, context, 2 -5
\ersions, software information, 1 — 24 Windows
modal, 2 -5

View reports online, 7-9

Viewing messages, 2 — 22 to 2 — 24
Viewing request output and log files, 7 -9
Viewing requests

moving around, 2 — 15
Windows menu, A -6

cancelling requests, 7 - 15 7
changing run and print options, 7-16to 7 —
17 Zoom, A -6
phase/status combinations, 7-12to 7 - 15 accessing, 2-24to02-25
Requests window, 7-2to7-5 using, 2—-24to2-25
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Reader’'s Comment Form
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A58195-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness
of this publication. Your input is an important part of the information we use for revision.

Did you find any errors?

Is the information clearly presented?

Do you need more information? If so, where?

Are the examples correct? Do you need more examples?

What features did you like most about this manual? What did you like least about it?

If you find any errors or have any other suggestions for improvement, please indicate the topic, chapter,
and page number below:

Please send your comments to:

Oracle Applications Documentation Manager
Oracle Corporation

500 Oracle Parkway

Redwood Shores, CA 94065

Phone: (650) 506—7000 Fax: (650) 506—7200

If you would like a reply, please give your name, address, and telephone number below:

Thank you for helping us improve our documentation.
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